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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Use help icons @ to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Before You Begin

This Guide Is for Customers on Update 24C

Customers who are still on Update 24B, should access the archived PDF version of the guide on the Implement Next Gen
Sales page on Oracle ScureSites.

Release 24C expands the capabilities of CX Extension Generator. The now unnecessary manual steps have been
removed from this version of the guide.

If you don't have access to SecureSites, you can ask an Oracle employee to provide it. See the Getting Help section on
Oracle SecureSites and SecureFiles.

Before You Create an Application Extension

Before your team can start creating application extensions, you must first set up Visual Builder Studio and configure it.
You only need to complete these steps once per implementation.

Before you begin, make sure you have the following information:

« The URL of your instance of Visual Builder Studio

You can obtain the URL by navigating from your Oracle Cloud Applications development instance. From the
Navigator, under Configuration, select Visual Builder.

Setting up Visual Builder Studio includes these steps:

1. Obtain the required roles and privileges.
2. Set up Visual Builder Studio users.
3. Create a project and workspace.

Or, create a workspace in an existing project.
4. Create the build pipeline to deploy your changes to your production environment.

Get the Required Roles and Privileges

To set up Visual Builder Studio and your Oracle Cloud Applications instances, make sure you're assigned the
FND_ADMINISTER_SANDBOX_PRIV privilege. Each role listed below, for example, has this privilege:

- Application Administrator (ORA_FND_APPLICATION_ADMINISTRATOR_JOB)

- Application Developer (ORA_FND_APPLICATION_DEVELOPER_JOB)

- Sales Administrator (ORA_ZBS_SALES_ADMINISTRATOR_JOB)

- Customer Relationship Management Application Administrator
(ORA_ZCA_CUSTOMER_RELATIONSHIP_MANAGEMENT_APPLICATION_ADMINISTRATOR_JOB)
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In addition, in order to view the Edit Page in Visual Builder Studio option in the Settings and Actions menu, users
must be assigned the View Administration Link privilege (FND_VIEW_ADMIN_LINK_PRIV). By default, this privilege is
assigned to the predefined roles listed above. Grant this privilege to custom roles, as well, where required.

Set Up Visual Builder Studio Users in IDCS

First, you must authorize users so they can access Visual Builder Studio to do extension work. You do this in Oracle
Identity Cloud Service (IDCS).

To sign in to the right instance of IDCS, complete these steps:

Navigate to www.oracle.com.

Click View Accounts.

Click Sign in to Cloud.

In the Cloud Account Name field, enter the name of your production pod, such as cakp. Click Next.

The Oracle Cloud Account Sign In page is specific to the Cloud Portal and is separate from your test and
production pods. Enter your user credentials and click Sign In, or use the Click here link to reset your
password.

uvhWNRA

On the Oracle Cloud Dashboard, navigate to the Active Applications region and click Identity Cloud. Scroll
down to view your IDCS service instances:

o ldentity

IDCS instance associated with the Myservices portal.
o CAKP (for example)

IDCS instance associated with your production pod.
o CAKPTEST (for example)

IDCS instance associated with your developer pod.
6. Tosignin to the IDCS instance associated with your test environment, click the Service Instance URL for your
test pod (in this example, CAKPTEST), or click the Open Service Console link.

I Tip: Bookmark this URL so you have it for next time.

7. Signin to IDCS directly, or click Oracle Applications Cloud (Fusion) at the bottom of the page to sign in using
your Oracle Applications user credentials.

Once you're in the Identity Cloud Service console, you can now authorize users so they can access Visual Builder Studio.
You can assign users, or groups of users, to the Visual Builder Studio administrator (DEVELOPER_ADMINISTRATOR)

or Visual Builder Studio user (DEVELOPER_USER) roles. These two predefined roles are specific to working with Visual
Builder Studio.

In this example, let's look at assigning a group to the Visual Builder Studio administrator
(DEVELOPER_ADMINISTRATOR) role. This is a way to provide Visual Builder Studio access to Fusion Application roles
and their users.

1. Inthe Identity Cloud Service console, expand the Navigation Drawer, and then click Oracle Cloud Services.
2. Click DevServiceAppAUTO_<VBSTUDIO_INSTANCE>.
3. Click the Application Roles tab.

ORACLE



Oracle Fusion Cloud Sales Automation Chapter 1
How do | create an application extension for custom objects Before You Begin
in Oracle Visual Builder Studio?
4. On either the DEVELOPER_ADMINISTRATOR or DEVELOPER_USER row, click the menu icon, then click Assign
Groups.

[.é DEVELOPER_ADMIMNISTRATOR ﬁ
L DEVELOPER_USER v

(eptcotion foe]

5. Inthe Assign Groups dialog, select the roles that you want to assign and click OK. For example:

[e]

o

o

o

o

Application Administrator

Sales Administrator

Customer Relationship Management Application Administrator
Application Developer

Any custom role, per your authorization plan

Users with the selected roles can now access Visual Builder Studio. Note that sometimes it may take up to 12 hours for
Oracle Cloud Applications user updates to sync with IDCS.

For more information, see Set Up VB Studio Users in the Oracle Cloud Administering Visual Builder Studio guide.

Create Your Project and Workspace

If you haven't yet created a project and workspace in Visual Builder Studio, then you must do so before creating an
application using the CX Extension Generator.

- A project is a collection of resources that your team will use to create the application extension.

Note: The CX Extension Generator uses fragments which are building blocks that help to configure pages
more quickly, with a minimal amount of manual coding. Create a new project to keep your fragment-based
extension separate from extensions that don't use fragments.

- A workspace exists within a project, and is your private work area which connects to a Git repository,
environment, and Oracle Cloud Applications sandbox.

If you already created a project, then you don't need to create a new one. Rather, you can create a new workspace
within your existing project. See the next section.

To create a project and workspace at the same time:

NOURWNA

In Visual Builder Studio, click the Organization side tab, then click the Projects subtab.
Click + Create.

In the New Project dialog, enter a name and description for the project.

Set the security for your project, either Private or Shared.

Click Next.

Select Empty Project as the template for this project, and click Next.

On the Properties step, click Next.
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On the Team step, add team members and select their membership levels.

Click Finish.

Visual Builder Studio provisions your project, which could take a few minutes to complete. You will then be
navigated to the project's home page.
Create a development environment for your project.

8.
9.

10.

1.

-0 2n CTO9

Click the Environments side tab, then click + Create Environment.

Enter a name and description for the environment and click Create.

Click + Add Instance.

In the Add Service Instances dialog, under Instance Type, click Oracle Cloud Applications.
Under Authentication Method, click Identity Domain.

Select the desired instance for the environment and click Add.

Create a new workspace.

=70 02N OO

Click the Workspaces side tab, then click New > New Application Extension.

In the New Application Extension dialog, in the Extension Name field, enter the extension name.
In the Extension Id field, enter site_cxsales Extension.

In the Workspace Name field, accept the default value or enter a new workspace name.

In the Development Environment field, select the environment you just created.

In the Base Oracle Cloud Application field, select CX Sales (from CX Sales).

In the Git Repository region, click Create new repository.

Enter a name for both the repository and working branch.

Click Create.

Create a Workspace in an Existing Project

To create a new workspace in an existing project:

1.
2.

In Visual Builder Studio, click the Workspaces tab on the left pane, then click Clone from Git.
In the Clone from Git dialog, enter these values:

Field Value

Workspace name Enter the name of your workspace.

Repository Name Select the Git repository connected to your team's project. Ask your administrator for this value.
Branch Select main.

"New branch from selected" check box  Select this check box.

New branch name Enter a name for your branch. For example, <user_id>_<feature_name>.

Development Environment Select your development environment.
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Field Value

Sandbox (optional) Select a sandbox, or leave this blank and attach a sandbox to your workspace later.

3. C(lick Create.

Create the Build Pipeline for Your Production Environment

Create the build pipeline to deploy your changes to your production environment.

When you created your project, a build pipeline was automatically created to deploy your application extension to your
test environment. Now you must create a second pipeline for your production environment.

For complete instructions, see Configure VB Studio to Run Cl/CD Pipelines and Set Up the Project to Deploy to
Production in the Oracle Cloud Administering Visual Builder Studio guide.

Related Topics
- Setting Up Visual Builder Studio for Oracle Cloud Application Extensions

How can | change my project's Extension ID?

When working with a Sales application extension in Oracle Visual Builder Studio, your project's extension ID must be
site_cxsales_Extension. | his topic illustrates how to correct the extension ID, if required.

To change the extension ID for a project:

1. In Visual Builder Studio, from the left navigator, click Environments > Deployments.
2. Undeploy any deployments to target servers.

See Delete an Extension.
3. Navigate to your workspace and, from the upper menu, click Settings.

o  Share

8% Settings l

4. Inthe Extension ID field, enter site_cxsales Extension.
5. Build and deploy your extension once more.

See Build Your Applications and Package, Deploy, and Manage Extensions.
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Chapter 2
Add a Custom Top Level Object

2 Add a Custom Top Level Object

Prerequisites for Using the CX Extension Generator

The CX Extension Generator is a tool that automates many of the manual tasks required to build an application
extension from scratch. Before you can build an application using the CX Extension Generator, complete these

prerequisite steps.

Setup Prerequisites Before Using the CX Extension Generator

Setup Step

1. Create and activate a sandbox.

2. Create custom top level objects, as well
as any child objects, related objects, and
relationships.

3. Publish the sandbox.

4. Enable all custom objects that you created for
Adaptive Search and publish your changes.

In addition, create at least one saved search.

ORACLE

Setup Location

Sandboxes work area

Application Composer

Application Composer

Setup and Maintenance work area

- Offering: Sales

- Functional Area: Sales Foundation

More Information

Create and Activate Sandboxes

This chapter provides you with step-by-step
instructions for creating a custom application
using the CX Extension Generator and Oracle
Visual Builder Studio. To build this custom
application, you will need to create a custom
top level object in Application Composer, as well
as a custom child object.

The example objects used in this chapter are a
Payment object and its child object, Payment
Line.

We will also add a panel for a related object,
Shipment.

For more information about creating custom
objects, see Define Objects.

Publish Sandboxes

Publish the sandbox so that you can enable all
custom objects for Adaptive Search, in the next
step.

Note:

If you're already running Visual Builder
Studio, then sign out and sign back in before
continuing to configure your application
extension. Doing this ensures that Visual
Builder picks up the latest published changes
from Application Composer.

Enable Business Objects for Adaptive Search

This step is required because the list page is
dependent on Adaptive Search.


https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20067187
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20032788
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20067977
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Oracle Fusion Cloud Sales Automation Chapter 2
How do | create an application extension for custom objects Add a Custom Top Level Object
in Oracle Visual Builder Studio?

Setup Step Setup Location More Information

Show: All Tasks
Task: Configure Adaptive Search

5. Grant the Custom Objects Administration Setup and Maintenance work area Enable Sales Administrators to Test
(ORA_CRM_EXTN_ROLE) role to the user who Configurations in the Sandbox
will create the user interface pages for the . Offering: Sales

custom object.
Functional Area: Users and Security
(All custom top level objects are given access to

this role by default) Task: Manage HCM Role Provisioning

Rules
6. Create your project and workspace. Oracle Visual Builder Studio For instructions about how to create a project
and workspace, refer to the Before You Begin
chapter.
7. Create a translation bundle. Oracle Visual Builder Studio Create a Translation Bundle, If You Don't Have
One Already

Related Topics
« Create a New Application Using the CX Extension Generator

» Modify an Existing Custom Application Using the CX Extension Generator

Create a New Application Using the CX Extension
Generator

The CX Extension Generator is your shortcut to creating applications that extend the functionality of Oracle Sales in
the Redwood user experience. With just a few quick selections, the CX Extension Generator can create an application
extension with panels, subviews, details pages, and smart actions, that you can download as a single .zip file and then
upload to Oracle Visual Builder Studio. After you upload the files to Visual Builder Studio, you can continue to build out
the extension in Visual Builder Studio and then publish it to your users.

Using CX Extension Generator you can add panels and subviews for child, 1:M (one-to-many), and M:M (many-to-
many) relationships. CX Extension Generator also creates the Details (edit) pages for each object and the required smart
actions that make it possible for users to create and edit individual records.

Prerequisites

« See Prerequisites for Using the CX Extension Generator.

- If you're following along with the examples in this chapter, then create these objects and relationships, as well:
o Objects
- Payment (top-level object)
- Shipment (top-level object)
o Relationships
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- PaymentLead1M (one-to-many relationship)
- PaymentShipment1M (one-to-many relationship)
- PaymentContactMM (many-to-many relationship)

Create a New Application

To create an application:

1. In a sandbox, navigate to Application Composer > CX Extension Generator.
2. C(Click Create New Extension.

CAUTION: You can use the Create New Extension button only the first time you configure your application
in the environment. If you use the CX Extension Generator to make further changes after your initial upload
to VBS, then you must import the files back from VBS using the Import Extension button before you start. If
you create a new extension using the Create New Extension button and import your changes to VBS, then
your upload will overwrite all your previous changes.

= {supremo @

CX Extension Generator import Extérrsion

Manage CX Extensions

Create a new extension or import an existing extension from Oracle Visual Builder Studia.

Creati New Extensson
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Add a Custom Top Level Object

3. Inthe Add objects drawer, select the objects you're using to create the application, and then click Add.

In this example, select Payment and Shipment.

Add objects

Select the objects to create the list, create, detail, and edit pages for.

Objects o
Payment X ‘ ‘ Shipment X

Cancel ‘ Add

The selected objects display on the list page.

CX Extension Generator

Q, Search by object name

Object name £ Resource Name £ Issues <

Payment Payment_c

Shipment ShipmentJiri3_c

| =N SRS L TR A . N BRSNS 0 TR MR

Actions ¥ Generate Files

ORACLE
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4. Drill down on each object to configure the detail page.

I Note: In the runtime application, the detail page is called the Overview page.

The page displays automatically-generated panels for attachments and notes. You can optionally delete them.

-

Otgect
Paymeént

T Allobjects

Payment - Record Name <

Iem 1 Value 2 Item2 Value Rem 3 Label lkem3 Value

Q
T S— W U W T —
Configure Panel Attachments i} Notes &
Recond Name
E ltem 1 Value i‘ ° Iem 1 Value
Add and configure a new panel.
Recond Name

Add

Use the default Configure Panel, which always displays as the first panel, to add new panels.

Note: When you add a panel for an object with a M:M relationship, the generator creates the panel for the
intersection object you created as part of the M:M relationship rather than the object itself.

n
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5. To add a panel:
a. On the default Configure Panel, click Add.

Configure Panel

Add and configure a new panel.

Add

Chapter 2
Add a Custom Top Level Object

b. Inthe Add Panels drawer, select the custom related objects that you want to create the panels for. These
can be objects with either a 1:M or M:M relationship.

For example, select Shipments.

Add panels

Obijects
Shipments X

Create subview for each panel

Cancel

Add

c. Select the Create subview for each panel check box to automatically create a subview along with each

panel.

ORACLE
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Note: If you don't select this check box, then you can add subviews later. See the next step.

d. Click Add.
6. Optionally, click Configure > Subviews to add and remove subviews for each panel.

= Jsupremo 0o '
| g;;;;ent v Configure ™
+ Al abjects Smart Actions
Payment - Record Name © Subviews
el ltem1 Value Itemz Label tem2 Value Item3 Label Item3 Value

7. Click Configure > Smart Actions to review the smart actions that the Extension Generator will automatically
create for the objects that you selected.

Tip: You can optionally enhance a smart action's configuration after the Extension Generator creates them.
You do this by editing the smart action in Application Composer (Common Setup > Smart Actions).

Note: If you previously created custom smart actions for a non-fragments implementation of an object, then
you don't need to create new smart actions for use with fragments. Instead, update existing Ul-based custom
smart actions to specify the action type, either Add or Create, as well as the target object and any required
field mapping. For existing REST-based or object function-based custom smart actions, edit the action and
then save without making any changes. These steps ensure that your custom smart actions still work with
new fragment-based extensions.

8. If your application includes more than one object, then use the Object drop-down field to switch between
objects to configure multiple detail pages.

Object
Payment

Payment
Shipment Name <

R —— 2 Label Item2 Value Item3 Label Item3 Value
Q Action Ba

9. After you've completed your changes, you can generate and download the .zip file.

Note: At any time, you can delete your configuration choices from the tool by clicking Actions > Start Over.

13
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oo B

Actions ~ Generate Files

—|— Add objects

Bl D Start Over [ &

Generate and Download Files

When you're done with your application extension changes, navigate back to the CX Extension Generator list page and

click Generate Files.

CX Extension Generator Actions

Q. Search by object name

Object name Resource Name < Issues = Action
Payment Payment_c @'
Shipment ShipmentJiri3_c |

The CX Extension Generator generates and downloads a .zip file that includes the pages and layouts for your selected

objects.

In addition, the process to create the smart actions is launched.

Note: The process of creating smart actions might take some time to complete. After smart actions are created,
you can optionally manage them further in Application Composer, if required. Depending on the objects in your

extension, you might need to manually create additional smart actions.

Import the Files into Visual Builder Studio

The CX Extension Generator generates a .zip file that you can import into Visual Builder Studio.

1. Use the Navigator to navigate to Visual Builder Studio: Configuration > Visual Builder.

ORACLE
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2

3.

In Visual Builder Studio, create a new workspace if you haven't already.

Chapter 2
Add a Custom Top Level Object

Note: The workspace Extension ID must be site_cxsales_Extension. For information on how to change the

extension, see How can | change my project's Extension ID?.

To create a workspace, see Before You Create an Application Extension. Be sure to follow the instructions for

updating the extension ID for your workspace.
Click the Menu icon at the top of the page, then click Import.

‘ Publish | =

Share

Settings

4 1mport

[2] Export

In the Import Resources dialog, add your .zip file and click Import.
Click the Preview button to see your newly created application.

P ©® Q ‘ Publish | =

The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-custom/<object name> c

Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/<object_name> c

Note: You must add /application/container to the preview link.

You can now continue to make changes to your application extension in Visual Builder Studio.

For example, you can modify the fields that display in the detail page's header region, or on a subview or create
page. The Extension Generator adds some default fields, but you will most likely want to add and remove fields

depending on your business needs.

If you need additional smart actions, you can create them in Application Composer. For example, if you keep

the Notes panel, then you must create a Create Note smart action.

ORACLE
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Modify the Gruntfile.js File

Chapter 2
Add a Custom Top Level Object

Once your extension is available in Visual Builder Studio, review the Gruntfile.js and make the following change if the
code doesn't match the below sample. You must make this change before publishing your extension.

1. On the Source tab, edit the Gruntfile.js.

] Source

4 | Q. Filter

1< 4 mextensiom
& 2 .gitignore
|J{~3 Gruntfile.js
i
[} Readme.md
@ { } package.json

©

2. Replace the existing JavaScript with the following:

'use strict';

/**

* Visual Builder application build script.

* For details about the application build and Visual Builder-specific grunt tasks

* provided by the grunt-vb-build npm dependency, please refer to

* https://www.oracle.com/pls/topic/lookup?ctx=en/cloud/paas/app-builder-cloud&id=visual-application-

build

*/
module.exports = (grunt) => {
require ('load-grunt-tasks') (grunt) ;
grunt.initConfig({

// disable images minification
"vb-image-minify": {

options: {

skip: true,

}I

}I

// configure requirejs modules bundling
"vb-require-bundle": {

options: {

transpile: false,

minify: true,

emptyPaths: [

"vx/oracle cx_fragmentsUI/ui/self/resources/js/utils/contextHelper",
"vx/oracle cx_fragmentsUI/ui/self/resources/js/utils/actionsHelper",

"vx/oracle_cx fragmentsUI/ui/self/resources/js/utils/callbackHelper",

]l
}I

ORACLE
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}’
});
};

Create the Row Variable

Create a variable for the detail page. For example:

NoUhAUWUNRA

In Visual Builder Studio, click the App Uls tab.

Expand cx-custom > payment_c, then click the payment_c-detail node.
On the payment_c-detail tab, click the Variables subtab.

Click + Variable.
In the Create Variable dialog, make sure the Variable option is selected and, in the ID field, enter row.
In the Type field, select Object.

Click Create.

Add the Row Variable to the Detail Page

1. On the payment_c-detail tab, click the Page Designer subtab.
2. C(lick the Code button.

Live

Design

Code

3. Add the following parameter to the cx-detail code.

Chapter 2
Add a Custom Top Level Object

<oj-vb-fragment-param name="row" value="{{ $page.variables.row }}"></oj-vb-fragment-param>

Related Topics

« Overview of Smart Actions

ORACLE
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Enable the List Page of Custom Objects Not Yet Enabled for
Adaptive Search

Each custom object includes a list page that displays the records for that object. The list page becomes automatically
visible in the Ul after you enable the custom object for Adaptive Search. If you haven't yet enabled the object for
Adaptive Search, then you can make the list page visible by adding a line of code in Visual Builder Studio (VBS).

1. In VBS, select the App Uls tab open the custom object in the left pane and click the list page (Payment_c-list in
this example).

EH AmlUs +
& | Q FEe
1= - I;], ENCLESIEAT E
o L] Q applcation “+

- CE, payment_c 4
i

[E: 2125 18t LS A

® D payrnens c-edlt
0 [ pavment o-bst

N

Click Code on the list page tab.
3. Add the following line of code before the <oj-vb-fragment> end tag:

<oj-vb-fragment-param name="query" value="[[ [{'provider':'adfRest',6 'params':[]}] ]]"></oj-vb-fragment-
param>

Modify an Existing Custom Application Using the CX
Extension Generator

Once you have a working application extension in Oracle Visual Builder Studio (VBS), you can use the CX Extension
Generator to add additional custom objects and custom panels to custom objects. The CX Extension Generator
automatically generates their custom subviews and required smart actions. To use the tool, download your workspace
as a .zip file from Visual Builder Studio and then import it into the CX Extension Generator.

The process of adding objects and panels is the same as when you're created the application after you import from
Visual Builder Studio. Here's an overview of the steps detailed in this topic:

1. Export the files from Visual Builder Studio.
2. Import the files into CX Extension Generator.
3. Add objects, panels, and subviews.

18
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4. Generate the modified files for export.

5. Import the files back into Visual Builder Studio.

6. Add the panels and subviews to the panel and subview layouts.
7. Preview the updated application.

Prerequisites

In Application Composer:

- Create the new custom objects and child objects that you want to add to your existing application.

Export Files from Visual Builder Studio

To update an existing custom application, you must first download the application from your Visual Builder Studio
workspace.

In Visual Builder Studio, click the Menu icon at the top of the page, then click Export.

o2 Share

Settings

&
4 Import
(2]

Export

Import the .Zip File into CX Extension Generator

1. In a sandbox, navigate to Application Composer > CX Extension Generator.
2. Click Import Extension.

= {supremo @
CX Extension Generator

Manage CX Extensions

Create a new extension or import an existing extension from Oracle Visual Builder Studio.

Create Mew Extenaion

3. Inthe Import Application drawer, select your .zip file and click Import.

The existing objects in your application are now visible in the CX Extension Generator.

19
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Add Objects, Panels, and Subviews

Using CX Extension Generator, you can add additional objects, panels, and subviews. And you can generate smart
actions for them. To delete existing panels, change their order, and configure them, you must use Visual Builder Studio.

1. To add objects, click Actions > Add Objects and add any of the objects you want to configure.

2. Drill down on each object to configure the detail page. In the runtime application, the detail page is called the
Overview page.

Note: The CX Extension Generator displays only the Configure Panel and the panels you add during your
configuration. It doesn't display any of the panels you've added previously.

20
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3. To add a panel:
a. On the default Configure Panel, click Add.

Configure Panel

Add and configure a new panel.

Add

Chapter 2
Add a Custom Top Level Object

b. Inthe Add Panels drawer, select the custom related objects that you want to create the panels for. These
can be child objects and objects with either a 1:M or M:M relationship.

For example, select Shipments.

Add panels

Obijects
Shipments X

Create subview for each panel

Cancel

Add

c. Select the Create subview for each panel checkbox to automatically create a subview along with each

panel.

ORACLE

21



Oracle Fusion Cloud Sales Automation Chapter 2
How do | create an application extension for custom objects Add a Custom Top Level Object
in Oracle Visual Builder Studio?

I Note: If you don't select this check box, then you can add subviews later. See the next step.

d. Click Add.

Note: When you add a panel for an object with a M:M relationship, the generator creates the panel for
the intersection object you created as part of the M:M relationship rather than the object itself.

4. Optionally, click Configure > Subviews to add and remove subviews for each panel.

= {supremo 0o @3
g;;:';ent v [ Configure ™
+ Al objects Smart Actions
Payment - Record Name © Subviews
bel Item1 Value Item2 Label tem2 Vialue Iem3 Label Item3 Value

5. Click Configure > Smart Actions to review the smart actions that the Extension Generator will automatically
create for the objects that you selected.

Tip: You can optionally enhance a smart action's configuration after the Extension Generator creates them.
You do this by editing the smart action in Application Composer (Common Setup > Smart Actions). See
Overview of Smart Actions.

6. If your application includes more than one object, then use the Object drop-down field to switch between
objects to configure multiple detail pages.

Object
Payment

Payment

Shipment Name <
oy 2 Label Item?2 Value Item3 Label Item3 Value

Q Action Bar

7. After you've completed your changes, you can generate and download the .zip file.

Note: At any time, you can delete your configuration choices from the tool by clicking Actions > Start Over.

22
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oo B

Actions ~ Generate Files

—|— Add objects

Bl D Start Over [ &

Generate Files

Chapter 2
Add a Custom Top Level Object

When you're done with your application extension changes, navigate back to the CX Extension Generator list page and

click Generate Files.

The CX Extension Generator generates and downloads a .zip file that includes the pages and layouts for your selected

objects.

Import the Files Back into Visual Builder Studio

The CX Extension Generator generates a .zip file that you can import into Visual Builder Studio.

1. Use the Navigator to navigate to Visual Builder Studio: Configuration > Visual Builder.
2. In Visual Builder Studio, navigate to the workspace that contains your existing application.
3. Click the Menu icon at the top of the page, then click Import.

‘ Publish |

Share

Settings

4 1mport

[2] Export

4. Inthe Import Resources dialog, add your .zip file and click Import.

Your workspace is updated with the newly added objects and related artifacts, without disturbing the existing

objects in the application.

ORACLE
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For Custom Objects You Imported, Add the Panels and Subviews to the
Layout

If you imported custom objects, then you must add the imported panels and subviews to the custom Panel Container
and Subview Container layouts. This step isn't required for new customer objects you create.

1. Click the Design button.

Live Design

2. Confirm that you're viewing the page in Page Designer.

v Page

Templates

3. Remove the comment tags for the dynamic container components that contains the panels and any subviews.

2 <oj-vb-fragment bridges"[[vbBridge]]” name="oracle cx fragmentsuUl:cx-detail™ class="oj-flex-iter
3 <oj-vb-fragment -param names" ces”
4 value="[[ {'Payment_c' : {"puid’': $variables.puid, "id": $variables.id, 'endpoint’': $applic

5 <foj-vb-fragment -param>

0 <0j-vb-fragment-param name="header"”

7 value="[[ {'resource’: $flow.constants.objectName, 'extensionId': $application.constants.ex
B <foj-vb-fragment - param>

g <0]-vb-fragment -param name="actionBar”

a

1 value="[[ { "applicationId™: "ORACLE-ISS-APP", "rescurce”: {"name”: $flow.constants.objectn
11 <foj-vb-fragment - param>

12 <0j-vb-fragment - param name="panels®

13 value="[[ { “panelsMetadata”: $metadata.dynamicContainerMetadata, “wview™: $page.variables.v
14 <foj-vb-fragment - params

15 <0]-vb-fragment -param name="context"” wvalue="[[ { flowContext': $flow.variables.context} ]]7»«
16 <fo]j-vb-fragment>

17

18 <o]-dynamic-container layout="PanelsContainerLayout” layout-provider="[[ $metadata.dynamicConta
19 class="oj-flex-item oj-sm-12 oj-md-1"»</o]-dynamic-containers

28 <oj-dynamic-container layout="subviewContainerLayout™ layout-provider="[[ $metadata.dynamicCont
21 </oj-dynamic-containers

2

23

4. Highlight the <oj-dynamic-container> tags for the panels.

mj-dynamic-corkainer‘ layout="PanelsContainerLayout™ layout-provider="[[ $metadata.dynamicConta
class="oj-flex-item 0j-sm-12 oj-md-1"3</0j-dynamic-container>

24
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5. Add the panels you imported to the Panel Container Layout:
a. On the Structure panel, click the Panel Container Layout node.

stoounts-detail | O Sales

Mew to configuring applications? X

Let us guickhy show you how you can easily
configure your Fusion App using the editing
tools you see hene

(&) Play video  Tell me mone

Components (3¢ Constants (2

™ ex-detadl

= [ ex-dewail-impl

* [ ex-setion-bar

[ _cx-single-fisld-update

* 5 Panel Containes Lsyout

= [ Activity Feed Panel Template
= [ cufeedampl

- M gxfeeed ~carg

I carnotesimpl

N cx-mte-impl

™ Action menu button

b. On the Properties pane, add the imported panels to the custom layout by clicking Add Panel (the plus

Dizplay Logic
M+ case |

w¢ Case 1(Copy) e B

Ahvays Show

Unbonown Template

Unbonown Temnplate

Sales
Oecer
Sasiel
Template

L Sakes

Dedlers

Fanel O Sales
Template

subscriptions

“anel N Saked
Template

icon next to the Sections heading highlighted in the screenshot).
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6. Now repeat the same process for the Subview Container Layout.

accounts-detail | CX Sales

Hew to configuring applications?

Let us quickly show you how you can easily
configure your Fusion App using the editing
tools you see here,

(®) Play video  Tell me more

Components (77) Constants (2)

Q Filter

> r" cx-detail
= ™ cx-detail-impl

F accounts - Header Layout

™

ox-action-bar ey
™ cx-single-field-update e
v E¥ Panel Container Layout L)
= E} suthew Container Layout (B %

- n} Activity Feed Subwiew Templal&

* M exfeed-impl =

sapuadolg

a. On the Structure panel, click the Subview Container Layout node.
b. On the Properties pane, add the subview layouts to the custom subview layout, by clicking Add Panel
(the plus icon next to the Sections heading).

Preview

1.

>

Click the Preview button to see the newly added objects in the application.

P ® Q ‘ Publish |

The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-custom/<object_name> c

Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/<object name> c

I Note: You must add /application/container to the preview link.

You can now continue to make changes to your application extension, if needed.

ORACLE
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Create a Translation Bundle, If You Don't Have One
Already

Create a translation bundle where you can later store custom application strings for translation. If you plan to follow the
examples in this chapter, then create the translation bundle and string as indicated below.

1. In Oracle Visual Builder Studio, click the Translation Bundles side tab > + Translation Bundle.

| Translation Bundles + %
4 ‘ Q. Filter
C You don't have any

@ translation bundles

= defined yet.

. —+ Translation Bundle “
-

i

%o

2. Inthe Create Bundle dialog, in the Bundle Name field, enter the name of your translation bundle.

For example, enter customBundle.

3. Click Create.

4. Add any required strings to the translation bundle. For example, in the examples in this chapter, you'll use a
Contacts String.

On the CustomBundle tab, click + String.
In the Key field, enter contacts.
In the String field, enter contacts.
d. Click Create.
5. Also add a string for contact Name.

noo

On the CustomBundle tab, click + String.
In the Key field, enter contactname.

In the String field, enter contact Name.
Click Create.

e ngoo
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Configure a Child Object

Add a panel for a child object to the parent and configure the subview for the child object.

Configure the Panel for the Child Object

Configure the panel for the child object using the cx-panel fragment.

To configure the panel region:

In Visual Builder Studio, click the App Uls tab.

Expand cx-custom > payment_c, then click the payment_c-detail node.
On the payment_c-detail tab, click the Page Designer subtab.

Click the Code button.

PUNA

Live Design Code

1. Before we update the rule set and layout that you just created, let’s create a custom field that will be used on the

panel itself.
The panels on the detail page use the avatar-card style. This means that the panel will have an avatar, which is
a visual representation of one of the fields on the panel, typically a name.

Payment Lines

Wells Payment

2,000
haresh.pahilajani@oracle.com
3/29/23 9:53 PM

In this step, let's create a custom field, avatar, as well as the avatarFieldTemplate field template, which defines
the style of the avatar.

Create the custom field first.

On the PaymentLineCollection_c tab, click the Fields subtab.

Click + Custom Field.

In the Create Field dialog, in the Label field, enter avatar.

In the ID field, the value should be avatar.

In the Type field, select Object (Virtual Field).

Click Create.

On the Properties pane for the new virtual field, next to the Fields section, click Add.
Select RecordName.

@ 0 Qn OO
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Pick any field from which initials can be derived. For example, we can use the RecordName field for
custom objects. For the Account object, you would select the PartyName field.
i. Click Add.

Create the field template next.

On the PaymentLinesCollection_c tab, click the Templates subtab.
Click + Template.

In the Create Template dialog, for Type, select the Field option.

In the Label field, enter avatarFieldTemplate.

Click Create.

P an o9

Map the custom field to the field template.

a. On the PaymentLinesCollection_c tab, click the JSON subtab.
b. Inthe panelcardrayout section, add this code:

’
"fieldTemplateMap": {
"avatar": "avatarFieldTemplate"
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}

The resulting code will look like this:

"PanelCardLayout"”: H
"type": "cx-custom”,
"layoutType": "form”,
"label™: "PanelCardLayout”,
"rules”: [
"isDefault”
B
"layouts™: {
"default™: {
"layoutType™: "form",
"layout™: {
"displayProperties”: [],
"templateId”: "defaultTemplate”,

"labelkdge"” : "none”
¥
"usedIn": [
"isDefault”
]
¥
L
"fieldTemplatemap™: {
"avatar”: "avatarFieldTemplate™
}
¥

ORACLE

30



Oracle Fusion Cloud Sales Automation
How do | create an application extension for custom objects
in Oracle Visual Builder Studio?

Chapter 2
Add a Custom Top Level Object

2. Next, let's add the fields that you want to display on the panel.

a. Onthe PaymentLineCollection_c tab, click the Rule Sets subtab.

Click the Open icon next to the default layout.
c. Click the cx-card fragment.

This fragment provides the format of the panel.

[E'.] payment_c-detail x %PaymentheCollection_c x

{ RuleSets PanelCardlLayout Layout default

EE Use Simple Layout

|_-=| Use Template

Rule Sets (1) Fields Templates Actions Event Listeners

Select fields to display >

1Y cx-card Application Comp...

oracle_cx_fragmentsUl:cx-card

.

/

d. Each panel includes specific slots. From the list of fields, drag each field to the desired slot.

For example, drag and drop the Avatar field to the avatarltem slot.

O F & - Set oracke_cx_fragmentsUlcx-card parameters

Fields

A avataritem

Suggested Fields.
O # amount ¢
O A pement_ld_c
O A Typec S ——
All Fields

O # ameunt ¢

O A conflictid

Diop a field from fields paleite

Drag and drop other desired fields to the appropriate slots.
e. On the Properties pane, click Go to Template.

ORACLE
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3. Onthe Templates subtab, click the Code button.

Live Design Code

4. Add the following parameters to the template code.

<oj-vb-fragment-param name="dynamicLayoutContext" value="{{ $dynamiclLayoutContext }}"></oj-vb-fragment-
param>

<oj-vb-fragment-param name="style" value="avatar-card"></oj-vb-fragment-param>

<oj-vb-fragment-param name="enableActions" value="false"></oj-vb-fragment-param>
<oj-vb-fragment-param name="badgeItemColor" value="oj-badge-success"></oj-vb-fragment-param>

The template code should look like the below sample. (The below sample also includes style instructions for the
avatarFieldTemplate field template.)

<!-- Contains Dynamic UI layout templates -->

<template id="defaultTemplate">

<oj-vb-fragment name="oracle cx fragmentsUI:cx-card" bridge="[[ vbBridge ]]">

<oj-vb-fragment-param name="dynamicLayoutContext" value="{{ $dynamiclLayoutContext }}"></oj-vb-fragment-
param>

<oj-vb-fragment-param name="style" value="avatar-card"></oj-vb-fragment-param>
<oj-vb-fragment-param name="enableActions" value="false"></oj-vb-fragment-param>

<oj-vb-fragment-param name="badgeItem" value="[[ $fields.Type c.name ]]">
</oj-vb-fragment-param>

<oj-vb-fragment-param name="avatarItem" value="[[ $fields.avatar.name ]]">
</oj-vb-fragment-param>

<oj-vb-fragment-param name="iteml" value="[[ $fields.RecordName.name ]]">
</oj-vb-fragment-param>

<oj-vb-fragment-param name="item4" value="[[ $fields.CreationDate.name ]]">
</oj-vb-fragment-param>

<oj-vb-fragment-param name="item2" value="[[ $fields.Amount_c.name 11">
</oj-vb-fragment-param>

<oj-vb-fragment-param name="item3" value="[[ $fields.CreatedBy.name ]]">

</oj-vb-fragment-param>

<oj-vb-fragment-param name="badgeItemColor" value="oj-badge-success"></oj-vb-fragment-param>
</oj-vb-fragment>

</template>

<template id="avatarFieldTemplate">

<oj-avatar role="img" size="sm" initials="[[ oj.IntlConverterUtils.getInitials ($value.RecordName(),
$value.RecordName()) 11"
raria-label="[['Avatar of ' + $value.RecordName()]]"
:title="[['Avatar of ' + $value.RecordName()]]" background="green">

</oj-avatar></template>
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You can add more fields by returning to the default layout and dragging and dropping, as you previously did.

Alternatively, you can add fields to the panel using the Properties pane. To do this, click the Fragment Container
node in the Structure pane.

[ payment_c-detail x

4@ PaymentLineCollection_c x

Rule Sets (1) Fields  Templates (1)  Actions
¢ Templates defaultTemplate
‘ Q. Filter, Alt+F =

Components
B

BEE@m B B

Foldout Layout

Foldout Layout Horizontal Template
Pattern

Foldout Layout Vertical Template
Pattern

Foldout Panel
Gantt Page Pattern
General Drawer Template

General Overview Page Template

— Ganaral Muanaes Page Tamnlate

‘ Q. Filter ‘ =

* EJ Template (defavitTemplate)

l' ™ Fragm!:nt(ontalncr]

Structure

B Fragment Input Parameter (¢
[ EragmentlnputPaameter (¢

[3 Fragment Input Parameter (s
B Fragment Input Parameter (e
[ Eraementlnout Parameter (€
Eragment lnput Paramster (i

[ _Fraosment Inniit Paramester (i

< Return to pa

L= < T = R T A T S

O e
WOk = @

14

Event Liste

<l--
<temp
<07
<

MAA A A A A A A A A A A A A

<
</o]
</tem

<temp]
<0j-a

Lk

Then, add your desired custom object fields using the Input Parameter fields on the Properties pane.

ORACLE
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< Fragment Container = 51‘:
=
1]

General Events All e
()

D

Fragment Select

_____ cx=-card
Application Components

MNo description provided.
Go to Fragment
Input Parameters

ﬁatarltem \

| [ $fields.avatar.name ]]

A badgeltem

| [[ $fields. Type_c.name ]]

A badgeltemColor

| oj-badge-success

3K dynamicLayoutContext ~ )
11} _/

This table describes some of the parameters that you can provide for a custom panel.

Parameters for Custom Panel

Parameter Name Description
style Specify "avatar-card" for the panels that you add to the detail page.
enableActions Panels can have actions when they display on a dashboard. Panels that display on a detail page

typically don't need actions, however, so set this parameter to "false".

ORACLE
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5. Manually update the template's JSON with the labelEdge property.

a. On the PaymentLineCollection_c tab, click the JSON subtab.

b. Inthe section for the PanelCardLayout's default layout, add the labelEdge property with a value of

"none"

In our example, this is what the labelEdge property should look like:

"PanelCardLayout™: {
"type": “"cx-custom”,
"layoutType": "form",
"label™: "PanelCardLayout"”,
"rules™: [
"isDefault"
P
"layouts™: {
"default™: {
"layoutType": "form",
"layout™: {
"displayProperties™: [],
"templateId”: "defaultTemplate'E]
| "labelEdge” : "none"
P
"usedIn™: [
"isDefault”

]
¥

}s

ORACLE
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6. Finally, comment out the dynamic container component from the payment_c-detail page.

a. Click the payment_c-detail tab, then click the Page Designer subtab.
b. Click the Code button.
c. Select Page from the dropdown.

[ payment_c-detail x 4% PaymentLineCollection_c

Page Designer  Actions Event Listeners Events

x

Types Variab

| Q. Filter, Alt+F ‘ =

%3]
=
g
S fragme
a ~ Redwood Patterns
£ _ V' Page l view-c
o Advanced Create and Edit Page -vb-fr
Template Templates vb-fr
= Bottom Drawer Template 5 <oj-vb-fr
1]
S _ . .
[B Create Edit Drawer Template 6 <0j-vb-fr
7 <oj-vb-fr
=i Dashboard Landing Page Template 2 </oi-vb-fraem

d. Comment out the dynamic container component that you added for the panel region.

15
16
17
18
19
28
21
22
23

<oj-vb-fragment bridges"[[vbBridge]]” name="oracle c¢x fragmentsUl:cx-detail™ c¢lasss™oj-flex-ites

<0j-vb-fragment -param name="resources”

value="[[ {"Payment_c' : {"puid’: $variables.puid, "id': $variables.id,

<foj-vb-fragment - param>
<oj-vb-fragment-param name="header"”
r

"endpoint’: Sapplic

value="[[ {'resource’: $flow.constants.objectName, "extensionId®: Sapplication.constants.ex

<foj-vb-fragment -param>
<oj-vb-fragment -param name="actionBar”

value="[[ { "applicationId™: "ORACLE-ISS-APP", "resource”: {"name":

<foj-vb-fragment - params
<oj-vb-fragment - param names="panels”

value="[[ { "panelsMetadata": $metadata.dynamicContainermetadata,
<foj-vb-fragment - param»

“wiew™:

$flow.constants.objectn

$page.variables.v

<0j-vb-fragment -param name="context"” wvalue="[[ { flowContext': $flow.variables.context} ]]"»<

¢/ o] -vb-fragment>

¢o]-dynamic-container layout="PanelsContainerLayout" layout-provider="[[ $metadata.dynamicConta

class="oj-flex-item oj-sm-12 oj-md-1"></07-dynamic-containers

<oj-dynamic-container layout="SubviewContainerLayout™ layout-provider="[[ $metadata.dynamicCont

£foj-dynamic-containers
J-dy

Note: To add more panels to the panel region, you must first un-comment the dynamic container
component so that you can add a new section for each desired panel.
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7. Test the panel that you added by previewing your application extension from the payment_c-list page.

a. From the payment_c-list page, click the Preview button to see your changes in your runtime test
environment.

P ® Q ‘ Publish | =

b. The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-custom/payment c/payment c-list
c. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/payment_c/payment c-list

The screenshot below illustrates what the list page looks like with data.

All Payments Ao

O | Try searching by ke Al Filter

— [ = - CEErA T S W
&3 Resulis
Paymient Name 5 Creation Date = Last Updated Date S Actions

0  Payment, Octimoice 101922 10003 P 11,17/25 4:2% AM
O  Payment for Order 1020 1171722 206 AM 11/17/23 4:42 AM
O  Payment 11/2 for Octaber 15 crder 1173422 737 PM 12719722 5:23 PM
O /7722 616 P 1177722 816 PM
O Mot 1177722 6:45 PM 1177722 645 PM

d. If data exists, you can click any record on the list page to drill down to the detail page. The detail page,
including header region and panels, should display.

Note: The screenshot below illustrates what a panel looks like with data. In your testing, the panel
might be empty.
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+ Al Payments

Payment for Laptops @

Amount 5000  Payment Date 3/28/23
H
/ﬁl_yment Lines \
m Wells Payment Secondary
2,000

haresh.pahilajani@oracle.com
3/29/23 953 PM

Secondary

)

BOA Payment

1,000
haresh_pahilajani@oracle com
32923 9:52 PM

N

Iw-\-.- All Payment Lines [.le
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Hext:Payment for Printers

[; Payment Details

The link at the bottom of the panel navigates the user to the subview. Learn how to configure the

subview in Configure the Subview for Child Objects.
8. Save your work by using the Push Git command.

Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the

Git repository).

gen-sales.git /20220830

Gl Gt @ D detail
A Q Filter Switch Branch
& » Changed (1) Commit. Commit

Mo Pull

.

® Merge

| Reset to HEAD
o E
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Configure the Subview for Child Objects

You can use fragments in Oracle Visual Builder Studio to create a custom object’s user interface pages: the list page,
create page, and detail page with panels. A panel can display only a few records, however, due to limited real estate.
To see all records, users must navigate from the panel to a subview. This topic explains how to build the subview using
fragments.

What's a Subview?

Since the real estate of a panel is small, users can click a View All link to navigate to a second page that displays all
records.

Here's a screenshot of a View All Contacts link on a panel. Notice that, in this example, the panel itself has room to
display only one contact, John Cook, although a total of three records exist. Users can click the View All Contacts link to
see all three contacts.

Contacts

IC John Cook

sendmail-test-discard@oracle.com

View All Contacts (3)

Here's a screenshot of a subview. A subview includes a basic information region at the top and a table. If you create
a custom panel for a child or related object, then you must create this page, as well. You can create this page using a
fragment.
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Pinnacle Technologies: Contacts

Create the Payment Lines Subview

Let's create the subview for our payment records. To do this, we'll add a new dynamic container to the detail page in
Page Designer.

In Visual Builder Studio, click the App Uls tab.

Expand cx-custom > payment_c, then click the payment_c-detail node.
On the payment_c-detail tab, click the Page Designer subtab.

Confirm that you are viewing the page in Page Designer.

P UWUN

Page

v Page

Templates

5. Click the Code button.

Live Design Code

o

In the Filter field, enter dynamic container.

7. Drag and drop the dynamic container component to the detail page canvas, outside the previous dynamic
container that holds the panels. This dynamic container will hold the subview.

8. In the code for the dynamic container, replace containerLayoutl With subviewContainerLayout.

¢! --pj-dynamic-container layout="PanelsContainerLayout™ layout-provider="[[ $metadata.dynami

amic-contalner-->»

<0j-dynamic-container layout="subviewContainerLayout]’ ]'_.-Jyu.n -provider="[[ $metadata.dynamicC

9. On the payment_c-detail tab, click the JSON subtab.
10. In the detail page's JSON, rename the two instances of containerLayoutl tO SubviewContainerLayout.

The two instances appear in the "1ayouts" section and in the "templates" section. Here's where the instance
appears in the "templates" section.
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"templates”: {
"leads": {
"title": "Leads",
"description": "",
"extensible": "byReference”,

lltﬂ]dt" : {
"type": "section”,
"layout™: "PanelsContainerLayout™
}
¥

"paymentLines": {
"title": "Payment Lines",

"description™: "V,
"extensible™: "byReference”,

"adtt: {
"type": "section”,
"layout"”: "PanelsContainerLayout”
¥
¥

"templatel™: {
"title": "Default Section”,
"extensible": "byReference”,
“@dt”: {

"type": "section”,

"layout”: "containerLayout2"

}
¥

Create the section template that will be used for the subview.

On the payment_c-detail tab, click the Page Designer subtab.

P WOWN

In the ID field, change the value to paymentLinecollection_c.

On the Properties pane, in the Case 1 region, click the Add Section icon, and then click New Section.
In the Title field, enter a title for the section using the REST child object name, such as paymentLineCollection c.

| Note: You can retrieve the REST child object name from the service connection endpoint.

» [PaymentLineCollection_c |

Gl Services + [ payment c-detall = 4g PaymentLineCollectionc x| &3 ct-custom
¢.. Service Connecliond  Backends Orverbew Servers Headers Souarce Y Metadats
Q F '
E] DELETE SRR Delete
.
» Attachment
i} Fuoen Dependendies
>
[ b Apphcation Companents e
o » CXSales * PaymentContactMMInter_Src_Payment_cToPaymentContactMMInter_c_Tgt
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5. Click OK.
6. Delete the pefault section.

Display Logic
+ Case

Case 1 ® :
Condition

Always Show

Sections -

PaymentLineCollection_c

7. Manually update the template's JSON with the correct subview name.

a. On the Payment_c-detail tab, click the JSON subtab.

b. In the section for the SubviewContainerLayout's section template layout, replace the sectionTemplateMap
and displayProperties values to match the subview's name, PaymentLineCollection_c.

In our example, this is what the SubviewContainerLayout's sectionTemplateMap and displayProperties

should look like:
len'gu‘n-nt c-detall x
Page Designer Actions Event Listeners Events Types Variables (3 lavaScript JSON Settings
57 L
S8 "subviewContainerLayout™: {
59 "label™: "Container Rule Set 17,
6 "layoutType”: "container”,
61 “layouts™: {
62 "casel™: {
63 "label": "Case 1",
64 "layoutType™: "container”,
65 "layout”: {
"soctionTemplateMap™: {
67 ["Paymr:uj.ne[ollectim_c"| "paymentLineCollectionC”
68 },
69 "displayProperties™: [
70 |"PaymentLineCollection ¢ |
i | ]
72 }
73 }
74 }s
75 "rules”: [
76 "containerLayout2-rulel”
77 ]
78 b

Configure the Subview Layout
We previously added the subview dynamic container to the page, as well as the section template.

Build the structure of the subview using the cx-subview fragment.
1. On the Properties pane, click the PaymentLineCollection_c section that you just added.
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Page Designer navigates you to the template editor, still on the payment_c-detail tab, where you can design the
PaymentLineCollection_c template.

2. Click the Code button.
Live Design Code
3. Onthe Components palette, in the Filter field, enter cx-subview.
4. Drag and drop the cx-subview fragment to the template editor, between the paymentLineCollectionC template
tags.
%mﬁﬂ::ll c zll-EJ::l 4 %H.IEIIII'.'I'. £ X ‘E“}I mentLineCollection ¢ x
MML Actions Event Listeners Evenis Types Variables (3 JavaScript 150N Settings
2 Q, ex-subview o = < Return to page
g g
E ~ Fragments @ 28 <template id="leads"»
S 21 </templatex
23
E <template id="paymentLineCollectionC™>
26 </template>

Add the following parameters to the fragment code so that the code looks like the below sample. Be sure to
replace payment__c_Id and paymentLineCollection_c With the appropriate values for your custom top level and
child objects. Retrieve these values from the service connection endpoint.

=} Services + [y payment _c-detall x & ce-custom
& Service Connections  Backends Overview Servers  Headers  Source /) Endpoints /) Metadata
-
o
~ PaymentLineCollection_c
i I SPayment_c/{Payment__e_ld) fehild /PaymentLineCollection_e I
Get Mary Get all
] From Dependencies m v :
L) v Application Components [ posT DS Create

<template id="paymentLineCollectionC">

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx_ fragmentsUI:cx-subview">
<oj-vb-fragment-param name="resource"

value='[[ {"name": $flow.constants.objectName,
$application.constants.serviceConnection } 1]'>
</oj-vb-fragment-param>

<oj-vb-fragment-param name="sortCriteria" value='[[ [{"attribute":
"desc" }] 11'>

</oj-vb-fragment-param>
<oj-vb-fragment-param name="query"
value='[[ [{"type": "selfLink", "params":
oj-vb-fragment-param>
<oj-vb-fragment-param name="child" wvalue='[[ {"name":
"relationship": "Child"} ]]'></oj-vb-fragment-param>
<oj-vb-fragment-param name="context" value="[[ {} ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="extensionId" value="[[ $application.constants.extensionId ]]"></oj-vb-
fragment-param>

"primaryKey": "Id", "endpoint":

"LastUpdateDate", "direction":

[{"key": "Payment_ c Id", "value": $variables.id }1}]1 ]1]'></

"PaymentLineCollection_c", "primaryKey": "Id4d",

</oj-vb-fragment>
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</template>

This table describes the parameters that you can provide for the subview:

Parameters for Subview
Parameter Name Description
sortCriteria Specify how to sort the data on the subview, such as sort by last updated date and descending
order.
query Include criteria for querying the data on the subview.
child Enter the REST child object name for the child object that the panel is based on.

Configure the subview layout.

1. Click the Layouts tab, then click PaymentLineCollection_c.
2. On the PaymentLineCollection_c tab, click + Rule Set to create a new rule set for the layout.

In the Create Rule Set dialog, in the Component field, select Dynamic Table.
In the Label field, enter subviewLayout.
In the ID field, change the value to subviewLayout.
d. Click Create.
3. Add the fields that you want to display in the layout.

n oo

a. Click the Open icon next to the default layout.

b. From the list of fields, select the fields that you want to display on the subview table. The fields display as
columns in the order that you click them, but you can rearrange them.
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4. Create an event so that users can be automatically navigated back to the subview after editing the payment.

a.
b.

On the payment_c-detail tab, click the Page Designer subtab.
Confirm that you are viewing the page in Page Designer.

v Page

Templates

Click the Code button.

Live Design Code

In the code for the detail page, click the oj-vb-fragment tag.

{ “panelsHetadata”: fmetadata.dynami

[ {"flowContext®: $flow.variables.cont

<oj-vb-fragment
7 <oj-vb-fragment
8 «</oj-vb-fragment>

9 ¢l--o0j-dynamic-container layout="PanelsContainerLayout”™ layout-providers"[[ smetadata.c
18 namic-container-->

11 amic-container layout="SubviewContainerLayout™ layout-provider="[[ $metadata.dyr
12

Page = Live Design Code
1 to] -vb-fragment |L|r' idge="[[vbBridge]]" name="oracle cx_fragmentsul:cx-detail™ class="oj. JU
2 on-view-change-event="[[$listeners.fragmentviewChangeEvent]]™>
3 ¢oj-vb-fragment-param names"res e="[ [ ["puid’: $variable:
4 <oj-vb-fragment-par ow. constants.objecti:
5 <0j-vh-fragment e="[[ { "applicationId": “ORACLE-ISS-AF

On the Properties pane for the cx-detail fragment, click the Events subtab.

i. Click + New Event > On 'viewChangeEvent'.
i. Dragan Assign Variables action onto the canvas.
i

iv. Inthe Variables popup, under the Page heading, click view.

ili. Onthe Properties pane, next to the Variable field, click the Select Variable icon.

ORACLE
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Variable * Create

view{ A

Page
A id
AL puid

.‘i\u view

Flow

{} context

Extension

A $extension.path

v. Inthe Value field, enter {{ payload.view }}.
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5. Comment out the subview's dynamic container component from the payment_c-detail page.

a. Click the payment_c-detail tab, then click the Page Designer subtab.
b. Click the Code button.
c. Select Page from the dropdown.

[EJ payment_c-detail X 4@ PaymentLineCollection_c X
Page Designer  Actions Event Listeners Events Types Variab
[l 1 fa =
s [Qemmr ] =
Y
5 fragme
(=4 ~ Redwood Patterns
£ v Page view-c
o Advanced Create and Edit Page _vb-fr
Template Templates
-vb-fr
g Bottom Drawer Template 5 <oj-vb-fr
Q _ . =
[ Create Edit Drawer Template 6 <0j-vb-fr
) 7 <o0j-vb-fr
Dashboard Landing Page Template 2 </oi-vb-fraem

d. Comment out the dynamic container component that you added for the subview.

1 <0j-vb-fragment bridge="[[vbBridge]]” name="oracle_cx_fragmentsUI:cx-detail™ class="oj
2 on-view-change-event="[[$listeners.fragmentViewChangeEvent]] >

3 <0j-vb-fragment-param name="resources” value="[[ {'Payment_c’ : {"puid’: $variable
4 <oj-vb-fragment-param name="header” value="[[ {"resource’: $flow.constants.objectn
5 <oj-vb-fragment-param name="actionBar”™ wvalue="[[ { "applicationId”: "ORACLE-IS55-A
6 <0j-vb-fragment-param name="panels” wvalue="[[ { "panelsMetadata™: $metadata.dynami
7 <oj-vb-fragment-param name="context”™ wvalue="[[ {'flowContext’: $flow.variables.con
8 <foj-vb-fragment>

9  <l--oj-dynamic-container layout="PanelsContainerLayout™ layout-provider="[[ $metadata.
(] </oj-dynamic-container--»

11 [<!--}bj-dynamic-container layout="SubviewContainerLayout” layout-provider="[[ $metadata
12 <fo]-dynamic cuntai-m

13

6. Add an Actions menu to the subview.
To do this, create a custom field, actions Menu.

On the PaymentLineCollection_c tab, click the Fields subtab.
Click + Custom Field.

In the Create Field dialog, in the Label field, enter actions Menu.
In the ID field, the value should be actionsMenu.

In the Type field, select String.

Click Create.

-0 9 n T

Map the custom field to the field template.

a. On the PaymentLinesCollection_c tab, click the JSON subtab.
b. In the subviewLayout section, add this code:
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"fieldTemplateMap": {
"actionsMenu" : "actionMenuTemplate"

}

The resulting code will look like this:

"SubviewLayout”: {
"type": “"cx-custom”,
"layoutType": "table",
"label™: "SubViewlLayout",
"rules™: [

"isDefault2"

1
"layouts™: {

"default™: {
"layoutType": "table",
"layout”: {

"displayProperties™: [
"RecordName"”,
"Amount c”,

"Type_c"
]
¥
"usedIn™: [
"isDefault2"”
]
¥

1

L]
"fieldTemplateMap”: {

}

‘ "actionsMenu” : "actionMenuTemplate”

h

Add the custom field to the subview table.

Click SubViewLayout.
Click the Open icon next to the default layout.

angoo

Click the PaymentLineCollection_c tab > Rule Sets subtab.

From the list of fields, click the actionsMenu field to add it to the subview table.

ORACLE
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7. The Actions menu provides both an Edit and Delete action. Users click Edit to edit a payment line.

Create a layout for the edit payment line page.

~~ -~

Type < Actions Menu <

Secondary

Sed Edit

Delete

a. On the PaymentLineCollection_c tab, click < Rule Set to return to the main Rule Sets page where you can
create a new rule set.

i. Click + Rule Set.
ii. Inthe Create Rule Set dialog, in the Component field, select Dynamic Form.
ili. Inthe Label field, enter editLayout.
iv. Inthe ID field, change the value to editLayout.
v. Click Create.
b. Add the fields that you want to display in the layout.

i. Click the Open icon next to the default layout.
ii. Click Select fields to display.

iii. From the list of fields, select the fields that you want to display on the edit payment line page. The
fields display as columns in the order that you click them, but you can rearrange them.

c. On the Properties pane for this layout, in the Max Columns field, enter 2.

You might need to click < Form to see the properties for the layout.
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8. Test the subview by previewing your application extension from the payment_c-list page.

a. From the payment_c-list page, click the Preview button to see your changes in your runtime test
environment.

P ® Q ‘ Publish | =

b. The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-custom/payment c/payment c-list
c. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/payment_c/payment c-list

The screenshot below illustrates what the list page looks like with data.

All Payments Ao

O | Try searching by ke Al Filter

— [ = - CEErA T S W
&3 Resulis
Paymient Name 5 Creation Date = Last Updated Date S Actions

0  Payment, Octimoice 101922 10003 P 11,17/25 4:2% AM
O  Payment for Order 1020 1171722 206 AM 11/17/23 4:42 AM
O  Payment 11/2 for Octaber 15 crder 1173422 737 PM 12719722 5:23 PM
O /7722 616 P 1177722 816 PM
O Mot 1177722 6:45 PM 1177722 645 PM

d. If data exists, you can click any record on the list page to drill down to the detail page. The detail page,
including header region and panels, should display.

Note: The screenshot below illustrates what a panel looks like with data. In your testing, the panel
might be empty.
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supremo

1+ All Payments

Payment for Laptops @

Amount 5,000 Payment Date 3/28/23
» Try Add ntact
(ﬂc—yment Lines \
m Wells Payment Secondary
2,000

haresh.pahilajani@oracle.com
3/29/23 9:53 PM

BOA Payment Secondary
1,000
haresh.pahilajani@oracle.com
\ 32923 9:52 PM _/

l\-"lf:l'.l All Payment Lines [i]l

Hext:Payment for Printers

[; Payment Details

e. Click the View All link to drill down to the subview.
Al Payments
Payment for Laptops @ [ Pusment Desass
i 5,000 Paynenl Dale 328723
» Ty Akt
= Go o Overvies
Payment Lines
PaymentLine Name = Amount Type = Acthons Menu T
Whells, Payment 3000 Secondary
B0 Payment [ r] Secondary
f. Click the Actions Menu > Edit to edit the payment line.
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Payment Lines

Pargmigait] e Wi Arvanartt
Woells Payment 5,000
Erees B0 2 dpvast chaasien

s'écmnaw

9. Save your work by using the Push Git command.

Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the
Git repository).

« Workspace2 > .git/20220830

1

q

) Git 3 0D dea
47, I QU Filter Switch Branch
cy » Changed (1) Commit. Commit

o Pull

e

@ Merge

Reset to HEAD
@

Display a Smart Action on a Child Object Subview Only for a
Specific Parent Object

When you create a subview for a child object, you may need to create smart actions that apply specifically to that
subview.

Suppose, for example, that you used the CX Extension Generator to display a list of shipments on payments, with
Shipments being a child object of Payments. CX Extension Generator automatically creates the Add smart action that
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users enter in the Action Bar to add shipments to payments, but it doesn't create any smart action to remove the entry.
Here are the steps to create the smart action and make it available only on the Payment subview.

1. Create the Remove smart action as a REST-based smart action as described in the topic Create REST-Based
Smart Actions. Be sure to enter the name of the parent object in the Context region of the Availability page.

2. In VB Studio open the parent object's detail page and view the Template code (App Uls > Payment_c_detail >

Code > Page > Template

= .__.“ T |
A S —— - e
g - e— ;- i - P = o _|'\-l.; o )
4 . By ¥ 4 e e s il .
- Ry s & - = [ ) o
B . x = [ER. o 3 "
L o P ———— 2 —E—tut
B . ! -
T ¥ Cme e
Y gt et ==
T #
& o By v .
T Singrae il
PR = T— [y —— .
b O Femgran - [T .
b3 R R e

3. Find the template for the subview in the code, and add the following parameter:

<oj-vb-fragment-param name=“enableActions” value='[[{“enabled”: “true”, “enableContext”:

oj-vb-fragment-param>

Insert it right before the </oj-vb-fragment> tag.

“true”}] ] r ></

mp-’rnlrﬂ c-ditail iy Bhipmant e

Pape Deslgngr  Action Chains (1) Evend Listensrs 1) Events  Types  Varables(s) Design Teme  JovaSoript  JSON  Settings
n Templates =
E B9 wa]=vi-fragment-paran nases”sxtension]d” values" [[ Sapplication.constants.extensiond |]"mcfof-wh=frageent-params
E an </oj-vb-1rageent>
81  «/tesplates
92
- 91  <tesplate id="Shipsent_PaymentShipsent1M_TgtSubwiewTemplate™s
E 04 <0 f=wb=1rageent bridges"[[vbBridgel]™ nases"sracle cx fragsentsll]:ce-subvimd">
a3 o] -vi-fragment-paran nase="rescarce”
a6 walues'[[ {"namg™: “Shipssnt_c*, "prisaryley”: =Id", “endpoint™: fagplication.constants.serviceConmection } )] =</a)
a7 «0] =yb-Trageent-parsa ndde="4ortCriteria™ waluve="[[ [{"attribute”: “"LaitUpdateDate” "direction”: =dedsc™ }) 1]'=
Ga wfio ] =vb=1ragment-parame
a3 =0) == rageent-paras AkSes"guery”
108 walves'[[ [{"type™: “gbe”, “"params”: [{"key™: "Payment_Id_PaymentShipsentI™®, “value™: Svariables.id }H 1)'=
181 <fa]-vb-1ragsent -parass
182 <0 -vb-fragment-paran name="context” wvalue="[[ { } J]I==
183 <f@]=vi=1 ragaent-parass
i i —yh— ¥ e ala s T ] ape” I nfa= Lypa” | 0 fl it REn Fas wbi-{ caament —ng e

185 ag] =wt=frageent-paran nasgs~enableActions” values' [[{™enabled”: “treme™, “enafleContext”: “true™}]] "st/oj-vh=1 ragsent-params

106 =/aj-vb-1 rageents
187 </templates

Add a Standard Object Panel for Related Objects (One-

to-Many)

You can configure an object's detail page by adding panels for related objects. This makes it easy for users to see —on a
single page - all pertinent information related to a record. You can add custom object panels or standard object panels.
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This topic illustrates how to add a standard object panel to an object's detail page (when the panel object is related via a
one-to-many relationship).

What's the Scenario?

Let's look at an example. In this example, the Payment object has a one-to-many relationship with the Lead object. At
runtime, users should be able to create leads for a payment, and view those leads on the Payment detail page.

Setup Overview

To enable users to create leads for a payment, we'll add a Leads panel and subview to the Payment detail page.

1. First, create the Create Lead smart action in Application Composer.

See Prerequisite: Create Smart Action.
2. Add a new Leads panel to the Payment detail page.

See Add the Leads Panel to the Payment Detail Page.
3. After adding the Leads panel, you can then add the subview.

See Add a Subview for the Leads Panel.

Prerequisite: Create Smart Action

The Create Lead smart action displays from the Action Bar on both the Payment detail page and Leads subview. Users
can select the Create Lead smart action to navigate to a create lead page.

Note: If you previously created a Create Lead smart action for a non-fragments implementation, then you don't need
to create a new smart action for this use case. Instead, update your existing smart action to specify the Create action

type, object, and field mapping. This ensures that your custom smart action still works with this new fragment-based

extension.

If you haven't yet created a Create Lead smart action, then create one now:

Create a sandbox.

In Application Composer, under the Common Setup menu, click Smart Actions.
At the top of the page, click Create.

On the Kind of Action page, click Ul-based action and then click Continue.

On the Basic Details page, in the Name field, enter the smart action name.

vhUND

For example, enter create Lead.
In the Object field, select the one-to-many relationship's source object.

o

In this case, select Payment and then click Continue.

On the Availability page, in the Application field, select Sales.

In the Ul Availability field, select List Page and click Continue.

On the Action Type page, in the Type field, select Create.

In the Target Object field, under the Top Level Object heading, select the one-to-many relationship's target
object.

© 0 ™y

1

For example, select Sales Lead.
11. In the Field Mapping region, click Add.
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12. In the Actions column, click the Edit icon and then set these field values:

Field Mapping n

Mame = % Type Yz Value = 2 Actions

Attribute a

Attribute Defaults
Column Value
Name Select the field on the one-to-many relationship's target object that holds the source object's ID
and relationship name. This is a standard field on the target object (Sales Lead).
The format of the field name is always <Source object name>_Id <Relationship
name>. For example, select Payment ID PaymentLead1M (Payment_ld_PaymentLead1M).
Note:
You won't see this field on the target object in Application Composer.
Type Attribute
Value Select Record ID (Id). This is a standard field on the source object (Payment).
This means that when users create a lead, the create smart action defaults the payment's ID
into the lead record's Payment ID PaymentLead1M (Payment_ld_PaymentLead1M) attribute.
13. Click Done.

14. Click Continue.
15. On the Action Details page, in the Navigation Target field, select Local and then click Continue.
16. On the Review and Submit page, click Submit.

Add the Leads Panel to the Payment Detail Page

To add a new Leads panel to the Payment detail page:

In Visual Builder Studio, click the App Uls tab.

Expand cx-custom > payment_c, then click the payment_c-detail node.
On the payment_c-detail tab, click the Page Designer subtab.

Click the Code button.

PWNA

Live Design Code

5. Confirm that you are viewing the page in Page Designer.
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v Page

Templates

6. Add the following code to the canvas, just below the closing </oj-vb-fragment> tag of the cx-detail fragment:

<oj-dynamic-container layout="PanelsContainerLayout" layout-

provider="[[ $metadata.dynamicContainerMetadata.provider ]]"
class="oj-flex-item oj-sm-12 oj-md-1"></oj-dynamic-container>

<oj-dynamic-container layout="SubviewContainerLayout" layout-

provider="[[ $metadata.dynamicContainerMetadata.provider ]]">
</oj-dynamic-container>

7. Highlight the <oj-dynamic-container> tags for the panels.

<oj-dynamic-cortainer layout="PanelsContainerLayout™ layout-provider="[[ $metadata.dynamicConta
class="oj-flex-item 0j-sm-12 oj-md-1"></0]-dynamic-container>
8. On the Properties pane, in the Case 1region, click the Add Section icon, and then click New Section.
- ] — -
Dynamic Container = 3
=
o
General Sections(2) Events All ;—D*-
v
ID
Container Template Create
| A
Display Logic
+ Case |
Case 1 ® :
Condition @ fx -
Always Show
Sections l -+ I
PaymentLinesCollection_c Add Section

9. In the Title field, enter a title for the section, such as Leads Panel.
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10.

n.

12

13.

14.
15.

16.

In the ID field, keep the value of 1eadspanel.

Note: Don't use the REST object name for this ID because you'll use the REST object name when you create
the subview.

Click OK.
On the Properties pane, click the Leads Panel section that you just added.

Page Designer navigates you to the template editor, still on the payment_c-detail tab, where you can design the
Leads panel template.
Click the Code button.

Live Design Code

On the Components palette, in the Filter field, enter cx-panel.
Drag and drop the cx-panel fragment to the template editor, between the leadsPanel template tags.

G-.p.-,‘m--r_. letail x

Page Designer Actions (3 Ewvent Listeners Events Typees Variables (4

L[]

Q. ex-panel x

~  Fragments ®

|r‘ cx-panel I

name

Components

Data

Add the following parameters to the fragment code so that the code looks like the below sample. Be sure to
replace 1eads and payment_Id_PaymentLeadiM With the appropriate values for your related object name and
foreign key field.

Note: The format of the foreign key field's name is always <source object name> Id <Relationship name>. YOU
can also retrieve the field name by doing a REST describe of the target object (Ieads).

<template id="leadsPanel'">
<oj-vb-fragment bridge="[[vbBridge]]" class="oj-sp-foldout-layout-panel"
name="oracle_ cx_ fragmentsUI:cx-panel">

<oj-vb-fragment-param name="resource" value='[[ {"name": "leads", "primaryKey": "Id", "endpoint":
llcxll } ]] l>
</oj-vb-fragment-param>
<oj-vb-fragment-param name="sortCriteria" value='[[ [{"attribute": "LastUpdateDate",6 '"direction":

"desc" }] 11'>

</oj-vb-fragment-param>

<oj-vb-fragment-param name="query"

value='[[ [{"type": "gbe", "params": [{"key": "Payment Id PaymentLeadlM", "value":

$variables.id }1}]1 11'>

</oj-vb-fragment-param>

<oj-vb-fragment-param name="context" value="[[ {} ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="extensionId" value="{{ $application.constants.extensionld }}"></0oj-vb-
fragment-param>

</oj-vb-fragment>
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17.
18.
19.

</template>
This table describes some of the parameters that you can provide for a custom panel.

Parameters for Custom Panel

Parameter Name Description

sortCriteria Specify how to sort the data on the panel, such as sort by last updated date and descending
order.

query Include criteria for querying the data on the panel.

Click < Return to page.
Click the Code button.
You're ready to add the subview next.

Tip: Once you add the panel to the panel region, that's all that's required. The standard object panel comes
configured with a set of attributes to display by default. If you want to configure the panel, however, then you can do
so. See Configure the Contents of a Panel.

You can test the panel after you add the subview. Let's do that next.

Add a Subview for the Leads Panel

After adding a related object panel to your custom object's detail page, add the subview next.

1.

o

On the payment_c-detail page, highlight the <oj-dynamic-container>tags for the subviews.

<div class="oj-flex"»
<oj-dynamic-container layout="SubviewContainerLayout" layout-provider="[[ $metadata.dynamicCo

class="o0j-flex-item 0j-sm-12 o nl-12" ><,-'(1j-d'-,'n.a|nit containers>

<fdive

On the Properties pane, in the Case 1region, click the Add Section icon, and then click New Section.
In the Title field, enter a title for the section, such as Leads.
In the ID field, keep the value of 1eads.

Note: Use the REST API object name for this ID.

Click OK.
On the Properties pane, click the Leads section that you just added.

Page Designer navigates you to the template editor, still on the payment_c-detail tab, where you can design the
leads template.
Click the Code button.

Live Design Code

On the Components palette, in the Filter field, enter cx-subview.
Drag and drop the cx-subview fragment to the template editor, between the leads template tags.
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[, payment_c-detail x

Page Designer Actions (3 Event Listeners Events Types Variables (4 JavaScript

Z I A cx-subyiew x = < Return to page

5 . 142

& ~ ) R ;
E e ® 143 <template-id="leads">
]

~ ™ cx-subview 144 </template>

145

146

Data

10. Add the following parameters to the fragment code so that the code looks like the below sample. Be sure to
replace 1eads and payment Id PaymentLeadiM With the appropriate values for your object and foreign key field.

Note: The format of the foreign key field's name is always <source object name> Id <Relationship name>. YOU
can also retrieve the field name by doing a REST describe of the target object (Ieads).

<template id="leads">
<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx fragmentsUI:cx-subview">

<oj-vb-fragment-param name="resource" value='[[ {"name": "leads", "primaryKey": "Id", "endpoint":
llcxll } ]] l>

</oj-vb-fragment-param>

<oj-vb-fragment-param name="sortCriteria" value='[[ [{"attribute": "LastUpdateDate",6 '"direction":

"desc" }] 11'>

</oj-vb-fragment-param>

<oj-vb-fragment-param name="query"

value='[[ [{"type": "gbe", "params": [{"key": "Payment Id PaymentLeadlM", "value":
$variables.id }1}]1 11'>

</oj-vb-fragment-param>

<oj-vb-fragment-param name="context" value="[[ {} ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="extensionIld" value="{{ $application.constants.extensionld }}"></o0j-vb-
fragment-param>

</oj-vb-fragment>
</template>

This table describes some of the parameters that you can provide for the subview:

Parameters for Subview
Parameter Name Description
sortCriteria Specify how to sort the data on the subview, such as sort by last updated date and descending
order.
query Include criteria for querying the data on the subview.
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11. Comment out the dynamic container components from the payment_c-detail page.

a. Click < Return to page.
b. Click the Code button.

c. Comment out the dynamic container components that contain the panels and subviews.

16 ¢f0]-vb-fragment>
=

oj-vb-fragment bridges"[[w

fr it ‘am names="resources

|7 names="oracle

18 <o]-dynamic-container layout="PanelsContainerLayout" layo
19 class="0j-flex-item oj-sm-12

28 ic-container layout="Suln,

21 amic-containers

22

23

tsUl:cx-¢ 111" classe™o-flex-1te
¢ $variables.id, 'endpoint’: $applic
ionI fapplication n i
A £ low ant by !

adata W” L hpag riables
$flow.variables.context} ]]"»<)
ider="[[ $metadata.dynamicConta
wrovider="[[ $metadata.dynamicCont

components.

Note: To add more panels and subviews, you must first un-comment the dynamic container

Tip: Once you add the subview, that's all that's required. The subview for a standard object comes configured with
a set of attributes to display by default. If you want to configure the subview, however, then you can do so. See

Configure the Subview Layout.

Test Your Panel and Subview

Test the subview by previewing your application extension from the payment_c-list page.

1. From the payment_c-list page, click the Preview button to see your changes in your runtime test environment.

P © Q

2. The resulting preview link will be:

‘ Publish |

https://<servername>/fscmUI/redwood/cx-custom/payment_ c/payment c-list
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3. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/payment_c/payment c-list

| Note: You must add /application/container to the preview link.

The screenshot below illustrates what the list page looks like with data.

All Payments actins >

S Try seadching by ke add a filver Al Filer

— T TEEFA T I S
&3 Resulis
Paymient Name 5 Creation Date = Last Updated Date S Actions

O Payment, Oct invoice 10419722 10003 P 11AT/254:2% AM
O  Payment tor Order 1020 1171722 206 AM 11/17/23 4:42 AM
O  Payment 11/2 for Octaber 15 crder 1173422 737 PM 12719722 5:23 PM
O  mew7_Rect 1/7722 616 P 117722 8216 PM
O Mot 1177722 6:45 PM 1177722 645 PM

4. If data exists, you can click any record on the list page to drill down to the detail page. The detail page, including

header region and panels, should display.

You should now see a Sales Leads panel.

¥ Al epis
Payment for Laplaps @ [FE
= L
e e e e
Payment Lines Attnchenents Sales Leads
e SR Rl o s

B: sy . .
u 8 -

=] &

= &

ORACLE

61



Oracle Fusion Cloud Sales Automation

How do | create an application extension for custom objects
in Oracle Visual Builder Studio?

Chapter 2
Add a Custom Top Level Object

5. Inthe Action Bar, select the Create Lead action.

1 All Payments

Payment for Laptops ©

Payment Date 5/31/23 Amount 1,000 Discount 5%

‘ > dreate Contact X

W Create Contact

Create Lead

Create Payment Line

Create Shipment

The Create Lead page displays. Here's an example of a general Create Lead page:

Brew  ODohorls  ODumos L =TT E T e

P

After creating a lead, you should be navigated to the lead's detail page. Click the browser back button to return
to the Payment detail page where the new lead displays in the Sales Leads panel.
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Contacts from Bundle

Lines. Fhipmant

Papment

n H " - e

o Q=

el il
Yo
o """“

— ——

Adtachments
&

6. On the Sales Leads panel, click the link for the lead you just created to navigate to the lead's detail page.

Click the browser back button.

7. Click the View All link to drill down to the subview.

PO

Pavisent for Lapiops @ Sales Leads

i

—— A =

8. On the Sales Leads subview, click a lead to navigate to the lead's detail page.

Click the browser back button.
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9. Save your work by using the Push Git command.

Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the
Git repository).

< Workspace2 > extend-next-gen-sales.git/20220830 ;
ol Git @ D detail
A Q Filter Switch Branch
» Changed (1) Commit. Commit
Pull
Merge

Reset to HEAD

Ke

|°¢»|D@D‘b®

Add a Custom Object Panel for Related Objects (One-to-
Many)

You can enhance an object's detail page by adding panels for related objects. This makes it easy for users to see—on a
single page - all pertinent information related to a record. You can add custom object panels or standard object panels.
This topic illustrates how to add a custom object panel to an object's detail page (when the panel object is related via a
one-to-many relationship).

What's the Scenario?

In our example relationship, the Payment object has a one-to-many relationship with the Shipment object. At runtime,
users should be able to create shipments for a payment, and view those shipments on the Payment detail page. To
enable this, we need to add a Shipments panel to the Payment detail page.
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Setup Overview

To add a related object panel to a custom object's detail page, you must complete a few steps first. Here's an overview of
the required steps.

1. Complete these steps for your related object:

a. Make sure that the CX Extension Generator generated the pages and layout for the related object, in this
case, for the Shipment object.

See Create a New Application Using the CX Extension Generator.
b. Create the required create smart action for the related object in Application Composer.

For example, create a Create Shipment smart action.

The Create Shipment smart action displays from the Action Bar on both the Payment detail page and
Shipments subview. Users can select the Create Shipment smart action to navigate to a create shipment

page.
2. You can then add a new related object panel to the custom object's detail page.

See Add the Shipment Panel to the Payment Detail Page.
3. After adding the panel, you can then create and configure the subview.

See Configure the Subview for Related Objects (One-to-Many).

Add the Shipment Panel to the Payment Detail Page

To add a new panel for shipments to the Payment detail page:

In Visual Builder Studio, click the App Uls tab.

Expand cx-custom > payment_c, then click the payment_c-detail node.
On the payment_c-detail tab, click the Page Designer subtab.

Click the Code button.

P WNa

| Live Design Code

5. Confirm that you are viewing the page in Page Designer.

‘ Page ~ |
v Page
Templates
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6.

o

10.

1"
12.

13.

14.
15.

Remove the comment tags for the dynamic container components that contains the panels and any subviews.

t bridges"[[vbBridge]]™ name="oracle cx_fragmentsUl:cx-detail™ class="oj-flex-ite

3 <oj-vk ment - param names urces”

4 value="[[ {'Payment_c"' : {"puid’: $variables.puid, 'id": $variables.id, 'endpoint’: Sapplic
5 <foj-vb-fragment -params>

B <oj-vbh-fragment -param name="header"

7 value="[[ {'resource’: $flow.constants.objectName, "extensionId®: Sapplication.constants.ex
8 <foj-vb-fragment - param>

9 <oj-vb-fragment -param name="actionBar”

18 value="[[ { "applicationId™: "ORACLE-ISS-APP", "resource”: {"name”: $flow.constants.objectn
11 </oj-vb-fragment -param>

12 <oj-vb-fragment - param names="panels”

13 value="[[ { "panelsMetadata™: $metadata.dynamicContainerMetadata, “view™: $page.variables.v
14 <foj-vb-fragment - param»

15 <oj fragment-param name="context” value="[[ { flowContext': $flow.variables.context} ]]"»¢
16 ¢f0]-vb-fragment>

17

18 ¢o]-dynamic-container layout="PanelsContainerLayout" layout-provider="[[ $metadata.dynamicConta
19 class="oj-flex-item oj-sm-12 oj-md-1"></07-dynamic-containers

20 <oj-dynamic-container layout="SubviewContainerLayout™ layout-provider="[[ $metadata.dynamicConty
21 dynamic-containers

22

23

ngh]]ght the <oj-dynamic-container> tags for the panels.

mj-dynamic-co*ainer‘ layout="PanelsContainerLayout™ layout-provider="[[ $metadata.dynamicConta
class="oj-flex-item o0j-sm-12 oj-md-1"></0]-dynamic-container>

On the Properties pane, in the Case 1 region, click the Add Section icon, and then click New Section.
In the Title field, enter a title for the section, such as shipments.
In the ID field, change the value to shipmentsPanel.

Note: Don't use the REST object name for this ID because you'll use the REST object name when you create
the subview.

Click OK.
On the Properties pane, click the Shipments section that you just added.
Page Designer navigates you to the template editor, still on the payment_c-detail tab, where you can design the

Shipments panel template.
Click the Code button.

Live Design Code

On the Components palette, in the Filter field, enter cx-panel.
Drag and drop the cx-panel fragment to the template editor, between the shipments template tags.

[Epawnent_c-clelail x

Page Designer Actions (1 Event Listeners (1 Events Types Variables (2 JavaScript
g Q cx-panel x = < Return to page

@

=]

5 a9

o ~ Fragments S P "
E - ® 50 <template id="shipments”>
(W] i = h’

52 <ftemplate>
53

Data
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16. Add the following parameters to the fragment code so that the code looks like the below sample. Be sure to
replace shipment c and rayment Id PaymentShipment1M With the appropriate values for your related object name
and foreign key field, and retain the proper capitalization of the custom object name.

Note: The format of the foreign key field's name is always <source object name> Id <Relationship name>. YOU
can also retrieve the field name by doing a REST describe of the target object (Shipment).

<template id="shipments">
<oj-vb-fragment bridge="[[vbBridge]]" class="oj-sp-foldout-layout-panel"
name="oracle cx_fragmentsUI:cx-panel">
<oj-vb-fragment-param name="resource" value='[[ {"name": "Shipment c", "primaryKey": "Id", "endpoint":
$application.constants.serviceConnection } ]1]'>
</oj-vb-fragment-param>
<oj-vb-fragment-param name="sortCriteria" value='[[ [{"attribute": "LastUpdateDate",6 "direction":
"desc" }] 11'>
</oj-vb-fragment-param>
<oj-vb-fragment-param name="query"
value='[[ [{"type": "gbe", "params": [{"key": "Payment_ Id PaymentShipmentlM", "value":
$variables.id }]1}] 11'>
</oj-vb-fragment-param>
<oj-vb-fragment-param name="context" value="[[ {} ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="extensionId" value="{{ $application.constants.extensionId }}"></oj-vb-
fragment-param>
</oj-vb-fragment>
</template>

This table describes some of the parameters that you can provide for a custom panel.

Parameters for Custom Panel

Parameter Name Description

sortCriteria Specify how to sort the data on the panel, such as sort by last updated date and descending
order.

query Include criteria for querying the data on the panel.

17. In the previous step, you configured the panel template. Next, let's configure the layout for the panel.
18. Click the Layouts tab, then click the Shipment_c node.

-} Layouts -+

E |O\ Filter

1C » 4& Payment_c

= ~ | 4@ Shinment.c
%Note

&
19. On the Shipment_c tab, click the Panel Card Layout rule set.
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20. Add the fields that you want to display on the panel.

a.
b.

Click the Open icon next to the default layout.
Each panel includes specific slots. From the list of fields, drag each field to the desired slot.

For example, drag and drop the RecordName field to the item1 slot. If an Id field is present in that slot, you

can remove it.

I:&, payment_c-detail x
Rule Sets (4) Fields

[ A LastUpdateDate

O A LastUpdatedBy

O A LastUpdateLogin
O[] Note

[ A OraZcxOwner_c

O A OraZexOwner_ld_c
[ A payment_ld_Paymen
O A Phone_c

A\ RecordName

O A RecordNumber
% ShipmentDate_c

|:| [] smartActions

D A\ UserLastUpdateDate

Templates (4

%sm‘ ment_c X

Actions

ipment1M

Event Listeners Events

A item1

Types

A RecordName

A item2

‘ ShipmentDate_c

A item3

A itemd

A item5 item5 only works with style

Drag and drop other desired fields to the appropriate slots. For example, drag the ShipmentDate_c field
to the item2 slot, and the Email_c field to the item3 slot.
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Comment out the dynamic container components from the payment_c-detail page.

21.
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a. Click the payment_c-detail tab, then click the Page Designer subtab.
b. Click < Return to page.
c. Click the Code button.
d. Select Page from the dropdown.
[ payment _c-detail x 4% PaymentLineCollection ¢ x
Page Designer Actions Event Listeners Events Types Variab
g2 | Q Fiter, AlF | =
c .
5 fragme
o ~ Redwood Patterns
5 v Page view-c
o Advanced Create and Edit Page _vb-fr
Template Templates
-vb-fr
I Bottom Drawer Template 5 <0j-vb-fr
1%}
=] = ) 3
[E Create Edit Drawer Template 6 <0j-vb-fr
] 7 <0j-vb-fr
Dashboard Landing Page Template 2 </ oi-vb-fraem

e. Comment out the dynamic container components that contain the panels and subviews.

e gracle ox fragmentsul:cx-detail™

g5, id,

“[[ #metadata.dynamicConta

class="oj-flex-ite
"endpoint’: fapplic
fapplication.constants.ex

: $flow.constants.objectn

“wiew™: fpage.variables.v

variables.context} ]]7»<)

"[[ $metadata.dynamicConty

You can test the panel after you add the subview. Let's do that next.

Note: To add more panels to the panel region, you must first un-comment the dynamic container

2 <oj-vb-fragment bridges"[[vbBridge]]” na

3 ent -param name="res

4 ‘Payment ¢ {“puid’: iables.puid, "id": $variable
5 ment -params

0 param name="header”

7 tants.objectName, 'extensionId’:
9 param name="act

18 “applicationId™: "Oi SS-APP", "resource”: {“name™
11 / t-param>

12 L0 s m names"panels”

13 letadata™: fmetadata.dynamicContainerMetadata,
14

15 nt-param name="context"” wvalue="[[ { flowContext': &flow.
16
17

18 <o) -dynamic-container layout="PanelsContainerLayout” layout-pre Iy
19 class="0j-flex-it 1"»¢ /0] -dynamic - containe
20 <oj-dynamic-container layout="SubviewContainerLayout™ layout-provider
21 <foj-dynamic -containers
»
23

component so that you can add a new section for each desired panel.

Configure the Subview for Related Objects (One-to-Many)

After adding a related object panel to your custom object's detail page, you can now create and configure the subview.
This topic illustrates how to create the subview for a related object (related via a one-to-many relationship).
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What's the Scenario?

In our example relationship, the Payment object has a one-to-many relationship with the Shipment object. At runtime,
users should be able to create and view shipments for a payment on the Payment detail page, and then drill down to a

Shipments subview.

We've already added a Shipments panel to the Payment detail page. Let's create the Shipments subview next.

Create the Shipments Subview

Create a new template for the subview that displays the shipments created for a payment.

In Visual Builder Studio, click the App Uls tab.

On the payment_c-detail tab, click the Page Designer subtab.
Click the Code button.

Live Design Code

5. Confirm that you're viewing the page in Page Designer.

v Page

A WNA

Templates

Expand cx-custom > payment_c, then click the payment_c-detail node.
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6. Remove the comment tags for the dynamic container components that contains the panels and any subviews.

class="oj-flex-ite

"endpoint’: fapplic

2 ¢oj-vb-fragment bridges"[[vb&r “ name="oracle cx fragmentsul:cx-detail”™

3 <aj-vh-fr ent -param name wrces”

3 value="[[ {'Payment_c’ *: Svariables.puid, "id": $variables.id

5 <foj-vb-fragment -param>

[ <0j-vb-fragment-param name="header’

7 value="[[ {'resource’: $flow.constants.objectName, "extensionId®: $application.constants.ex
</oj-vb-fragment - param>

1 <0j-vb-fragment -param name="acti 3|
18 alue= { "applicationId™: "ORACLE-ISS-APP", "rescurce”: {"name™: $flow.constants.objectn
11 <foj-vb-f ent -params
12 <aj-vh-fr nt-param name="panels”
1 value="[[ { "panelsMetadata™: $metadata.dynamicContainerMetadata, “view™: $page.variables.v
14 i fragment - param»
15 fr. nt-param name="context” value="[[ {'flowContext’: $flow.variables.context} ]]"»</
16 ¢f0]-vb-fragment>
v ()
18 <o) -dynamic-container layout="PanelsContainerLayout” layout-providers"[[ $metadata.dynamicConta
19 class="oj-flex-item oj-sm-12 oj-md-1"></07-dynamic-containers
20 <oj-dynamic-container layout="SubviewContainerLayout™ layout-provider="[[ $metadata.dynamicConty
21 < /o] -dynamic -containers
2
23

7. Highlight the <oj-dynamic-container> tags for the subviews.

<div class="oj-flex"»
<oj-dynamic-container layout="SubviewContainerLayout" layout-provider="[[
class="oj-flex-item oj-sm-12 oj-md-12"»</0j-dynamic-container>
<fdive

$metadata.dynamicCo
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8. On the Properties pane, in the Case 1region, click the Add Section icon, and then click New Section.
9. Inthe Title field, enter a title for the section, such as shipment c.
10. Inthe ID field, change the value to shipment_c.

| Note: Use the REST API object name for this ID.

11. Click OK.
12. Manually update the template's JSON with the correct subview name.

a. On the payment_c-detail tab, click the JSON subtab.

b. In the section for the SubviewContainerLayout's section template layout, replace the sectionTemplateMap

and displayProperties values to match the subview's ID name, shipment_c. This is the object's REST API
name.

In our example, this is what the SubviewContainerLayout's sectionTemplateMap and displayProperties
should look like:

"SubviewContainerLayout”: {
"label”: "Container Rule Set 1",

"layoutType": "container”,
"layouts": {
"casel": {

"label™: "Case 1",

"layoutType"”: “"container”,

"layout": {
"sectionTemplateMap”: {

ntlinecollection c": "paymentLineCollectioncC”,

"shipmentc”

"displayProperties”: [
"pPaymentlinecollection ¢”,

“Shipment_c"
]
}
}
b
"rules”: [
"containerLayout2-rule1”

]
by

Configure the Subview Layout

Next, let's build the structure of the subview using the cx-subview fragment.

1. On the payment_c-detail tab, click the Page Designer subtab.

7
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2. On the Properties pane, click the Shipment_c section that you just added.

Display Logic
+ Case

Case 1 ©® & :
Condition

Always Show

Sections -+

PaymentLineCollection_c

Shipment_c

Page Designer navigates you to the template editor, still on the payment_c-detail tab, where you can design the
Shipment_c template.
3. Click the Code button.

Live Design Code

4. Onthe Components palette, in the Filter field, enter cx-subview.
5. Drag and drop the cx-subview fragment to the template editor, between the shipmentC template tags.

Ebpdwnentndemn x

Page Designer Actions Event Listeners Events Types Variables (3 JavasScript
& Q ex-subview x = ¢ Return to page

g

] 66

2 v Fragments ® T .
E 67 <template id="shipmentC™>
= I-"'l cx—sut}\fiE'-'ai ===

69 </template>
78

Data

6. Add the following parameters to the fragment code so that the code looks like the below sample. Be sure to
replace shipment_c and Payment_Id_PaymentShipmentlM With the appropriate values for your object and foreign

key field.

Note: The format of the foreign key field's name is always <source object name> Id <Relationship name>. YOU
can also retrieve the field name by doing a REST describe of the target object (Shipment).

<template id="shipmentC">
<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx fragmentsUI:cx-subview">
<oj-vb-fragment-param name="resource" value='[[ {"name": "Shipment c", "primaryKey": "Id",
$application.constants.serviceConnection } ]1]'>
</oj-vb-fragment-param>
<oj-vb-fragment-param name="sortCriteria" value='[[ [{"attribute": "LastUpdateDate",6 "direction":
"desc" }] 11'>
</oj-vb-fragment-param>

"endpoint":
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<oj-vb-fragment-param name="query"

value='[[ [{"type": "gbe", "params": [{"key": "Payment_ Id PaymentShipmentlM", "value":
$variables.id }]1}] 11'>

</oj-vb-fragment-param>

<oj-vb-fragment-param name="context" value="[[ {} ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="extensionId" value="{{ $application.constants.extensionlId }}"></oj-vb-
fragment-param>

</oj-vb-fragment>

This table describes some of the parameters that you can provide for the subview:

Parameters for Subview
Parameter Name Description
sortCriteria Specify how to sort the data on the subview, such as sort by last updated date and descending
order.
query Include criteria for querying the data on the subview.

Next, let's configure the subview layout.

1. Click the Layouts tab, then click Shipment_c > Rule Sets subtab.
2. C(lick the Sub View Layout rule set.
3. Add the fields that you want to display in the layout.

a. Click the Open icon next to the default layout.

b. From the list of fields, select the fields that you want to display on the subview table. The fields display as
columns in the order that you click them, but you can rearrange them.
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4. Create an event that updates the URL when a user navigates to a subview. This enables users to be

automatically navigated back to the subview after editing a record.

this step.

a. On the payment_c-detail tab, click the Page Designer subtab.
b. Confirm that you're viewing the page in Page Designer.

v Page

Templates

c. Click the Code button.

| Live Design Code

d. Inthe code for the detail page, click the oj-vb-fragment tag.

Page = Live | Design | Code

1 of-vb-fragment Jbridge="[ [ vber

<foj-vb-fragment >

roy ider || tmetadata.

‘Layout™ layout-provider="[[ fmetadata.dy I

e. On the Properties pane for the cx-detail fragment, click the Events subtab.

i. Click + New Event > On 'viewChangeEvent'.
ii. Dragan Assign Variables action onto the canvas.

iii. On the Properties pane, in the Variable field, click view under the Page heading.

ORACLE
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Note: If you already created this event when configuring a subview for a different object, then you can skip
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Variable *

Create

view{

-

Page
A id
AL puid

.‘i\u view

Flow

{} context

Extension

A $extension.path

iv. Inthe Value field, enter {{ payload.view }}.

ORACLE
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5. Comment out the dynamic container components from the payment_c-detail page.

a. Click the payment_c-detail tab, then click the Page Designer subtab.

b. Click the Code button.
c. Select Page from the dropdown.

[EJ payment_c-detail X 4@ PaymentLineCollection_c X
Page Designer  Actions Event Listeners Events Types Variab
[l 1 fa =
s [Qemmr ] =
Y
5 fragme
(=4 ~ Redwood Patterns
£ v Page view-c
o Advanced Create and Edit Page _vb-fr
Template Templates
-vb-fr
g Bottom Drawer Template 5 <oj-vb-fr
Q _ . =
[ Create Edit Drawer Template 6 <0j-vb-fr
) 7 <o0j-vb-fr
Dashboard Landing Page Template 2 </oi-vb-fraem

d. Comment out the dynamic container components that contain the panels and subviews.

2 to)-vb-fra
3 <0j-vh-f ent - param names"
value="[[ {'Payment_c" :
<foj-vb-fragment -params>

ent bridges"[[vbEr

urces”

dge]]” name="oracle ¢x fragmentsUl:cx-detail™ classs"oj-flex-ite

{"puid’: $variables.puid, "id": $variables.id, 'endpoint’: $applic

5
B <oj-vbh-fragment -param name="header"

7 value="[[ {'resource’: $flow.constants.objectName, "extensionId®: Sapplication.constants.ex
8 <foj-vb-fragment - param>

9 <oj-vb-fragment -param name="actionBar”

18 value="[[ { "applicationId™: "ORACLE-ISS-APP", "resource”: {"name”: $flow.constants.objectn
11 </oj-vb-fragment -param>

12 <oj-vb-fragment - param names="panels”

13 value="[[ { "panelsMetadata™: $metadata.dynamicContainerMetadata, “view™: $page.variables.v
14 <foj-vb-fragment - param»

15 <0j-vb-fragment -param name="context"” wvalue="[[ { flowContext': $flow.variables.context} ]]"»<
16 ¢f0]-vb-fragment>

17

18 ¢o]-dynamic-container layout="PanelsContainerLayout" layout-provider="[[ $metadata.dynamicConta
19 class="oj-flex-item oj-sm-12 oj-md-1"></07-dynamic-containers

20 <oj-dynamic-container layout="SubviewContainerLayout™ layout-provider="[[ $metadata.dynamicConty
21 < /o] -dynamic -containers

2

23

Add a Link to the Panel and Subview

On both the panel and subview, users should be able to click the shipment name to navigate to the Shipment detail
page. To enable the shipment name as a hyperlink, you must do the following:

1. Add the RecordName field to the Shipment panel and subview layouts.

2. Create a hyperlink field template.

3. For each layout, associate the RecordName field with the hyperlink field template.

First, create the hyperlink field template.

1. Click the Layouts tab, then click the Shipment_c node.

ORACLE
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2

10.

N I A o

On the Shipment_c tab, click the Templates subtab.
Click + Template.

In the Create Template dialog, for Type, select Field.
In the Label field, enter hyperlinkTemplate.

Click Create.

In the template editor, click the Design button.

On the Components palette, in the Filter field, enter ex-hyperlink.

Chapter 2
Add a Custom Top Level Object

Drag and drop the cx-hyperlink fragment to the Structure pane, under the Input Text node.

%Shi ment_c X

Rule Sets (4) Fields Templates (4) Actions E
{ Templates hyperlink -

Z ‘ Q cx-hyperlink X =

] : -

5

% ~ Fragments @
5

J

™

T (oxchypertink |

You can ako try searching for "cx-hyperlink”™ at
Componefyt Exchange...

Search Exchange

‘ Q Fi]:er\

* ™ Fragment Container

Fragment Input Parameter {dynamicLayo

Delete the Input Text node.

Next, associate the hyperlink field template that you just created with the RecordName field that you already added to
the panel and subview layouts.

A WN

Click the Layouts tab, then click the Shipment_c node.
On the Shipment_c tab, click the Rule Sets subtab.
Click the Panel Card Layout rule set.

On the Properties pane, click the Templates subtab.
Click + Default Field Template.

ORACLE
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6. Select the RecordName field and then select the hyperlinkTemplate template. Click Confirm.

Field ~

RecordName hd
Template ~

hyperlinkTemplate hd

[ Apply to all current usages of the field in this rule
set that map to a template

=
-|— Default Field Template

7. At the top of the page, click < Rule Sets to return to the list of rule sets.

%Slﬂ ment_c %

Rule Sets (4) Fields Templates (4) Actions

£ Rule Sets PanelCardLayout -

8. C(lick the Sub View Layout rule set.
9. Click the Open icon next to the default layout.
10. Click the RecordName field to select it.

11.  On the Properties pane, in the Template field, select the hyperlinkTemplate template.

o

Rbe e

[y —

P Select Plds to dsplay ¢ Table

Tirkh

O A Camercyone [

OAu

O A Lnrispeisseliaze
O A s
O A Lt ogn
[=1e L]

O A cvszcwmns,c

Y [ Stuprrervelione BeciedHame

0 A ovaostnes. g I -

12. Modify the hyperlink template's JSON entry for the panel card layout.

On the Shipment_c tab, click the JSON subtab.
The following code displays in the PanelCardLayout section:

4
"fieldTemplateMap": {
"RecordName": "/hyperlinkTemplate"
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}

13. Remove the "/" so that the code looks like this:

’

"fieldTemplateMap":
"RecordName" :

}

"hyperlinkTemplate"

Test Your Panel and Subview

Test the subview by previewing your application extension from the payment_c-list page.

Chapter 2
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1. From the payment_c-list page, click the Preview button to see your changes in your runtime test environment.

2. The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-custom/payment_c/payment c-list
3. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/payment_c/payment c-list

I Note: You must add /application/container to the preview link.

The screenshot below illustrates what the list page looks like with data.

All Payments

S | Try searching

Actias ™

Al Filer

—
&3 Resulis

O O O g o

Paymient Name 5

T TS T ST

Creation Date = Last Updated Date S Actions
10419722 10003 P 11T/ 23 4:25 AM

1171722 206 AM 11/17/23 4:42 AM

1173422 737 PM 12719722 5:23 PM

/7722 616 P 1177722 816 PM

1177722 6:45 PM 1177722 645 PM
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4. If data exists, you can click any record on the list page to drill down to the detail page. The detail page, including
header region and panels, should display.

You should now see a Shipments panel.
= {supremo oo B

+ AN Payments

Payment for Laptops © [ payment Detais

nt 5000 Payment Date 3/28/23

Payment Lines Shipments

wells Payment Mar Shipment
3,000 5/4/2%
haresh.pahilajani@or -

aclecom
Acer Laptops
3,/29/23 %53 PM 5/3/2%

Thinkpad Laptops
5/2/23

View All Payment Lines (2) View All Shipments (11)

5. Inthe Action Bar, select the Create Shipment action.

4+ All Payments

Payment for Laptops @

Amount 5,000 Payment Date 3/28/23

> Try Create Shipment

Create Shipment

Add Contact

Create Payment Lines

—

The Create Shipment page displays. Here's an example of a general Create Shipment page:
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= ORACLE

Shipment Name

Mar| Shipment

Shipment Date
2/22/23

email
al@al.com

Account - My Accounts
Pinnacle Technologies

Create Shipment cii ﬂ

Chapter 2
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After creating a shipment, you should be navigated to the shipment detail page. Click the browser back button

to return to the Payment detail page.

6. On the Shipments panel, click the link for the shipment you just created to navigate to the Shipment detail

page.

Click the browser back button.
7. Click the View All link to drill down to the subview.
= supremo

Payment for Laptops @
5,000 Payment Date 3/28/23

A L L
= Goto Overview

Shipments
Shipment Mame < Shipment Date = Created By <
Mar Shipment 5/4/23 kristin.penaskovic@oracle.com
Acer Laptops ETETFE kristin.penaskovic@oracle.com
Thinkpad Laptops 5/2/23 kristin.penaskovic@oracle.com
Manual payment kristin.penaskovic@oracle.com

[5 payment Details

Creation Date &

5/3/23 6:06 PM

SAf23 WS4 PM

5/1/23 724 PM

SAF23T0PM
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81



Oracle Fusion Cloud Sales Automation Chapte

r2

How do | create an application extension for custom objects Add a Custom Top Level Object

in Oracle Visual Builder Studio?
8. On the Shipments subview, click the Mar Shipment link to navigate to the Shipment detail page.
Click the browser back button.
9. Save your work by using the Push Git command.

Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the
Git repository).

cen-sales.git /20220830 .

ol Git @ D detail
4. Q. Filter Switch Branch
&= » Changed (1) Commit. Commit

e Pull

.

ey Merge

| Reset to HEAD
(%) q

Display a Panel and Subview Based on a Field Value

You can display different sets of panels (and their corresponding subviews) based on the value of a field.

To do this, create a panel layout or subview layout, and then add a field value condition. If a record's field matches the
specified value, then the associated layout displays. If not, then a different layout displays.

This topic illustrates how an account's type, either Customer or Prospect, changes the panel and subview layout on an
account detail page.

Prerequisite

To create a layout condition that references a field value, you must first enable this feature so that panels and subviews

are loaded to the page only after evaluating the header.

In Visual Builder Studio, click the App Uls side tab.

Navigate CX Sales > cx-sales > accounts > accounts-detail.

On the accounts-detail page, click the Variables subtab.

In the Constants region, click the deferRelatedDataload constant.
On the Properties pane, in the Default Value field, select True.

VAR WNRD
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If you want to add a field value condition to panel and subview container layouts, then you must set this value
to true.

Create a New Panel Layout

Once you have enabled the feature, you can now add a field value condition to a panel layout. Let's add a condition to
the account detail page.

1. Navigate to Visual Builder Studio from an account record.
2. On the accounts-detail page, click the Page Designer subtab.
3. On the Structure panel, click the Panel Container Layout node.

D accounts-detail x %hccounls b
Page Designer Actions Event Listeners Eve
& 8 Q. Filter, Alt+F =
]
5
g E_ ~ Redwood Patterns
5 ™
s
B
1=}
[z a
-,
|
[
%o .
Q Fi =
* ™ cx-detail
* ™ cx-detail-impl
?‘ accounts - Header Layout
Iv E3 Panel Container Layout I
= Activity Feed Panel Template {ac
* ™ cx-feed
v M
g
= M
T
= M
@A
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4. On the Properties pane, next to Sales Admin Case, click the Duplicate icon.

Panel Container
Layout

General Sections (18)

>+ Sales Admin Case

Account Team Panel
Template

Application Comp...

From Dependencies (Read-only)

@|&

Condition @
cxcore.utils.userinfo.getRoles().includes(...
Sections

Duplicate Account Panel X Sales
Template

Opportunity Panel X Sales
Template

Linked Account Panel X Sales
Template

subscriptions Panel X Sales
Template

Invoices Panel Template | CXSales

CX Sales

salladoiy

5. Next to the Sales Admin Case (Copy) panel layout's condition, click the Expression Editor icon.

>4 Sales Admin Case
Condition @

(Copy) ® :

-

6. Inthe Expression Editor dialog, replace the existing expression with this new one, just for testing:

$base.page.variables.row.Type=='ZCA_CUSTOMER'

7. Click Save.
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8.

9.

10.

1"

Delete the Opportunity Panel Template.
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With the field condition specified above, this means that accounts of type Customer won't see the

Opportunities panel on the account detail page.

Panel Container

Layout Application Comp...

General Sections (16

<>+ Sales Admin Case (Copy) @ B :
Condition @ fx -

$base.pagevariables.row.Type=="2CA_C...

Sections =+
Duplicate
Account
Panel
Template
Opportunity
Panel Cxsales [, ~ ~[|TH
Template

Linked

Account

Panel

Template
subscriptions

Panel CX Sales
Template

Invoices

Panel CX Sales
Template

Account

Team

Panel

Template

CX Sales

CX Sales

CX Sales

sanuadolg

Let's test this change.

From the accounts-list page, click the Preview button to see your changes in your runtime test environment.

> (@) Q ‘ Publish |

The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-sales/accounts/accounts-list

Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-sales/application/container/accounts/accounts-list

| Note: You must add /application/container to the preview link.
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12. Onthe My Team's Accounts page, click any account.
o If the account is of type Customer, then you won't see the Opportunities panel.

T My Tean's Accounts

Pinnacle Technologies <

(=]
-— - ErA W W
Duplicate Accounts Linked Customers Subscriptions
Az vou add duplicate account As you add financial customer After the first subscription is
records, vou'll see them here. records, vou'll see them here, created, you can view the

summary information here.

o If the account is of type Prospect, then the Opportunities panel does display.

LT S—

Pinnacle Technologies <

— s e wra wr

Duplicate Accounts / Opportunities M Linked Customers Subscriptions
As you add duplicate account ki As you add financial castomer After the first subscription is
records, youTl see them here. § 2277748 recards. you'll see them here. ereated, you oa

Sody

32 -\i

Lllmlr Tech Solar -~

~

Create a New Subview Layout

Next, add the field condition to the subview layout, as well. It's important to add the field condition to the subview
layout. Otherwise, the Show Opportunities smart action is still available from the Action Bar even when the account is a
customer.
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My Tean's Accourds

Pinnacle Technologies <

o show opppriunities X
W [Show Opportuniies T . T |
Filter show app
Duplicate Accounts Linked Customers Subscriptions
As you add duplicate account As vou add financial customer After the first subscription is
records, vou'll see them here, records, you'll see them here, created, you can view the
summary information here.

cupAhuN

~

10.

n.

Navigate to Visual Builder Studio from any subview page, which you can navigate to from any panel on an
account record.

On the accounts-detail page, click the Page Designer subtab.

On the Structure panel, click the Subview Container Layout node.

On the Properties pane, next to Subview Container Layout, click the Duplicate icon.

Next to the Subview Container Layout (Copy) subview layout's condition, click the Expression Editor icon.
In the Expression Editor dialog, add this expression:

$base.page.variables.row.Type=='ZCA_CUSTOMER'

Click Save.
Delete the Opportunity Subview Template.

With the field condition specified above, this means that accounts of type Customer won't see the Show
Opportunities smart action on the account detail page.

Let's test this change.

From the accounts-list page, click the Preview button to see your changes in your runtime test environment.

The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-sales/accounts/accounts-list

Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-sales/application/container/accounts/accounts-list

Note: You must add /application/container to the preview link.
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12. Onthe My Team's Accounts page, click any account and make sure that the account is of type Customer. The
Opportunities panel shouldn't display.

T My Tean's Accounts

Mastin Hoope | T

Pinnacle Technologies <

Duplicate Accounts

Az vou add duplicate account
records, vou'll see them here.

- TEA W —

Linked Customers

As you add financial customer
records, vou'll see them here,

Subscriptions

After the first subscription is
created, you can view the
summary information here.

13. Test the field condition on the subview layout by checking to see if the Show Opportunities smart action is still
available from the Action Bar. It shouldn't be visible anymore if the account is a customer.

T My Tean's Accounts

Pinnacle Technologies ©

Martin Hoope

Type Customer

O show opp

Filter shew app

Duplicate Accounts

As you add duplicate account
records, vou'll see them here.

Linked Customers

As vou add financial customer
records, vou'll see them here.

Subscriptions

After the first subscription is
created, vou can view the
summary information here.

Configure the Subviews for Appointments and Tasks

Using Oracle Visual Builder Studio, you can make it possible for users to create and view appointments and tasks right

from a custom object's detail page.

What's the Scenario?

This example shows you how to create subtabs for appointments and tasks on a Payment custom object and how to
enable users to view and create tasks and appointments directly from each payment's Action Bar. The view and delete
actions are already provided for you, but you must create the Create smart actions for tasks and for appointments.

ORACLE

88



Oracle Fusion Cloud Sales Automation Chapter 2

How do | create an application extension for custom objects Add a Custom Top Level Object
in Oracle Visual Builder Studio?

T Pasent page

Payment for Laptops @

Owner EXTN EXTH_AM3  Last Update Date 1/4/24 8:24 AM  Last Updated By EXTH_AMS

| © create Appointment x

'1 Create Appaintment ] =

Create Activity

Create Contact
| Create Note
Create Order
| Create Task |

A3

Order for May
1424 8:13 AM
EXTH_AM3

Order for Apr
1/4,/24 8:09 AM
EXTH_AMS

When you're finished with the setup in this example, you'll end up with separate subtabs for tasks and appointments.

Here's a screenshot of a sample Tasks subtab. The subtab includes 3 separate views highlighted by callouts: All Tasks,
Open Tasks, and Overdue Tasks. For each task, there are 3 available actions: Mark Complete, Edit and Delete Task.

T Parwel page

Payment for Laptops < : Tasks

Do EXTHENTM_AMY  Last Upstate Diste L0720 00 MM Lawt Upisted By EXTH_AME

S M
NN W = “—

L e

G oo

Alffaks OpsnTasks  Chesrdes Tmic

Sulesd T B Biste = [

Prioriby T Babus T A Lz
Tarsh e Loy Prge=prt 528 EXTHIENTH_AMY gt vy Mot parted 1=
Tkl WS EXTH EXTN_AnS et ©pemplene Mok =
)
et Tirsy

The Appointments subtab includes 2 separate views highlighted by callouts in the following screenshot: All
Appointments and Upcoming Appointments. The available actions are: Edit and Delete Appointment.
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Prerequisites

In Application Composer, Create a 1:M relationship between your custom object and the Activity object. In this example,
we're adding the relationship for the Payment custom object.

Create Smart Actions for Appointments and Tasks

1. In a sandbox, open Application Composer.

2. C(Click Smart Actions.

3. Create separate Create smart actions for tasks and appointments.
a. Onthe Smart Actions list page, click Create.

The application displays a guided process with 7 steps to complete in order.

Note: For your entries to be saved when creating smart actions, you must click Submit (available in the
last step in the guided process) . You can always go back and make changes after submitting.

b. Inthe Kind of Action step, select Ul-based action.
c. Click Continue.
d. Inthe Basic Details step, enter the following on the Payment object.:

Field Name Entries for Tasks Entries for Appointments
Name Create Task Create Appointment
Object Payment Payment
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Field Name Entries for Tasks Entries for Appointments
Action ID You can accept the default. You can accept the default.

e. Click Continue.
f. In the Availability step, enter the following:

Field Name Entries for Tasks and Appointments

Application Sales

Ul Availability List page

Action ID You can accept the default.

Role Filter Optionally, specify the job roles that can use this smart action. No entry means that all job

roles can use this action.

g. Click Continue.
h. Inthe Action Type step, make the following entries:

Field Name Entries for Tasks Entries for Appointments
Type Create Create

Subtype Task Appointment

Target Object Activity Activity
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Field Name Entries for Tasks Entries for Appointments

Object Subtype Task Appointment

i. While in the Action Type step, in the Field Mapping section add two field mapping conditions.
j- Click Add (callout 1in the screenshot)

Field Mapping o Add
* * * i,
Mame O Type > Value £ Actions
Attribute e & &
Cancel Continue

k. Inthe Actions column, click Edit (the pencil icon highlighted by callout 2)
I. Make the following entries:

Field Name Entries for Tasks Entries for Appointments

Name Payment ID Activities (Payment_id_ Payment ID Activities (Payment_id_
Activities) Activities)

Type Attribute Attribute

Value Record ID (Id) Record ID (Id)

m. Click Done to save the row.
n. Click Add again and add the second condition. The entries are the same for tasks and appointments
except for the Value where you must type either TASK or APPOINTMENT.

Field Name Entries for Tasks Entries for Appointments
Name Activity (ActivityFunctionCode) Activity (ActivityFunctionCode)
Type User-entered User-entered
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Field Name Entries for Tasks Entries for Appointments

Value TASK APPOINTMENT

0. Click Done.

p. Click Continue twice to skip over the Ul-Based Action Details step. This step doesn't apply to Redwood
Sales.

g. Optionally enter a confirmation message in the Confirmation Message step. The confirmation message
appears briefly after the user creates the record.

r. Click Continue.

s. On the Review and Submit step, click Submit.

Create the Subviews

Create new templates for the subviews that display the appointments and tasks created for a payment. You will
configure the actual subviews in the next section.

PUN

10.
1.
12
13.

In Visual Builder Studio, click the App Uls tab.

Expand cx-custom > payment_c, then click the payment_c-detail node.
On the payment_c-detail tab, click the Page Designer subtab.

Click the Code button.

Confirm that you are viewing the page in Page Designer.
Remove the comment tags for the dynamic container components that contains the panels and any subviews.
Highlight the <oj-dynamic-container> tags for the subviews.

On the Properties pane, in the Case 1 region, click the Add Section icon, and then click New Section.
In the Title field, enter a title for the section, such as tasks.
In the ID field, accept the value tasks.
Click OK.
Repeat steps to create a second section: appointments.
Add the following code for activity translations below imports:
"translations": {

"activityBundle": {
"path": "faResourceBundle/nls/oracle.apps.crmCommon.activities.resource.activityManagement"

}
}l

Configure the Subview Layouts

Next, build the structure of the subviews using the cx-subview fragment.

1.
2.

On the payment_c-detail tab, click the Page Designer subtab.
On the Properties pane, click the tasks section that you just added.
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Display Logic
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Note Panel

tasks

appointments

Page Designer navigates you to the template editor, still on the payment_c-detail tab, where you can design the
tasks template.
3. Click the Code button.

4. Onthe Components palette, in the Filter field, enter cx-subview.
5. Drag and drop the cx-subview fragment to the template editor, between the tasks template tags.
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6. Add the following parameters to the fragment code so that the code looks like the below sample. For the query
parameter, be sure to replace the foreign key payment 1d PaymentToactivities With the appropriate value.

| Note: The format of the foreign key field's name is always <Source object name>_ld_<Relationship name>.
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<oj-vb-fragment-param name="resource"

value='[[ {"name": "activities", "primaryKey": "ActivityId","puid": "ActivityNumber", "endpoint":
"ex" , "alias" : "tasks"} ]]'></oj-vb-fragment-param>
<oj-vb-fragment-param name="sortCriteria" value='[[ [{"attribute": "LastUpdateDate", "direction":

"desc" }] 11'>

</oj-vb-fragment-param>

<oj-vb-fragment-param name="query" value='[[ [{"type": "gbe","provider": "adfRest", "params": [{"key":
"Payment Id PaymentToActivities", "value":$variables.id }]}] 1]'></oj-vb-fragment-param>
<oj-vb-fragment-param name="context" value="[[ {} 1]">

</oj-vb-fragment-param>

<oj-vb-fragment-param name="extensionId" value="oracle cx_salesUI"></oj-vb-fragment-param>
<oj-vb-fragment-param name="types" value='[[ $functions.getTaskSubviewTypesData ($page.variables.id,
$page.translations) ]]'></oj-vb-fragment-param>

<oj-vb-fragment-param name="title" value="Tasks"></oj-vb-fragment-param>

<oj-vb-fragment-param name="subviewLayoutId" value="[[ 'SubViewLayoutForTasks' ]]"></oj-vb-fragment-
param>

7. Return to step 2 and complete the same steps for the appointments section.

Add the following parameters to the fragment code so that the code looks like the below sample. For the query
parameter, be sure to replace the foreign key payment 1d PaymentToactivities With the appropriate value.

Note: The format of the foreign key field's name is always: <Source object name>_ld_<Relationship name>.

<oj-vb-fragment-param name="resource"

value='[[ {"name": "activities", "primaryKey": "ActivityId", "puid": "ActivityNumber", "endpoint":
"cx" , "alias" : "appointments"} ]]'></oj-vb-fragment-param>
<oj-vb-fragment-param name="sortCriteria" value='[[ [{"attribute": "LastUpdateDate",6 '"direction":

"desc" }] 11'>

</oj-vb-fragment-param>

<oj-vb-fragment-param name="query"

value='[[ [{"type": "gbe", "params": [{"key": "Payment Id PaymentToActivities", "value":
$variables.id }1}]1 11'>

</oj-vb-fragment-param>

<oj-vb-fragment-param name="context" wvalue="[[ {} 1]">

</oj-vb-fragment-param>

<oj-vb-fragment-param name="extensionId" value="oracle cx_salesUI"></oj-vb-fragment-param>
<oj-vb-fragment-param name="types"

value='[[ $functions.getAppointmentSubviewTypesData ($page.variables.id, $page.translations) ]]'></oj-
vb-fragment-param>

<oj-vb-fragment-param name="title" value="Appointments"></oj-vb-fragment-param>
<oj-vb-fragment-param name="subviewLayoutId" value="[[ 'SubViewlLayoutForAppointments' ]]"></oj-vb-
fragment-param>

This table describes some of the parameters that you can provide for the subview:

Parameter Name Description

sortCriteria Specify how to sort the data on the subview, such as sort by last updated date and descending
order.

query Include criteria for querying the data on the subview.

types Pass a JavaScript function, either getTaskSubviewTypesData or

getAppointmentSubviewTypesData. These functions enable the tabs on each subview, such
as All Tasks, Open Tasks, and Overdue Tasks, as well as All Appointments and Upcoming
Appointments.
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8. In the previous step, you added the types parameter to each subview fragment to pass a JavaScript function,
either getTaskSubviewTypesData or getAppointmentSubviewTypesData.

In this step, manually add the functions to the JavaScript:
a. Onthe payment_c-detail tab, click the JavaScript subtab.

b. Add the below functions. Be sure to replace the foreign key payment_Id PaymentToActivities With the
appropriate value.

define(['vx/oracle_cx salesUI/ui/self/applications/cx-sales/resources/utils/CrmCommonUtils’, 'vx/
oracle cx salesUI/ui/self/applications/cx-sales/resources/utils/FormatUtils'],
(CrmCommonUtils,FormatUtils) => {
'use strict';

class PageModule {
}

PageModule.prototype.getTaskSubviewTypesData = function (id, translation) {
const typesData = [];

typesData.push ({

"resource": "activities",
"query": [{

" type " . que " ,
"provider": "adfRest",
"params": [

{

"key": "Payment Id PaymentToActivities",
"value": id

}I

{

"key": "ActivityFunctionCode",

"value": "TASK"

}

1

.,

"isDefault": true,

"sortCriteria": [{
"attribute": "LastUpdateDate",
"direction": "descending"

1,
"title": "AllTasks",

"id": "AllTasks"
})

typesData.push ({

"resource": "activities",

"query": [{

" type " : llqbe " ,

"provider": "adfRest",

"params": [

{

"key": "Payment Id PaymentToActivities",

"value": id

},

{

"key": "ActivityFunctionCode",
"value": "TASK"

}I

{

"key": "StatusCode",
"operator": "$in",

"value": "NOT_ STARTED,IN PROGRESS,ON_HOLD"
}

1
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)]’

"isDefault": true,

"sortCriteria": [{
"attribute": "DueDate",
"direction": "ascending"

.,

"title": "OpenTasks",
"id": "OpenTasks"

|

typesData.push ({

"resource": "activities",
"query": [{

"type": "gbe",
"provider": "adfRest",
"params": [

{

"key": "Payment Id PaymentToActivities",
"value": id

}l

{

"key": "ActivityFunctionCode",

"value": "TASK"

}I

{

"key": "DueDate",

"operator": "$1lt",

"value": FormatUtils.getFormattedDate (new Date())
}l

{

"key": "StatusCode",

"operator": "$in",

"value": "NOT STARTED,IN PROGRESS,ON_ HOLD"
}

1

,

"isDefault": true,

"sortCriteria": [{
"attribute": "DueDate",
"direction": "descending"

.,
"title":"OverdueTasks",
"id": "OverdueTasks"

b

return { "style": "tab", "items": typesData };

}i
PageModule.prototype.getAppointmentSubviewTypesData =

const typesData = [];

typesData.push ({

"resource": "activities",
"query": [{

"type": "gbe",
"provider": "adfRest",
"params": [

{

"key": "Payment Id PaymentToActivities",
"value": id

}l

{

"key": "ActivityFunctionCode",

"value": "APPOINTMENT"

}

ORACLE
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1

1,

"isDefault": true,
"sortCriteria": [{
"attribute": "SortDate",
"direction": "ascending"
}]I

"title": "AllAppointments",
"id": "AllAppointments"

|

typesData.push ({

"resource": "activities",
"query": [{

" type " : llqbe " ,
"provider": "adfRest",
"params": [

{

"key": "Payment Id PaymentToActivities",
"value": id

}I

{

"key": "ActivityFunctionCode",
"value": "APPOINTMENT"

}I

{

"key": "ActivityEndDate",
"operator": "$ge",

"value": new Date().toISOString()
}

]

.,

"isDefault": true,
"sortCriteria": [{

"attribute": "ActivityStartDate",
"direction": "ascending"

}]I

"title": "UpcomingAppointments",
"id": "UpcomingAppointments"

})

return { "style": "tab", "items": typesData };

};

return PageModule;

})

9. Comment out the dynamic container components from the payment_c-detail page:
a. Click the payment_c-detail tab, then click the Page Designer subtab.
b. Click the Code button.
c. Add the subview label for tasks and appointments in the actionBar param:

<oj-vb-fragment-param name="actionBar"

value='[[ { "applicationId": "ORACLE-ISS-APP", "resource": {'"name": "Payment c", "primaryKey":
"Id", "puid": "Id", "value": $variables.puid }, "subviewlLabel": {"tasks" : "Tasks",
"appointments" : "Appointments"}} ]1'>

</oj-vb-fragment-param>

d. Comment out the dynamic container components that contain the panels and subviews.
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Test Your Subviews

Test the subview by previewing your application extension from the payment_c-list page.

1. From the payment_c-list page, click the Preview button to see your changes in your runtime test environment.

2. The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-custom/payment c/payment c-list
3. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/payment_c/payment c-list
Note: You must add /application/container to the preview link.

The screenshot below illustrates what the list page looks like with data.

4. Create a task and an appointment by entering Create Task and Create Appointment in the Action Bar.

T Pasent page

Payment for Laptops <

Owner EXTN EXTH_AM3  Last Update Date 1/4/24 8:24 AM  Last Updated By EXTH_AM3

S greate Appointment x

q Create Appolntment I o
Create Activity

Create Contact
Create Note

Create Order Pic

I Create Task I

Order for May
1/4,/24 815 AM
EXTH_AM3

Order for Apr
1,424 805 AM
EXTH_AMS

After creating a task and an appointment, view the records you created by entering Show Tasks and Show
Appointments in the Action Bar.

5. Inthelist page, drill down into the record you created to view the subtabs and actions.

Save Your Work to Git

Save your work by using the Push Git command:

Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the Git
repository).
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Create Navigation Menu Entry

After you create a custom application in Oracle Visual Builder Studio, you must create a Navigator entry for your custom
application. This topic explains how to add an entry to the Navigator for your custom object.

Prerequisites

1. In Oracle Visual Builder Studio, create the list page for your custom application.
2. In Fusion Applications, create a sandbox with the Structure tool enabled.

Create the Navigator Menu Entry

1. From the sandbox menu bar, click Tools > Structure.

2. C(Click Create > Create Page Entry.

3. Enter these details:

In the Name field, enter the Navigator menu text, such as payments.

In the Icon field, click the search icon to pick an icon for this navigator entry.
Click OK.

In the Group field, select the group that makes sense for your business needs, such as Redwood Sales.
In the Show on Navigator field, keep the default: Yes.

In the Show on Springboard field, keep the default: Yes.

In the Mobile Enabled field, keep the default: No.

In the Link Type field, select VB Studio Page.

In the Focus View ID field, enter /index.html.

In the Web Application field, search for and select: ORA_FSCM_UL.

Click OK.

In the Application Stripe field, enter crm.

In the VB Studio Flow field, enter the flow name, application.

In the VB App Ul field, enter the App Ul, cx-custom.

In the VB Page Name field, enter the page name including the container/flow name prefix, such as
container/payment_ c/payment c-list.

4. C(lick Save and Close.

5. Open your list page in Visual Builder Studio.

6. Click the Preview button to see your changes in your runtime test environment.

OF 3 ~Fe TR AP 2N T

a. From the list page, click the Home icon at the top of the page.
b. From the Navigator, click the new Payments entry under Digital Sales.
c. You should be navigated back to your custom object's list page.
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7. Publish your sandbox.

sandbox.

Configure the Picker

Chapter 2
Add a Custom Top Level Object

Note: If you need to make changes to this Navigator menu entry in the future, you can do so from a new

A picker enhances a regular list of values field so that users can quickly find the record they need. Depending on setup,
pickers can display either a list of saved searches to pick from, or a list of results most relevant to the user's context.
Pickers are already available on certain standard fields and can't be modified, although you can configure new pickers
for those fields, if needed. You can also configure pickers for custom list of values fields. Use the cx-picker fragment in

Oracle Visual Builder Studio to configure new pickers.

Here's an example of a field without a picker. Without a picker, the field has a button that users can click to view a list of

values.

Create Payment

Payment Mame

Owner
Ben Eaton

Account

Tata Consultancy Services
Siemens Healthcare

Eevil Corp

Supremo Industries LE
Volunteer Fire Depart
Tata Sons Pvt Ltd
Ironside Manufacturing

Epic Manufacturing

ORACLE
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This basic list of values includes the ability to filter on a value that the user enters into the field. For example, if the user

enters pi, then a list of accounts whose names include pi display for selection.

Account

Pl

Pinnacle Technologies

Pinnacle Technologies

Capital Bank

Epic Manufacturing

Pinnacle Seolutions

Washington Hospital Systems

This basic filtering functionality is helpful, but the best practice is to add a picker to enable a wider range of search

features on a field.

What's a Picker?

A picker is a special kind of search on a dynamic choice list field. With pickers, users can search on more than one
attribute of a record, not just on a single attribute. For example, in an Account picker, users can search on account
name, address details, and contact name. The screenshot below illustrates a search on city name.

Account
austir]

Barton Systems

Health Foods Bowie Street

MNexus Inngvations

Pinnacle Technologies

Wells Fargo

Address <

2131 Barton Hills Dr, AUSTIN, TX 78704

550 Bowie Street, AUSTIN, TX 78703

T7-12, Bristol Avenue AUSTIN, TEXAS 78737

500 Congress Avenue AUSTIN, TX 78701

2300 Oracle Way AUSTIN, TX

Prirmary -
Contact  ~

Esteban Galvan
Sherry Maloof
Andrew Scott
Anthony Smith

Matias Jet

City <

Austin

Austin

Austin

Austin

Austin

ORACLE
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In addition, pickers are more powerful than the standard search on a field because, depending on setup, pickers can
display either a list of saved searches or a list of results most relevant to the user's context:

- Saved searches are search filters that are predefined for an object. You (and end users) can define new saved
searches, if needed.

If the picker is configured to display a list of saved searches, then the user can apply a saved search at runtime
to filter the records available to search and thus more quickly find the right record to select.

Here's an example of a picker with a list of saved searches:

US Account - “es

—|— Create Account

Default Search View ~

1
o

All Accounts

1
o

My Accounts

1
o

My Favorite Accounts

1
o

My List for Accounts

1
o

= My Team's Accounts

At runtime, the picker displays the records based on the default saved search enabled for that object or the last
saved search that the user selected.

- If the picker is configured to display a list of results most relevant to the user's context, then when the user
opens the list of values, they will see records that are related to their current context in some way.

Picker Example Scenario

This topic illustrates a picker configuration example. In this example, we'll add an Account picker to a Create Payment
page so that users can search for and associate an account with a payment record.

In this example, you'll do the following:

1. In Application Composer, create a custom dynamic choice list field.
2. In Visual Builder Studio:

a. Add the dynamic choice list field to a page layout.
b. Associate the field with a field template that uses the picker fragment.
c. Configure the picker layout.
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Prerequisites

Before creating the custom Account field, you must:

1. Complete the Adaptive Search setup, if working with a custom object.

If you're configuring a picker for a field on a custom object, then make sure that you've enabled the custom
object for Adaptive Search. The operation of a picker depends on what's already set up in Adaptive Search.

A picker searches against all Adaptive Search fields that are enabled for keyword search. To enable additional
attributes for search, see Make a Field Searchable in the Ul in the Adaptive Search and Workspace chapter in the
Oracle Fusion Cloud Sales Automation Implementation Reference guide.

2. Create your own workspace in Visual Builder Studio if you don't yet have one.

If you're configuring a picker for a custom dynamic choice list field that's not yet published, then make sure
your workspace is associated with your Cloud Applications sandbox.

3. Addthe Common Application Components dependency to your workspace.
To add a dependency, click the Dependencies side tab in Visual Builder Studio.

Use the search field to find the Common Application Components dependency and then click Add.

4. This example assumes that you've got a custom Payment object with pages already configured in Visual Builder
Studio.

You can use the CX Extension Generator to set this up quickly. See Create a New Application Using the CX
Extension Generator.

1. Create the Custom Dynamic Choice List Field

To get started, create a custom dynamic choice list field on a custom object, Payment, in Application Composer. This
dynamic choice list field displays account records.

Note: Creating a custom field is a data model change. Create all data model changes in Application Composer before
creating application extensions in Visual Builder Studio. You don't have to publish your sandbox before working in
Visual Builder Studio, however, since your workspace is associated with your current sandbox.

To create the custom dynamic choice list field:

1. Ensure you're in an active sandbox.
2. In Application Composer, navigate to the Payment object > Fields node.
3. Create a custom dynamic choice list field with these values:

Field Value

Display Label Account
Name Account
Related Object Account
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Field Value

List Selection Display Value Organization Name

Tip: In Application Composer, you can optionally add a filter to the dynamic choice list field to constrain the values
that users see in the picker. For example, you might want the picker to display only accounts that are based in a
specific country or city. Adding a filter means that the picker won't display the list of saved searches to users. Also,
if you add a filter to the field in Application Composer, then you must publish your sandbox so that the filter works
correctly at runtime.

When you create a dynamic choice list field in Application Composer, two fields are created.

- One field is for use with standard, non-Redwood Oracle applications. The naming convention for this standard
field is customfield_c.

In this example, the Account_c field is automatically created. You can see and modify this field in Application
Composer and Visual Builder Studio.

- One field is for use with Redwood Sales. The naming convention for this standard field is customfield_Ild_c.

In this example, the Account_Ild_c field is automatically created and displays in Visual Builder Studio only. This
is the field that you add to Redwood Sales page layouts.

You can now add the Account_Id_c field to a page layout in Visual Builder Studio. We'll do that in the next section.

2. Add the Field to a Page Layout

Let's add your custom field to a page layout. In this example, we'll add the field to a create page. Typically, you would
also add the field to an edit page.

1. In the Redwood user experience of Sales, navigate to the page that displays the area you want to extend. In this
example, navigate to the Payments list page.
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2. Under the Settings and Actions menu, select Edit Page in Visual Builder Studio.

Settings and Sign Out
Actions

Personalization

Set Preferences

Administration

| Edit Page in Visual Builder Studio ||

Troubleshooting

Run Diagnostics Tests
Applications Help

About This Application

3. Select the project that's already set up for you. If only one project exists, then you will automatically land in that

project.

4. Visual Builder Studio automatically opens your workspace. If more than one workspace exists, however, then
you must first pick your workspace.

5. When you enter into your workspace in Visual Builder Studio, click the Layouts side tab.

6. On the Layouts side tab, click the Payment_c node.

-} Layouts -+

4 ‘ Q. Filter

€ » 4&' Qrder ¢
o 7| 4B Ravment.s
47 Note

&
4 PaymentLinesCollection_c
® » %Shigmem C

7. On the Payment_c tab, Rule Sets tab, click the Create Layout rule set.

| Note: Optionally repeat these same steps for the Edit Layout rule set.
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8. C(lick the Open icon to edit the default layout.

% Payment ¢ X

Rule Sets 2 Create Layout ~

Layouts

E default [a

Rule Sets (9) Fields Templates (5) Actions (11) Ev

CX [

O

||

Chapter 2
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9. Scroll through the list of fields to find your custom dynamic choice list field. Visual Builder Studio shows the

internal APl name, not the display name.

| Tip: To find your field more quickly, use the Filter field. For example, enter account into the Filter field.

% Payment_c X

Rule Sets » Create Layout » Layout default

Rule Sets (3) Fields Templates (5) Actions (11)

Fields

Qo) e -]

Suggested Fields

A Account_c

A Account_ld_c

O A AccountCountry_c

ORACLE
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10. Select the field, Account_ld_c, from the field list.

When you select a field, it displays in the list of fields to the right, at the bottom of the list. You can optionally
use the field's handle to drag the field to the desired location.

Select fields to display

A RecordName

A OraZexOwner_ld_c (Owner Picker Template)

I=
()
[m]
Q
[
=
3
_
=3
Iﬁ
X
e ——

If you were to preview the create page at this point, then the Account field that displays is a simple list with only
basic search filtering.

Account
-

Pl

Pinnacle Technologies
Pinnacle Technologies

Capital Bank

Epic Manufacturing
Washington Hospital Systems

Pinnacle Seolutions

To add a picker to the field, you must associate the field with a field template that uses the picker fragment.
Let's do that next.

3. Associate the Field with a Field Template

Let's add a picker to your custom dynamic choice list field to give users enhanced searching functionality. To do this,
you associate the field with a field template that uses the picker fragment.

Note: The following steps illustrate the required picker parameters, but you can set other parameters, as well. See
Parameters for the cx-picker Fragment.
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1. Make sure that you're still on the Rule Sets tab, viewing the default layout.

2. Click the Account_ld_c field.

Select fields to display

A RecordName

A OraZexOwner_ld_c (Owner Picker Template)

e e e e e e

3. Onthe Properties pane, above the Template field, click Create.

create in the next step.

4. Inthe Create Template dialog, in the Label field, enter a label for the template.

In this example, enter AccountPickerTemplate.

Create Template

Label *

AAAAAAAAAAAAAAAAAAAA

accountPickerTemplate \ ‘

Description \

Enable Extensions @

o |

Template
MNone | A |

Note: If you're doing these steps a second time for the Edit Layout rule set's layout, then in the Template
field, you don't need to create a field template. Instead, you can select the template that you're about to

FUDNS | =

o \ 3 OE s

salladoiy

5. Click Create.

ORACLE
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Visual Builder Studio creates a placeholder template with a basic structure, including an Input Text node which
you can see on the Structure pane.

= Redwood Fasiarns

oM

E Bomoen Drasver Templae
B Caleraar

B Card

[E Create Ede Drawer Templace
B Detsd Pacel

i Dragram Builder

|';lf|p:l|.i(‘

]

Pt Cawas = || suto x| sutc w0 - Live Devign

€ Return to layout

$labelHing

Code

6. Delete the default Input Text node from the Structure pane by right clicking the node and clicking Delete.

7. Click the Code button.

Live Design

Code

8. In the template editor, select the accountPickerTemplate template tags.

< Return to page

52

55

53 <template-id="accountPickerTemplate">
54  </template>

9. On the Components palette, in the Filter field, enter cx-picker.
10. Drag and drop the cx-picker fragment to the template editor, between the template tags.

Jan

‘% PaEnwn[__( £
Rul i (9 Flelds Templates (2] Actions (1 Event Listeners (11 Events Types Variables
Templates AccountPickerTemplate =
a | Q lt?(-pltk?;l l * = < Retumn to page
E 54
&  ~ Fragmaents ® T . . .
E 53  <template-id="accountPickerTemplate®:
(=] el
Y I ox-picker o) = </templatex

55

ORACLE
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11. Make sure the fragment code is selected, as illustrated in this screenshot.
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£ Return to page Live Design
BT

53 <template id="accountPickerTemplate”>

54 <oj-vb-fragment bridge="[[vbl ge]]” name="oracle cx_fragmentsUI:cx-picker”>
<0j-vb-fragment - param - name="dynamicLayoutContext™ value="[[ - fdynamicLayoutC
56 <foj-vb-fragment >

<ftemplates

i

Code

same thing.
Search Exchange

| Q Filter =
- kg ICIHHIOUT  [JUE IR ETHILAULT) .
~ ™ Fragment Container
Fragment Input Parameter (resource)
Fragment Input Parameter (extensionic
Fragment Input Parameter (dynamicla

¥ [ Template (accountPicker Template)

~| ™ Fragment Container

Fragment Input Parameter (dynamicla

Structure

Tip: On the Structure pane, selecting the Fragment Container node for the picker template accomplishes the

12. On the Properties pane for the cx-picker fragment, in the Input Parameters section, set values for the required

picker parameters.

Required Parameters for the cx-picker Fragment

Parameter Sample Value

dynamicLayoutContext [[ $dynamicLayoutContext ]]

ORACLE

Description

This parameter is set by default and you
don't have to change it, provided the field
displays on a create or edit page.

If this field doesn't display on a

create or edit page, then refer to the
dynamicLayoutContext description in
Parameters for the cx-picker Fragment for
more details.
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Parameter Sample Value Description

pickerLayoutld PickerLayout This parameter points to the rule set whose
layout controls how the picker looks at
runtime.

The default value, which you don't have to
change, is PickerLayout, the ID of the
Picker Layout rule set that's predefined for
each object including custom objects.

If you need to create a custom rule set, then
create the rule set as a dynamic table and
ensure that the values for the Label and ID
fields are identical. Then add the ID to this
parameter.

resource [[ {"name": Use this parameter to pass the target object
"accounts","displayField":"Organiz name and end point:
custom", "primaryKey":"PartyId" } ]
o name - target object name

o endpoint - target object end point

Optionally pass these additional attributes:

o displayField - the field value that's
displayed in the picker field after the
user makes a selection. If not provided
here, then the picker displays the first
field in the picker layout, by default.

o primaryKey - the field to derive the
primaryKey from. If not provided, then
the object's primaryKey field will be
used.

Be sure to update the resource parameter
with the appropriate values for your use
case. For example, replace accounts with
the REST API name of the object that the
dynamic choice list field is based on.

For additional parameters that you can set for the cx-picker fragment, see Parameters for the cx-picker
Fragment.

4. Configure the Picker Layout

Finally, select which fields display in the picker by modifying the Picker Layout rule set. This rule set's layouts control
how the picker looks at runtime.

The Picker Layout rule set and default layout are predefined for each object, including custom objects.
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In this example, we're adding an Account picker which means we must modify the Picker Layout rule set for the
Account object.

1. On the Layouts side tab, click the CX Sales > Accounts node.

-} Layouts +
| Q. Filter

4

13 » 4&, Order_c
& » “4pRauments
=

» 4& Shipment_c

K
From Dependencies
¥ (X 5Sales

3 4& Accounts

2. Onthe Accounts tab, Rule Sets tab, click the Picker Layout rule set.
3. Duplicate the default layout and then click the Open icon to edit the default_copy layout.

% Accounts X

Rule Sets (23) Fields Templates (21) Actions Even
Rule Sets Picker Layout ([ CXSales| ™

@ ) :

: Qe o=
e | J

m

|

El default_copy [a|O 1

From Dependencies
~ oracle_cx_salesUI

Bl default

4. Scroll through the list of fields to add any desired fields to the picker layout.

| Tip: To find your field more quickly, use the Filter field. For example, enter city into the Filter field.
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5. Select the field, City, from the field list.
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When you select a field, it displays in the list of fields to the right, at the bottom of the list. You can optionally

use the field's handle to drag the field to the desired location.

% Accounts X

Rule Sets (23) Fields Templates (21 Actions Event Listeners Events

Rule Sets Picker Layout | CX Sales Layout default_copy -

IQ city] x| ® - Select fields to display

Fields

All Fields @A OrganizationName

o D'I } PrimaryAddress A FormatedAddress

O A PrnimaryAddress.City
A PrimaryContactName

'.::[ A City

Test the Picker Flow

You can now test the picker that you added to the list of values field.

1.

P © Q

‘ Publish | =

2. The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-custom/payment c/payment c-list

ORACLE

From the payment_c-list page, click the Preview button to see your changes in your runtime test environment.
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3. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/payment_c/payment c-list

| Note: You must add /application/container to the preview link.

The screenshot below illustrates what the list page looks like with data.

All Payments o

O Try searching by key Al Filter

[ = - CEErA T S W
&3 Resulis
Paymient Name 5 Creation Date = Last Updated Date S Actions

O Payment, Oct invoice 10419722 10003 P 11AT/254:2% AM
O  Payment tor Order 1020 1171722 206 AM 11/17/23 4:42 AM
O r 1 Ot 1 4 1173422 737 PM 12719722 5:23 PM
O  mew7_Rect /7722 616 P 1177722 816 PM
O Mot 1177722 6:45 PM 1177722 645 PM

4. Inthe Action Bar, enter create payment.
5. Click Create Payment.

The Create Payment drawer displays.
6. Inthe Create Payment drawer, click the three dots next to the Account field to view the list of saved searches.

US Account hd L

Create Account

_I_

Default Search View ~

sl

=& Al Accounts

ey My Accounts

% My Favorite Accounts
== My List for Accounts
% My Team's Accounts
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7. If you enter some text into the field, the picker leverages Adaptive Search to return matched results. In the
example below, we've entered pinnacle tech.

Aceount
pinnacle te cﬂ

Name <

Pinnacle Technologies

Pinnacle Technologies

Address = Primary Contact <
600 Congress Avenue AUSTIN, TX 78701 Anthony Smith
400 Pinnacle Way,SEATTLE, WA Cole Mitchell

City <
Austin

Seattle

In the picker, try searching on a city, for example, austin, SO you can see how you can search on other record

attributes.
Account = .
austir]
Prirmary :

N v Add e City <
ame ress Contact =4/
Barton Systems 2131 Barton Hills Dr, AUSTIM, TX 78704 Esteban Galvan Austin
Health Foods Bowie Street 550 Bowie Street AUSTIN, TX 78703 Sherry Maloof Austin
MNexus Inngvations T7-12, Bristol Avenue AUSTIN, TEXAS 78737 Andrew Scomn Austin
Pinnacle Technologies 500 Congress Avenue AUSTIN, TX 78701 Anthony Smith Austin
Wells Fargo 2300 Oracle Way, AUSTIN, TX Matias Jet Austin

To understand how the search works, see Search Within Fields in the Search and Lists chapter in the Oracle
Fusion Cloud Sales Automation Using Digital Sales (Redwood Sales) guide.

8. Once you're happy with how the picker looks, repeat these same steps for the edit layout.

When configuring a second layout, you don't have to create a new field template and configure the picker
fragment again; you can select the field template that you created in this procedure.

You also don't need to configure the picker layout a second time.

ORACLE
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9. Save your work by using the Push Git command.
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Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the

Git repository).

< Workspace2 > extend-next-gen-s: it /20220830

Ly O\ Filter

» Changed (1) Commit

|°¢'|D@E>‘b®

o Git B

Switch Branch

Commit

Pull

Merge

Reset to HEAD

D detail

Ke

Parameters for the cx-picker Fragment

This topic lists the parameters that you can set for the cx-picker fragment. To learn how to set parameters for this

fragment, see Configure the Picker.

Required Parameters for the cx-picker Fragment

Parameter Sample Value
dynamicLayoutContext [[ $dynamicLayoutContext 1]
pickerLayoutld PickerLayout

ORACLE

Description

This parameter is set by default and you don't
have to change it if the field displays on a create
or edit page.

If this field doesn't display on a create or edit
page, but rather on a mass update page for
example, then you can remove the default value
in this parameter.

This parameter points to the rule set whose
layout controls how the picker looks at runtime.

The default value, which you don't have to
change, is PickerLayout, the ID of the Picker
Layout rule set that's predefined for each
object including custom objects.
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Parameter Sample Value Description

If you need to create a custom rule set, then
create the rule set as a dynamic table and
ensure that the values for the Label and ID
fields are identical. Then add the rule set's ID to
this parameter.

resource [[ {"name": Use this parameter to pass the target object
"accounts","displayField":"Organizat: name and end point:
custom", "primaryKey":"PartyId" } 1]

- name - target object name

- endpoint - target object end point

Optionally pass these additional attributes:

- displayField - the field value that's
displayed in the picker field after the user
makes a selection. If not provided here,
then the picker displays the first field in
the picker layout, by default.

- primaryKey - the field to derive the
primaryKey from. If not provided, then the
object's primaryKey field will be used.

Be sure to update the resource parameter with
the appropriate values for your use case. For
example, replace accounts with the REST API
name of the object that the dynamic choice list
field is based on.

Optional Parameters for the cx-picker Fragment

Parameter Sample Value Description
context To display one field vs. another, You can use the context parameter to control
set the context parameter to picker behavior. For example:

[[ {'variableName':true} ]].
- Display different fields in a picker at

For example: runtime.
[[ {'showContact':false} ]]

. o For example, based on the value of this
To allow users to enter text values into this field, parameter, the picker could display either
add this property to the context parameter: Field A or Field B.
[[ {'enablePlainText':true} 1]

To set this up, see Display Different Fields
in a Picker.

- Allow the user to enter a text value into
the field at runtime, instead of selecting
an existing value.

createConfig [[ {'enabled':true} 1] Indicates if the user can create a record directly
from the picker. Specify true or false.

If no value is set, then the "create a record"
option is automatically displayed in the picker
by default.

18
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Parameter

isDefaultSavedSearchEnabled

label

pickerNameField

query

ORACLE

Sample Value

This parameter is a check box.

US Account

{{ $value.pickerNameField }}

[ { "op" H "$CO" ,
"attribute":"OrganizationName",
"value":"Pinnacle"}]

Chapter 2
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Description

Use this parameter to indicate the default saved
search that's automatically applied to the list of
values in the picker field.

The check box is not selected, by default.

- When not selected, the Default Search
View option is automatically selected from
the list of saved searches on the picker
field.

For accounts and contacts, the default
search view is All Accounts and All
Contacts.

- When selected, the default selection is
always the default saved search enabled
for the object, regardless of the last saved
search selected.

Note: This parameter is applicable only
for objects that are supported by Adaptive
Search.

Use this parameter to override the field name
on the UL

This parameter is particularly useful if a filter
is defined on the dynamic choice list field in
Application Composer or if you pass filter
criteria using the query parameter (described
below).

For example, if you add a simple filter to

the dynamic choice list field to display only
accounts in the US, then you can use the
label parameter to change the field name. In
this example, you might want to change the
Account field name to a new field name, Us
Account.

Use this parameter in conjunction with the
context parameter to support user-entered
text in the picker field. Bind this parameter
to a virtual field that you create, such as
pickerNamefield

If this field has a simple filter (from Application
Composer) or a value in the query parameter,
then any value in the pickerNameField
parameter is ignored.

Use this parameter to filter the records that are
available in the picker at runtime.
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Parameter Sample Value
readonly This parameter is a check box.
required This parameter is a check box.
selectedRow {{ $page.variables.selectedRow }}
sortCriteria Forexample, [[ [{'attribute':
'PrimaryContact.PartyName',
'direction': 'descending'}] ]1]

ORACLE
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Description

For example, you could filter the records to
display only accounts with a specific keyword in
the name, such as Pinnacle.

The value for this parameter should be an
array[object].

If you have both a simple filter on the dynamic
choice list field (from Application Composer)
and also a query in this parameter, then this
parameter takes precedence.

If you pass a value in this parameter, then the
list of saved searches won't display in the picker
at runtime.

Use this parameter to make the field read only.

For example, you might want to make the field
editable only when users first create a record.
During edit, however, you might want this field
to be read only.

This parameter is applicable only when there
is no value in the dynamicLayoutContext
parameter. Use this parameter to make the
picker field required.

If the dynamicLayoutContext parameter
does contain a value, however, then you can
make the picker field required by selecting
the Required check box on the Fields tab. For
example: Payment_c tab > Fields subtab >
select the Account_ld_c field > on the
Properties pane, click the Required check
box.

Use this parameter in conjunction with the
value parameter to make use of other field
values from the selected row in the picker.

For example, if the user picks a contact, then
the contactld is stored in the value parameter
that's bound to the picker. But, the user can also
retrieve the contact's email address using this
parameter.

Use this parameter to override the default sort
criteria in the picker layout.

If the user selects a saved search, then the sort
criteria comes from this parameter, if provided.
If not provided, then the picker honors the

sort criteria defined in the saved search. If not
defined, then the picker sorts values based on
the first column in the picker layout.
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Parameter Sample Value

value {{ $page.variables.pickerValue }}

Display Different Fields in a Picker

Depending on how you use the context parameter in the cx-picker fragment, you can display different fields in the

picker at runtime. For example, the picker could display either Field A or Field B.

Chapter 2
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Description

If there is a simple filter on the field or if a filter
is defined in the query parameter, or if the user
selects Related Records, then the sort criteria
comes from this parameter, if provided. If not
provided, then the picker sorts values based on
the first column in the picker layout.

Use this parameter to store the value selected
in the picker field, when there is no value in the
dynamicLayoutContext parameter.

For example, let's say a contact picker is on a
page doesn't have a dynamic layout.

If the user picks a contact, then the contactld is
stored in the value parameter that's bound to
the picker.

To display different fields in a picker, use the context parameter. You'll also have to do the following:

- create a custom variable

- update the picker layout display properties in the picker object's JSON

Let's look at an example using the Account picker documented in Configure the Picker.

In this example, the picker you already created includes both the Address and Primary Contact fields.

Account

austir

A

Mame < Address

Barton Systems 2131 Barton Hills Dr, AUSTIM, TX 78704

Health Foods Bowie Street 550 Bowie Street, AUSTIN, TX 78703

MNexus Inngvations 7-12, Bristol Avenue AUSTIN, TEXAS 78737
Pinnacle Technologies 500 Congress Avenue AUSTIN, TX 78701
Wells Fargo 2300 Oracle Way AUSTIN, TX

Primary -
Contact

Esteban Galvan
Sherry Maloof
Andrew Scott
Anthony Smith

Matias Jet

City 2

Austin

Austin

Austin

Austin

Austin

Using the context parameter, you can instead show either the Address or Primary Contact field, depending on the value

of a custom variable.

Here's how to set this up:

ORACLE
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1. Create the Custom Variable
First, create the custom variable on the picker's object:

1. On the Layouts side tab, click the CX Sales > Accounts node.

-} Layouts +
| Q. Filter

4

13 3 4&, Order_c
e » 4% Paymenic
=

» 4&1 Shipment_c

K
From Dependencies
¥ (X 5Sales

3 4& Accounts

On the Accounts tab, click the Variables subtab.

Click + Variable.

In the Create Variable dialog, make sure the Variable option is selected and, in the ID field, enter showcontact.
In the Type field, select Boolean.

Click Create.

cuhlhunN

2. Add the Condition to the Picker Display Properties

Next, add the condition (which field to show depending on the value of the variable) to the picker layout display
properties in the Account object's JSON.

1. On the Accounts tab, click the JSON subtab.
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2. Find the picker layout display properties.

w

9
18
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34

}

4%] Accounts X

Rule Sets (23) Fields Templates (21) Actions

1y
"addLayouts": {
"default_copy": {

“expression”: “[[ ‘default_copy' ]]1"

}
I
“addSubLayouts”: {
"/PickerLayout™: {
“default_copy": {
"layoutType": "table"”,
"layout": {
"displayProperties”: [
"OrganizationName",

Event Listeners

"FormattedAddress”,
"PrimaryContactName”,

“City”
]l‘
"fieldTemplatemap": {},
“readonly": true
b
“usedIn": [
"default_copy”

}
}

3. Inthe display properties section, replace the two lines for the "Formattedaddress" and "PrimaryContactName"
fields with a single line:

"{{ $componentContext.showContact ? 'PrimaryContactName'

'FormattedAddress' }}",

ORACLE
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3. Set the Value of the Variable in the Picker Fragment

Finally, define the value of the variable (true or false) in the picker fragment itself.

1. On the Layouts side tab, click the Payment_c node.

-} Layouts +

4 ‘O\ Filter

4 PaymentLinesCollection_c

® » 4 Shipment.s

2. Onthe Payment_c tab, Templates tab, click the AccountPickerTemplate template.
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3. Make sure the fragment code is selected, as illustrated in this screenshot.

£ Return to page
o
53 <template id="accountPickerTemplate”>
54 <oj-vb-fragment bridge="[[vbBridge]]” name="
56 <foj-vb-fragment>
<ftemplates

Live l Design

oracle cx fragmentsul:cx-picker”>
55 <0j-vb-fragment - param - name="dynamicLayoutContext™ value="[[ - fdynamicLayoutC

Code

same thing.
Search Exchange

| Q. Filter

B VSHIIGUE [IWF ILRGE SISy
~ ™ Fragment Container
Fragment Input Parameter (resource)
Fragment Input Parameter (extensionic
Fragment Input Parameter (dynamicla

= Template (accountPickerTemplate)

~| ™ Fragment Container

Fragment Input Parameter (dynamicla

Structure
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Tip: On the Structure pane, selecting the Fragment Container node for the picker template accomplishes the

4. On the Properties pane for the cx-picker fragment, in the Input Parameters section, set the value for the
context parameter. You can set the showContact variable to true or false:

[[ {'showContact':true} 1]
or

[[ {'showContact':false} ]]

ORACLE
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4. Test Your Setup

You can now test each variable setting.

1. Preview your extension and test the picker with the showContact variable as true:

Account hd

Name < Primary Contact| City <

BlueSky Manufacturing

Time Variance Authority Tara Minnuts Kimberling City

2. Next, preview your extension and test the picker with the showContact variable as false:

Account

Name 2 > City <

BlueSky Manufacturing

Time Variance Authority 76 South,KIMBERLING CITY, MO 65686 Kimberling City

Add a Mashup to a Page

For any Redwood Sales object, standard or custom, you can configure its detail page to include a mashup that
references a publicly available URL. You create the mashup in Oracle Visual Builder Studio.

For example, you can add a Wikipedia page to a payment's detail page. At runtime, when the user views a payment, the
user can enter Show Wikipedia into the Action Bar. The Show Wikipedia action lets the user view a related Wikipedia
page without having to leave the payment record.

Add a Mashup to a Detail Page

Let's walk through an example of adding a mashup. In this example, we'll add a mashup to a payment's detail page.

In Visual Builder Studio, click the App Uls tab.

Expand cx-custom > payment_c, then click the payment_c-detail node.
On the payment_c-detail tab, click the Page Designer subtab.

Click the Code button.

PUWNa

Live Design Code
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5. Confirm that you are viewing the page in Page Designer.

o

10.
1n

v Page

Templates

Remove the comment tags for the dynamic container components that contain the panels and subviews.

B oW R

wn

O WO m D

12
13
14
15
16
17
18
19
28
21
22
23

<oj-vb-fragment bridges"[[vbBridge]]” name="oracle c¢x fragmentsUl:cx-detail™ c¢lasss™oj-flex-ites
<0j-vb-fragment -param name="resources”
value="[[ {'Payment_c' : {"puid’: $variables.puid, "id": $variables.id, 'endpoint’: $applic
</oj-vb-fragment - param>
<oj-vb-fragment-param name="header"”
value="[[ {'resource’: $flow.constants.objectName, "extensionId®: Sapplication.constants.ex
<foj-vb-fragment -param>
<oj-vb-fragment -param name="actionBar”
value="[[ { "applicationId™: "ORACLE-ISS-APP", "resource”: {"name”: $flow.constants.objectn
</oj-vb-fragment - param>
<oj-vb-fragment - param names="panels”
value="[[ { "panelsMetadata": $metadata.dynamicContainermetadata, "wiew™: $page.variables.wv
<foj-vb-fragment - param>»
<0j-vb-fragment -param name="context"” wvalue="[[ { flowContext': $flow.variables.context} ]]"»<
¢/ o] -vb-fragment>

¢o]-dynamic-container layout="PanelsContainerLayout" layout-provider="[[ $metadata.dynamicConta
class="oj-flex-item oj-sm-12 oj-md-1"></07-dynamic-containers
<oj-dynamic-container layout="SubviewContainerLayout™ layout-provider="[[ $metadata.dynamicCont
< /o] -dynamic -containers

Highlight the <oj-dynamic-container> tags for the subviews.

<div class="o0j-flex"»
<oj-dynamic-container layout="SubviewContainerLayout™ layout-provider="[[ $metadata.dynamicCol
class="0j-flex-item oj-sm-12 oj-md-12"></0j-dynamic-container>
<fdive

On the Properties pane, in the Case 1 region, click the Add Section icon, and then click New Section.

In the Title field, enter a title for the section, such as wikipedia.
In the ID field, change the value to wikipedia.
Click OK.
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12. Manually update the template's JSON with the correct subview name.

a. On the payment_c-detail tab, click the JSON subtab.

b. Inthe section for the SubviewContainerLayout's section template layout, replace the sectionTemplateMap

and displayProperties Values to match the subview's ID name, wikipedia.

In our example, this is what the SubviewContainerLayout's sectionTemplateMap and displayProperties

should look like:

"layouts": {
“SubviewContainerLayout™: H
"label™: "Container Rule Set 1",

"layoutType": "container",
"layouts": {
"casel": {

"label": “Case 1",

"layoutType": "container”,

"layout™: {
"sectionTemplateMap™: {

Fs

"displayProperties”: [

"PaymentLinesCollection c¢",
]
}
}

bs

“rules”: [
"containerLayoutl-rule2”

]
}s

"PaymentLinesCollection_c": "paymentLinesCollectionC”,
“wikipedia”

13. Still on the payment_c-detail tab, click the Page Designer tab.

ORACLE
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14.

15.

16.

17.

On the Properties pane, click the Wikipedia section that you just added.

Display Logic
-+ Case
Case 1 ® :

Condition
Always Show

Sections +
PaymentLinesCollection_c

Wikipedia

Page Designer navigates you to the template editor, still on the payment_c-detail tab, where you can design the
mashup template.
Click the Code button.

Live Design Code

In the template editor, find the mashup template tags.

< Return to page

38

39 <template id="wikipedia">
40 ¢/template>

11

Add the following parameters to the fragment code so that the code looks like the below sample. Be sure to
update the values for the titie and url parameters as needed.

<template id="wikipedia">

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx fragmentsUI:cx-url">
<oj-vb-fragment-param name="dynamicLayoutContext" value="{}"></oj-vb-fragment-param>
<oj-vb-fragment-param name="mode" value="embedded"></oj-vb-fragment-param>
<oj-vb-fragment-param name="title" value="Wikipedia"></oj-vb-fragment-param>
<oj-vb-fragment-param name="url" value="https://en.wikipedia.org/wiki/"></oj-vb-fragment-param>
</oj-vb-fragment>

</template>

This table describes the parameters that you can provide for a mashup:

Parameters for Mashup
Parameter Name Description
title Enter the title of the mashup, which displays in the subview Ul.
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Parameter Name Description

url Enter the mashup's URL.
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18. Comment out the dynamic container component from the payment_c-detail page.

a. Click < Return to page.

< Return to page

33 value="[[ { "name': $flojy
34 <oj-vb-fragment-param name;
35 </0j-vb-fragment>

36

37 «/template>

38

39  «<template id="wikipedia">»

49 <0j-vb-fragment bridge="[[vbj
a1 <oj-vb-fragment-param name;
a2 <oj-vb-fragment-param name;
a3 <oj-vb-fragment-param name;
44 <0j-vb-fragment-param name;
45 </oj-vb-fragment>

46 themplate>

a7

b. Click the Code button.

c. Comment out the dynamic container components that contain the panels and subviews.

t bridges"[[vbBridge]]” names="oracle cx fragmentsUl:cx-detail™ class="oj-flex-ite

4 Wrces
value="[[ { Payment_c" id': $variables.puid, "id": $variables.id, 'endpoint’: $applic
<foj-vb-fragment -param>
<oj-vbh-fragment -param name="header"

value="[[ {'resource’: $flow.constants.objectName, 'extensionId’: $application.constants.ex
<foj-vb-fragment -param>
<oj-vb-fragment -param name="actionBar”

value="[[ { "applicationId™: "ORACLE-ISS-APP", "resource”: {"name”: $flow.constants.objectn
</oj-vb-fragment -param>
<oj-vb-fragment - param names="panels”

value="[[ { "panelsMetadata": $metadata.dynamicContainermetadata, "wiew™: $page.variables.v
<foj-vb-fragment - param»
<0j-vb-fragment -param name="context"” wvalue="[[ { flowContext': $flow.variables.context} ]]"»<

¢f0]-vb-fragment>

¢o]-dynamic-container layout="PanelsContainerLayout" layout-provider="[[ $metadata.dynamicConta
class="oj-flex-item oj-sm-12 oj-md-1"></0j-dynamic-container>
<oj-dynamic-container layout="SubviewContainerLayout™ layout-provider="[[ $metadata.dynamicCont

< /o] -dynamic -containers

Note: To add more subviews, you must first un-comment the dynamic container component so that
you can add a new section for each desired subview.

19. From the payment_c-list page, click the Preview button to see your changes in your runtime test environment.

> ©® Q ‘ Publish | =
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20. The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-custom/payment c/payment c-list
21. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/payment_c/payment c-list

I Note: You must add /application/container to the preview link.

The screenshot below illustrates what the list page looks like with data.

All Payments Actions T

S Try searching by ke Add Filnes

— TN CEES S
63 Results
Payment Name 2 Creation Date < Last Updated Date < Actions

O e 10719422 10:03 PM 11717023 4:23 AM
O Py 1101722 2:06 AM 1117723 4:42 AM
O 1 o 1173722 737 P 12/19/22 523 PM
] 1177722 616 FM 1177722 816 PM
O HevsiA 117722 6:45 PM 1177722 &:45 PM

Chapter 2
Add a Custom Top Level Object

22. If data exists, you can click any record on the list page to drill down to the detail page. The detail page, including
header region and panels, should display.

23. Inthe Action Bar, enter show wikipedia.

T All Payments

Payment for Laptops ©

Amount 1,000 Discount 5%

» show wikipedia

W Show Wikipedia

ORACLE
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24. C(Click Show Wikipedia.

The Wikipedia mashup displays:

T Al Payments

Payment for Laptops @
nt 1,000 [ nt 5%

= Goto Dveivies

Wikipedia

= ) WIKIPEDIA
- Thar Frew Ecyeloperdia

), Search Wikipadia Saarch

Man Page  Tak

Welcome to Wikipedia

the free encyc

weda that asryone can o)
4 articied i English

BT

From today's featured article I the|
Intersiate 90 (1-50) is an sasi-wesi ranscontinental = Stor
iragway and the longest Intersialn Mighway in the caug
Unked States at 3021 miles. (4,862 km). i runs from Madi
Seattle. Washington, o B i dam:
passing through the P, Mountain peop
Wesl, Greal Plains, wasl The ® An e

R AT e Fighviriry Sanves 13 8lates and has 15 susilias mare

oonbiguous Uiniied Siaies
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25. Save your work by using the Push Git command.
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Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the

Git repository).

< Workspace2 > extend-next-gen-sales.git/20220830 .

L Q Filter

» Changed (1) Commit

o Git B

Switch Branch

Cormmit

Pull

Merge

Reset to HEAD

O detail

Ke

Add a Rollups Region to a Panel

Rollups summarize data across records, for an attribute of a business object and its related objects. The summarized
value of a rollup appears as a business metric inside a panel on an object's detail page. You can add new rollups to a

panel using Oracle Visual Builder Studio.

Where Do Rollups Appear?

Rollups appear inside panels on an object's detail page.

You can add rollups, either predefined or custom, to panels for both custom and standard objects. Some panels for

standard objects are already delivered with a rollups region.

Here's a screenshot of a rollup that displays in a panel for a payment.
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T All Payments
Payment for Laptops ©
EEEIE) Pevment Date 531425 Amount 1,000 int 5%
3
-— - AW W
Payment Lines Shipment Contacts from Bundle
e ' 7,000 Mamual 1 Shigiment Brandon C Hooper
4 b 67723 8:41 PN BATI2IF1IAM
Tillerey Payrreert
s 1,000 Maniial Shipament Gustay Sebald
BN &/7/23 315 P BATI2IF1TAM
1000 Director
BOA Payment
2.000 - May Shipment Walsh Hooper
&5 523 67723429 AM BATS23 158 AM
1000
S Bank Payment
IV =000 Api Shipment John Hooper
&/523 67725 257 AM B/ 16720 G568 P
4,000
Wells Payment
W R Mar Shipment Justin Garmble
&11723 G625 921 PM & 15/23 T:51 P
3000 WP, Purchasging
Wiew All Payrment Lires (4) View All Shipment (T) Wiew All Contacts from Bundle (12)

You can add a predefined or custom rollup to a panel.

Before adding a custom rollup, you must first create the custom rollup.

1. In Application Composer:

o For the desired object, create a rollup object and fields.
o Then, create and publish the fields as rollups.

2. Inthe Sales Setup and Maintenance work area, in the Configure Adaptive Search task, enable the rollup object
and attributes.

See What are the steps to set up rollups?.

In the following example, we'll use a rollup object, called RollupObject, created for the Payment object. The RollupObject
object has these fields:

- Number of Payment Lines (number field)

- Total Amount (currency field)

Create the Rollup Layout and Rule Set

To add a rollup to a panel, you must first create a layout for the rollup. You can then add the rollup layout to the panel.

Let's look at an example of adding a rollup to the Payment Lines panel on a payment's detail page.
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First, create the rollup layout:

1. In Visual Builder Studio, click the Layouts tab, then click the Create Layout icon.

-} Layouts E
4 ‘ Q. Filter |
] L J
\Ca - & Payment_c

4 PaymentContactMMInter_Src_
Nej

4 PaymentLinesCollection_c
& 47 Shipment_c
i) 47 Contacts

2. In the Create Layout dialog, click the REST resource for your child object.

In our example, the rollup object is called RollupObject. So, expand cx-custom and click Payment_c/
RollupObject_c.

Create Layout

Choose the source of your data

= E =1
Payment_c/Paym Payment_c/Rollup
entLinesCollectio Object_c

n_c \ y

3. Click Create.

Next, create the associated rule set.

1. On the RollupObject_c layout tab, click + Rule Set to create a new rule set for the layout.

a. Inthe Create Rule Set dialog, in the Component field, select Dynamic Form.
b. Inthe Label field, enter PaymentLinesRollup.
c. Inthe ID field, change the value to PaymentLinesRollup.
d. Click Create.
2. Add the rollup fields to the layout.
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a. Click the Open icon next to the default layout.

4% RollupObject_c X

Rule Sets (1) Fields Templates Actions Event List

¢ RuleSets  JPaymentLinesRollup |

Qe o

El default O 1

Layouts

b. Click the cx-panel-rollup fragment.

This fragment provides the format for the rollup region.

™ cx-panel-rollup Application Comp...

oracle_cx_fragmentsUl:cx-panel-rollup

c. The rollup layout includes two slots. From the list of fields, drag a rollup field to the desired slot.

For example, drag the TotalAmount_c field to the item2 slot.

% RoflupObject_c =

Rule Se1%01) Fields Templates Actions Event Lteners Events Types Wariables JanvaScript FSON Setings
€ RuleSes  PaymentLinéesRollup  Layout default
£ Q. Filter @ - Set oracle_cx_fragmentsUl.cx-panel-rollup parameters
)
[
A item

B F# HumberOiPaymentLim l_ F# NumberOfPaymentLines_c I

. :
O A Payment_id_ A toarm

O A RecordMame
D #* Shigementimount_¢

O # TotalShipmeni_c

Add the Rollups Region to the Panel

In the previous section, you configured the rollups region using a layout and rule set.

137
ORACLE



Oracle Fusion Cloud Sales Automation Chapter 2
How do | create an application extension for custom objects Add a Custom Top Level Object

in Oracle Visual Builder Studio?
Next, add the rollups region to a panel by adding a parameter to the panel's page and template. Here's how:

In Visual Builder Studio, click the App Uls tab.

Expand cx-custom > payment_c, then click the payment_c-detail node.
Click the payment_c-detail tab, then click the Page Designer subtab.
Click the Code button.

PN

| Live Design Code

5. Select Templates from the dropdown.

[E'.] payment_c-detail X

Page Designer Actions (3) Event Listeners (1) Events Tvp
Z ‘ Q. Filter, Alt+F | = | Templates ~

= .

5

% ~ Redwood Patterns Page

=]

“ Bottom Drawer Template

v Templates

Calendar

T

6. Add the following parameter to the fragment code.

<oj-vb-fragment-param name="rollupLayoutId" value="PaymentLinesRollup"></oj-vb-fragment-param>

Be sure to replace the rollupLayoutid parameter's value with the appropriate value.

The resulting template code should look something like this:

<template id="paymentLines">

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle_cx_fragmentsUI:cx-panel">
<oj-vb-fragment-param name="resource"
value='[[ {"name": $flow.constants.objectName, "primaryKey": "Id", "endpoint":

$application.constants.serviceConnection } ]]'>
</oj-vb-fragment-param>
<oj-vb-fragment-param name="sortCriteria" value='[[ [{"attribute": "LastUpdateDate",b "direction":
"desc" }] 11'>

</oj-vb-fragment-param>
<oj-vb-fragment-param name="query"
value='[[ [{"type": "selfLink", "params": [{"key": "Payment__c_Id", "value": $variables.id }1}]1 11'></
oj-vb-fragment-param>

<oj-vb-fragment-param name="child" value='[[ {"name": "PaymentLinesCollection c", "primaryKey": "Id",
"relationship": "Child"} ]]'></oj-vb-fragment-param>
<oj-vb-fragment-param name="context" value="[[ {} ]]"></oj-vb-fragment-param>

<oj-vb-fragment-param name="extensionId" value="{{ $application.constants.extensionId }}"></oj-vb-

fragment-param>
<oj-vb-fragment-param name="rollupLayoutId" value="PaymentLinesRollup"></oj-vb-fragment-param>

</oj-vb-fragment>
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17

<foj

18

<ftemplate

Select Page from the dropdown.

Page

v Page

Templates

8. Replace the existing resource parameter with the following code:

<oj-vb-fragment-param name="resource"
value="[[ {'name':'Payment_c', 'puid': $variables.puid, 'id':
$application.constants.serviceConnection ,'extensionId': $appl
'RollupObject c'} ]1">

$variables.id, 'endpoint':

ication.constants.extensionId, 'rollup':

Be sure to replace all attribute values with the appropriate values for your scenario.

The resulting code should look something like this:

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle_cx fragmentsUI:cx-detail" class="oj-flex-item oj-

sm-12 oj-md-11"
on-view-change-event="[[$listeners.fragmentViewChangeEvent]]">
<oj-vb-fragment-param name="resource"

value="[[ {'name':'Payment c', 'puid': $variables.puid, 'id':
$application.constants.serviceConnection ,'extensionId': $appl
'RollupObject c'} ]1">

<oj-vb-fragment-param name="header" value="[[ {'resource': $fl

$variables.id, 'endpoint':
ication.constants.extensionId, 'rollup':

ow.constants.objectName, 'extensionId':

$application.constants.extensionId } ]]"></oj-vb-fragment-param>

<oj-vb-fragment-param name="actionBar" value='[[ {

"applicationId":

"ORACLE-ISS-APP",

"subviewLabel":

{"PaymentContactMMInter Src Payment cToPaymentContactMMInter c_Tgt":

$translations.CustomBundle.Contacts ()},

nId" ,

"puid":

"resource":
"Id", "value": $variables.puid }} ]]'></oj-vb-fragment-param>

{"name": $flow.constants.objectName,

"primaryKey":

<oj-vb-fragment-param name="panels" value='[[ { "panelsMetadata": $metadata.dynamicContainerMetadata,

"view": $page.variables.view } ]]'></oj-vb-fragment-param>
<oj-vb-fragment-param name="context" value="[[ {'flowContext':
fragment-param>

$flow.variables.context} ]]"></oj-vb-

<oj-vb-fragment-param name="row" value="{{ $variables.row }}"></oj-vb-fragment-param>

</oj-vb-fragment>
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Test Your Panel

Test the rollups by previewing your application extension from the payment_c-list page.

1. From the payment_c-list page, click the Preview button to see your changes in your runtime test environment.

> ® Q ‘ Publish |

2. The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-custom/payment c/payment c-list
3. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/payment c/payment c-list

I Note: You must add /application/container to the preview link.

The screenshot below illustrates what the list page looks like with data.

All Payments Actions T

S Try searching by ke Add Filnes

— —— TN CEES S
63 Results
Payment Name 2 Creation Date < Last Updated Date < Actions

O  Paymens, Oct invoice 101522 1005 P AT/ 25425 AN
O Paymens for Grder 1020 1101722 2:06 AM 1117723 4:42 AM
0O pa 1 o 1 ! 1173722 737 P 12/19/22 523 PM
] o T_Rec 1 1177722 616 FM 1177722 816 PM
O HevsiA 1147722 6:45 P 1177722 &:45 PM
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4. If data exists, you can click any record on the list page to drill down to the detail page. The detail page, including
header region and panels, should display.

You should now see the Payment Lines panel on the detail page, with a region for rollups.

T Al Payments

Payment for Laptops <@

Payment Date 5/31/23

» Try Croole Note

Payment Lines

7,000

oz
E H :

Zillrw Payrivnt
A 1.000

8/17/23

BOA, Payrient

2,000 (Primary)

&/5/23

S Bank Payment

IV =000
&/5/23
Wells Payment
Ll 1000

/1423

Wigswr All Pasrment Lines (4]

Shipment

Mamual1 Shigment
L0 67723841 PM

Mamual Shiparent
&/7723 315 PM
1000

May Shipment
677723 4:29 AM
1000

Apr Shipment
67725 257 AM
4000

Mar Shipment
G252 PM
3,000

0000

View All Shipment (7)

Contacts from Bundle

Brandon C Hooper
B/17/23 313 AM

Gustay Sebald
B/17723 312 AM
Director

Walsh Hoogper

B/17/23 2:58 AM

Jahn Hooper
B/ 16023 5:38 PM

Justin Garmble
51323 T:51 PM
WP, Purchasing

Wigsw All Contacts fr

om Bundle [12)
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5. Save your work by using the Push Git command.

Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the
Git repository).

< Workspace2 > extend-next-gen-sales.git/20220830 .
ol Git @ D detail
A O\ Filter Switch Branch
» Changed (1) Commit. Commit
Pull
Merge

Reset to HEAD

Ke

|°¢»|D@[;b‘b®

Understanding "Show" Actions

Whenever you add a subview, a Show action is automatically created. The Show action displays in the Action Bar so that
users can display the related subview. Show actions are not smart actions and you don't need to manually create them.
The only change you might want to make for Show actions is the label. Each Show action string is hard-coded but you
can change it to a string that can be translated.

What's a Show Action?

Show actions are similar to smart actions because they are both available from the Action Bar. However, Show actions
are not smart actions. Instead, Show actions are actions that are automatically displayed specifically so that users can
navigate to subviews for various objects.

For example, these Show actions were automatically created when you added subviews for the below objects:
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Payment for Laptops ©

Owner Pahilajani Haresh  Last Update Date 11/29/23 1:57 AM  Creation Date 5/31/23 5:57 AM

© show|Attachments *

B show Attachments
Show Contacts
Show Notes

Show Payment Lines

Show Shipment

Show Action Labels

The labels for Show actions are derived from each subview's display property. The display property was specified when
the section was initially added for the subview. You can view subview display properties on the detail page's JSON.

EE payment_c-detall x

Page Designe Actions Event Listeners Events Types Variables (2 JavaSeript JSON Settings
a2 "subviewContainerLayout”: {

43 "label™: "Container Rule Set 1%,

a4 "layoutType™: "container”,

as "layouts”™: {

a6 “casel™: {

47 "label": "Case 1",

A8 "layoutType”: “container”,

49 "layout™: {

50 “sectionTemplateMap”: {

51 "PaymentLinesCollection_c™: "PaymentLinesCollection_cSubviewTemplate”,
52 "Attachment™: “AttachmentSubviewTemplate"”,
53 "Note": "NoteSubviewTemplate™,

54 "Wikipedia": “"wikipedia”

55 L

56 |"displayProperties”] [

57 "PaymentLinesCollection ¢”,

58 "Attachment™,

59 "Note™,

61 ]

62 }

Since Show action labels are automatically derived from the display property strings, the labels are hard-coded and not
translatable. If needed, you can make them translatable.

Create a Translatable String

Let's look at an example. If you add a subview for a mashup that displays Wikipedia, then the Show Wikipedia action is
automatically created without any action required on your part.
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T All Payments

Payment for Laptops ©

Amount 1,000 Discount 5%

> show wikipedia X

W Show Wikipedia

But, maybe you have users who need to see the Show Wikipedia string in Korean. In that case, you can change the hard-
coded string to a string that's translatable.

To create translatable Show actions:

1. Add the translatable string to your custom translation bundle.

See Create a Translation Bundle, If You Don't Have One Already.
2. Create a constant that refers to the string in your translation bundle.

a. Onthe payment_c-detail tab, click the Variables subtab.
Click + Variable.

c. Inthe Create Variable dialog, make sure the Constant option is selected and, in the ID field, enter
subviewLabel.

d. Inthe Type field, select Object.
e. Click Create.

f. On the Properties pane for the new subviewLabel constant, in the Default Value field, enter the
reference to the string that you added to the translation bundle.

Use the following format, where the first wikipedia instance is the subview's display property and the
second wikipedia instance is the string key that you added to the translation bundle:

{"Wikipedia":"[[ $translations.CustomBundle.wikipedia() 1]"}
Be sure to replace the translation bundle name and string with your own information, as needed.

If you have multiple subviews and you need translatable Show actions for each one, then you can add
that to the default value for the subviewLabel constant. For example:

{
"PaymentContactMMInter Src_Payment cToPaymentContactMMInter c Tgt":"[[ $translations.CustomBundle.Contact:
"Wikipedia":"[[ $translations.CustomBundle.wikipedia() ]1"

}
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3. Add the new subviewLabel constant to the payment_c-detail page's cx-detail fragment code.
a. On the payment_c-detail tab, click the Page Designer subtab.
b. Click the Code button.

Live Design Code

c. Add the subviewLabel constant to the "actionBar" parameter in the fragment code, as follows:
"subviewLabelExtension": $page.constants.subviewLabel
The fragment code should look like the below sample. Be sure to replace payment _c with your custom

object's REST API name.

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx fragmentsUI:cx-detail" class="oj-flex-item
oj-sm-12 oj-md-12">

<oj-vb-fragment-param name="resources" value="[[ {'Payment c' : {'puid': $variables.id, 'id':
$variables.id, 'endpoint': $application.constants.serviceConnection }} ]]"></oj-vb-fragment-
param>

<oj-vb-fragment-param name="header" value="[[ {'resource': $flow.constants.objectName,

'extensionId': $application.constants.extensionId } ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="actionBar"

value='[[ { "applicationId": "ORACLE-ISS-APP", "resource": {"name": $flow.constants.objectName,
"primaryKey": "Id", "puid": "Id", "value": $variables.puid }, "subviewLabelExtension":
$page.constants.subviewLabel } ]]'>

</oj-vb-fragment-param>

<oj-vb-fragment-param name="panels" value='[[ { "panelsMetadata":
$metadata.dynamicContainerMetadata, "view": $page.variables.view } ]]'></oj-vb-fragment-param>
<oj-vb-fragment-param name="context" value="[[ {'flowContext': $flow.variables.context} ]]"></oj-
vb-fragment-param>

<oj-vb-fragment-param name="row" value="{{ $page.variables.row }}"></oj-vb-fragment-param>
</oj-vb-fragment>

Add the CreatedBy and LastUpdatedBy Fields to Notes
Panels and Subviews

Users can add notes to a record, and those notes will display on a Notes panel as well as on a Notes subview page. As
an administrator, you can optionally display the CreatedBy and LastUpdatedBy fields for each note. If you add either
of these fields to a Note layout, then you must use a specific field template so that the user names display correctly at
runtime. This topic illustrates how to add the correct field template.

In this example, we'll add the LastUpdatedBy field to the Notes panel and subview that display on a Payment record. You
can follow the same set of steps if you want to display the CreatedBy field, as well.

Update the Field Templates File

In the field templates file, add a new field template.

1. In Visual Builder Studio, click the Source side tab.

2. Onthe Source side tab, navigate to extension1 > sources > dynamicLayouts > self > field-templates-
overlay.html.
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3. Inthe field-templates-overlay.html file, add this field template:

<template id="userNameTemplate'>
<oj-vb-fragment name="oracle_ cx_ fragmentsUI:cx-profile" bridge="[[ vbBridge ]]">
<oj-vb-fragment-param name="user" value="[[ { 'userName' : $value() } ]]"></oj-vb-fragment-param>

</oj-vb-fragment>
</template>

Add the LastUpdatedBy Field to the Panel

Add the LastUpdatedBYy field to the Notes panel that displays on a Payment record.

1. In Visual Builder Studio, click the Layouts side tab.
2. On the Layouts side tab, click the Payment_c > Note node.
3. Click the Rule Sets subtab.
4. C(lick the Panel Card Layout rule set.
5. Click the Open icon to edit the default layout.
O payment clist x | 4 Note x
Rule Sets (4) Fields (1) Templates (3) Actions Eve
Rule Sets Panel Card Layout ~
P . .
Qe o=
s | )
-
E default O &

6. Select the field, LastUpdatedBy, from the field list and drag to the desired location on the panel layout.

| 1ﬂ¥|]lE‘IlI_r-]i‘>t ® %Nnt? *

Rule Sets (4) Fields Templates (3 Actions Event Listeners Events Types

A Note hitle
A LastUpdateDate

| & A Lastupdatedsy A\ item2
OA LastUpdateLogin A LastUpdateDate
O A Noteld
O A NoteMumber A item3
A NoteTitle A LastUpdatedBy ]
M A NereTyr

7. Associate the LastedUpdatedBy field with the userNameTemplate field template:

a. On the Note tab, click the JSON subtab.
b. Inthe "PanelCardLayout" section, add a "fieldTemplateMap" section with a row for the LastedUpdatedBy

field:
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’

"fieldTemplateMap": {

"LastUpdatedBy":

}

"userNameTemplate"

The resulting JSON will look like this:

Rule Sets (4)

55
56
57
58
59
6e
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
88
81
82

4% Mote  x

Fields (1) Templates (3) Actions

"panelcardLayout™: {
"type": "cx-custom”,
"layoutType": "form",
"label™: "Panel Card Layout”,
"rules": [
"panelsContainerLayout-rulel”
1,
"layouts™: {
"default”: {
"layoutType": "form",
"layout": {
"displayProperties™: [
"NoteTxt",
"LastUpdateDate",
"LastUpdatedBy"
1,
"templateId": "PanelCardTemplate”,
"labelEdge™: "none"

¥
"usedIn": [
"PanelsContainerLayout-rulel”

]
1

}s

"fieldTemplateMap”: {
| “LastUpdatedBy":  "userNameTemplate™

}

Event Listeners

JavaScript

JS0N
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Add the LastUpdatedBy Field to the Subview

1. Switch to the Sub View Layout rule set.

0 payment_c-list x 4& Note x
Rule Sets (4) Fields (1) Templates (3) Actions Eve
Rule Sets . Panel Card Layout ~

‘ Q Fir Dynamic Form ‘

Create Layout

Layouts

[ def:
Edit Layout

[Sub View Layout]

2. C(lick the Open icon to edit the default layout.
3. Select the field, LastUpdatedBy, from the field list, and drag to the desired location on the subview layout.

For example, drag the field to the item2 slot.

4& Note x

Templates (3) Actions Event Listeners Events Types

A item1

‘ A NoteTitle |

A item2

‘ A LastUpdatedBy |

4. Associate the LastedUpdatedBy field with the userNameTemplate field template:

a. Onthe Note tab, click the JSON subtab.
b. Inthe "SubViewLayout" section, update the existing "fieldTemplateMap" section with a row for the

LastedUpdatedBy field:

’

"fieldTemplateMap": {
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"NoteTxt": "noteTemplate",
"LastUpdatedBy": "userNameTemplate"
}

Test the Flow

You can now test the Notes panel and subview to confirm that they both display the name of the person who last
updated the note.

1. From the payment_c-list page, click the Preview button to see your changes in your runtime test environment.

2. The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-custom/payment_c/payment c-list
3. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-custom/application/container/payment c/payment c-list

I Note: You must add /application/container to the preview link.

The screenshot below illustrates what the list page looks like with data.

All Payments Ao

O | Try searching by ke Al Filter

— [ = - CEErA T S W
&3 Resulis
Paymient Name 5 Creation Date = Last Updated Date S Actions

O Paryrneng, Oct invoice 10419722 10003 P 117725425 AM
O  Payment for Order 1020 1171722 206 AM 11/17/23 4:42 AM
O  Paymens 112 for October 15 crder 1173422 737 PM 12719722 5:23 PM
O /7722 616 P 1177722 816 PM
O Mot 1177722 6:45 PM 1177722 645 PM

4. C(lick any existing payment to view its detail page.
In the Action Bar, enter create Note.
6. Click Create Note.

ui

The Create Note drawer displays.
7. Create a note and then click Create.

8. On the Notes panel, you should see the newly created note, along with the full user name, not the ID, of the
person who last updated the note.
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9. Click View All Notes to view the Notes subview.

The subview should also display the full user name, not the ID, of the person who last updated the note.

T Payments

Payment for Laptops1 < : Notes

Crverer EXTH EXTH_AMS ast Update Date 01-09-2024 11205 PM Last Updated By EXTH_AMS
O Ty Add Contoct

LB B TR B S — A TSR
= Go to Overview

Today March 1, 2024 R

[P  Testfor payrent
Ban Hosper

Test for payment

P test

ENTH EXTN_AMS
Test1

10. Save your work by using the Push Git command.

Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the
Git repository).

< Workspace2 > extend-next-gen-sales.git/20220830

o Gt (5) D detai
A Q Filter Switch Branch

& » Changed (1) Commit. Commit

s Pull

.

@ Merge

B Reset to HEAD
) £
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Link to a Smart Action Using a URL

You can construct a URL that calls a smart action in the Redwood version of Sales. Construct this URL whenever needed
and then use it as a deeplink. Depending on the smart action added to the URL, clicking the link will either execute a
smart action without involving a Ul (to delete a record, for example) or navigate directly to an open drawer on a Sales
page (to create a record, for example).

To construct the URL, append the smart action ID as a parameter to the detail page URL.

1. Obtain the smart action ID.

You can retrieve the smart action ID from Application Composer.
2. Obtain the URL of the detail page.

For example:

https://<servername>/fscmUI/redwood/cx-sales/application/container/accounts/accounts-detail?
id=300000008600956&puid=38005&view=foldout

3. Append the smart action ID parameter as follows:

&actionId=<smart action ID>

4. The resulting URL can be used to link to a smart action:
For example:

https://<servername>/fscmUI/redwood/cx-sales/application/container/accounts/accounts-detail?
id=300000008600956&puid=38005&view=foldout&actionId=SDA-Delete-accounts

Note that once the action is completed, the URL changes to:

https://<servername>/fscmUI/redwood/cx-sales/application/container/accounts/accounts-detail?
id=300000008600956&puid=38005&view=foldout&actionId=completed
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5 Additional Configuration Tasks

Configure the Contents of a Panel

An individual record's detail page includes key information displayed in a region of panels. Each panel contains
information related to the record, such as related contacts and opportunities. Most panels display information in a list
format. You can configure these lists using Oracle Visual Builder Studio.

What's Inside a Panel?

A panel often contains a list, which you can configure. Here's an example of a list inside a panel:

Pinnacle Technologies ©

Activities Hierarchy Contacts Opportunities Leads

ol [ngn Lons
Comrepe weuh o Lctremt
ot Gopee mty

2 G Corwior Lrpaeion
3 778 O Spartmecnng Mot S Linad

At T [—]

[l ey ey it st s Lt e

Lists can display up to 5 records, depending on screen size. If the screen size is small, then the list automatically adjusts
to display fewer records. However, users can click the View All link that displays at the bottom of the panel to navigate to
a second page to see all records in the list. This second page is called the subview.

What Can You Change in a List?

In Visual Builder Studio, you can modify the information that displays in each list.
You can:

- Add and remove fields

- Change the display order of fields in the list

This topic illustrates how to change the display order of fields that display on panels on an account's detail page. We'll
look at both the Contacts panel and Opportunities panel.

To configure the subview, see Configure the Subview Layout.

Change the Display Order of Contact Panel Fields

Let's change the display order of fields in a panel list. In this example, we'll switch the order of the email and phone
number fields on the Contacts panel on the Account detail page.

153
ORACLE



Oracle Fusion Cloud Sales Automation Chapter 3
How do | create an application extension for custom objects Additional Configuration Tasks
in Oracle Visual Builder Studio?

Contacts

Joshua Baker
VP, Global

=3 Procurement m

joshua.baker_exei-_.. J[+]
+1(958) 555-1288

Forrest Gump
(W Chief Innovator
+1(713) 660-8512

Roger Glass

Director, Purchasing
roger glass_exei-test@oraclepd..
+1(551) 555-7539

View All Contacts (3)

1. In Visual Builder Studio, navigate to the Layouts tab and expand the CX Sales node > Accounts >
AccountContact.

The AccountContact node contains the rule sets for the Contacts panel on the Account object.
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1 Layouts =

4 Q. Filter

& y 4 Payment_c

S From Dependencies

o »  Application Components

* (X Sales
3
- 4& Accounts
=

47 AccountContact

4 AccountRollup

P

47 AccountTeam

&

47 Address
47 ContactPoint
47 Note

47 SalesTeamMeml

Note: When configuring the contents of a panel, consider what kind of relationship the panel's object has
with the primary object. In this case, the Account object has a many-to-many relationship with Contact. This
means that you'll find layouts for the Contact object on the AccountContact node, nested under the Accounts
node.
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2. O

n the AccountContact tab > Rule Sets subtab, click the Panel Card Layout.

accounts-detail X ccountContact X
4 Rule Sets (4) Fields Templates (4) Actions Event Listeners
© | Q. Filter
S .

~ Dynamic Form

N

Add Layout | cxsales
2 Page region where users can add a contact for an account.

Edit Layout | Oxsales
=

Page region where users can edit a contact of an account.

'

Panel Card Layout | Otsales
Page region where users can view account contact details in panel.

¢

~ Dynamic Table

Sub View Layout | O¢sales
Page region where users can view account contacts in sub view.

Both a default layout as well as a default rule are displayed for the Panel Card Layout.

=] [a....n.n..-.—.. ® A Arcerelomact ¥
. Panel Carnd Layow (Oxiaim) =
-] E Display Logic &
I
5 + e E) Stait by Supicating thve buit-n rube:
= fsom Dependonchrs
-] e Ak Trom Orperbencie tread aniy) ()
o I oo IiDetau e
u [+
. &——v| roum
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3. Click the Duplicate Rule icon.

Display Logic @

¢ > (1 Start by duplicating the built-in rule

Tell me more
From Dependencies (read-only) @

isDefault | CXSales f
’ p return El

4. Inthe Duplicate Rule dialog, accept the default rule name or enter a new name. The name you enter here is
both the rule name and also the layout name, so enter a layout name that makes sense for you.

Also, make sure that the Also create a copy of the layout check box is selected.

Duplicate Rule X

Name ~

isDefault_copy

Also create a copy of the layout

‘ Cancel | Duplicate

5. Click Duplicate.

The new rule displays at the top of the list of existing rules, which means that this rule will be evaluated first at
runtime. If the rule's conditions are met, then the associated layout is displayed to the user.

In this example, we're not adding any conditions which means that the associated layout will always be
displayed.
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6. Modify the rule's copied layout.

a. Click the Open icon to edit the copied layout.

Display Logic @

\

isDefault_copy &

Click to add condition

return isDefault_copy

- @~

al

From Dependencies (read-only) @

isDefault

A </¥ return default

CX Sales

b. Scroll down the list of fields in the layout until you locate the email and phone fields.

(m] [y accounis detail x

Ay AccoumiContact X

Variables

& Rule Sets 4 Fuelds Templates (3 A i Ewent Listeners Ewents (& Types
T LA Lontaciartybunmiber
& A e
O A ConiactbouceSystem
() Mam itk
2 O A ConactSouceSystemBeterenceValue 1) Contacibome. friperin
& O A Creseosy A emz
O A CrestecBymodule
0o A PersonlobTitle
O A cremionDate
o [ & DecisionbakerFlag A iem3
B O A pepanimenn { } EmailAddress_email
O A DeparimeniCode
@ A\ trema

0 B pocaFug
D B DoEmailflag { } FermatbedPhioneMumber_phone

0 = poNaiCaliFlag

[ © DoloiEmailFlag
0 A Emaitsddress

B 1} Emasitastiess el

da Floceibla ol

A4 Heem5 itemS only works with style a5 Tabel-cand

JanvaSongpt

150N

Semings

c. Delete each field from the Item3 and Item4 slots, and then add the fields back. This time, however, switch
the order so that the phone field is in the ltem3 slot and the email field is in the ltem4 slot.
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= | %dﬂﬂull'}.-dﬂlﬂ = ‘%Aunum(ulaml =
F Rule Sets (4) Fieldds Templates (4 A thans Event Listeners Events (51 Types Variables JavaSoript el Setings
& O A Createdty A team1
e BlyE 1} Contactiame Fyparlink -
O A creationDace
Pl 0 & pecisionMakerFlag A, Hand
o 0 A Department A PersonlobTite
O A DepartmentCode
@ itam3
0 & pacaiifiag
& 0 = boEmaiFiag { } FormattedPhoneNumber_phone
0 = ponotCaliFla
@ b A itama
O & pototEmailFisg
DAE . { } Emaildddress_email =
B} Emaitaddressemai A\ HemS item only works with style a5 Tabel-caed”
O [ EmaaverincationDate
0 A EmasinverificationSeacus
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7. Click the Preview button to see your changes in your runtime test environment.
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The preview link must include the application/container sSegments in the URL. If not, then change the preview

link using the following example URL:

https://<servername>/fscmUI/redwood/cx-sales/application/container/accounts/accounts-detail?
id=300000003513233&puid=7050&view=foldout

T My Team's Accounts

Pinnacle Technologies ©

Account Score 180 Industry High technology

Activities

Connect with this Account

The last interaction with Pinnacle
Technologies was 21 days ago on the

View Details Dismitss

Pending

= Automatic Task:...
Susan Morgan
4/28/23

Recent
Identify Key decision mak...

Gutpa Atanu
6/6/23 6:00 PM

View All Activities (37)

Address 3903 Ambassador Caffery Pkwy,LAFA]

Contacts

Joshua Baker

VP, Global
Procurement

+1(958) 555-1288
joshua baker_exei- ™

~N
o

Forrest Gump
Chief Innovator
+1(713) 660-8512

Roger Glass
Director, Purchasing

+1(551) 555-7539

roger.glass_exei-test@orac Ieptl./

‘T3 A M) |

View All Contacts (3)

. TREDLO T |

Change the Display Order of Opportunity Panel Fields

In this example, we'll switch the order of the sales stage and effective date fields on the Opportunities panel on the

Account object.
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Opportunities

Potential Revenue

$ 3,744,140

June 2023 Opportunity
L al

01 - Qualification
7/18/23

Q2 Gas Generator Expansion
$ 271,865
07 - Closed

6/6/23

Diesel Engine Fall Opportunity
$0
01 - Qualification

6/25/23

Houston Tesla plant
$0
01 - Qualification

A3

View All Opportunities (23)

1. In Visual Builder Studio, navigate to the Layouts tab and expand the CX Sales node > Opportunities.

The Opportunities node contains the rule sets for the Opportunities panel on the Account object.
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3

= Layouts
4 Q. Filter
* (XSales

\C

b %Accnunts
(=] » 47 Activities
£ » A7 Assets
o 4 CampaignMembers

4 Campaigns

@ 4 CatalogProductGrol
B 47 Competitors
. » 47 Contacts

47 ConversationMessa
47 Deals

47 HubOrganizations
47 Interactions

47 Leads

]

47 Opportunities

47 PartnerContacts
47 Partners
4 Products

47 ProgramEnrollment

+

Note: When configuring the contents of a panel, consider what kind of relationship the panel's object has
with the primary object. In this case, the Account object has a one-to-many relationship with Opportunity.
This means that you'll find layouts for the Opportunity object on the Opportunities node.
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2. On the Opportunities tab > Rule Sets subtab, click the Panel Card Layout.

+ 0

]

9D9E§'bm}

Layouts
Q. Filter

W LOMTETS

& ConversationMessa
& Deals

4 HubOrganizations
& Interactions.

& Leads

4 Opportunities

4 PartnerContacts
& Partners

4 Products

& ProgramEnreliment
4 Receivablesinvoices
& Resources

& SalesOrders

4 ServiceRequests
& SubscriptionProduc

4 Territories

I:a'l accounts-detall %

Rule Sets (12)

4 Opportunities =

Fields Templates (12 Actions  Event Listeners

Q, Filter

~ Dynamic Form

Create Layout | cx sales
Opportunity Create Layout

Dashboard Card Layout | Cx Sales
Page region displaying oppartunity in dashboand,

Edlit Layout | cx Sabes.
Opportunity Edit Layout

Header Layout | X Sales
Opportunity Details Header Layout

Panel Card Layout | X sabes
Page region where users can view opportunities in a panel.

Panel Card Layout For Pariner | Cx Sabes
Page regon whete USers can view opportunines on summarny panel for Parner

Single Field Update Layout | cx Sales
Single Field Update Layouwt

Ewents (%

Both a default layout as well as a default rule are displayed for the Panel Card Layout.

&
B
(o

i ]

L]
o
L

I'bumu.h et

Buile S5 (121

€ Prabe Sy

4 Oppoanaaties. =

Fiekts  Templalesii2] | Adtiin

Paned Cord Lt | Ciben . %

Friuss Djurssstivar s

e bl

Bl ol

[+ . PR
L [ Stawt by duplicating the Bulit.in nae
Frcmm Dompurenbers b 1wl wedyh (71
[ T
v rovurn [E] defoutt x

3. Click the Duplicate Rule icon.

»

Display Logic @

[ Start by duplicating the built-in rule
Tell me more

From Dependencies (read-only) @

lsDefault3

return

CX Sales

default

x
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4. Inthe Duplicate Rule dialog, accept the default rule name or enter a new name. The name you enter here is
both the rule name and also the layout name, so enter a layout name that makes sense for you.

Also, make sure that the Also create a copy of the layout check box is selected.

Duplicate Rule X

Name ~

1sDefault3_co p\,-{

Also create a copy of the layout

| Cancel ‘ Duplicate

5. Click Duplicate.

The new rule displays at the top of the list of existing rules, which means that this rule will be evaluated first at
runtime. If the rule's conditions are met, then the associated layout is displayed to the user.

In this example, we're not adding any conditions which means that the associated layout will always be
displayed.
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6. Modify the rule's copied layout.

a. Click the Open icon to edit the copied layout.

Display Logic @
|

>

isDefault3_copy &

Click to add condition

return [ isDetaultd copy

G

From Dependencies (read-only) (5
isDefaults | CX Sales.
return

A O

b. Scroll down the list of fields in the layout until you locate the sales stage and effective date fields.

I%acwum-s-delml * %Ugecrtunlilrﬁ ®

[E] EffectiveDate

O A creationDate

s

2 Rule Sets (12) Fields Templates (12 Actions Event Listeners
& OA BdgtAmount A item1

O A BdgtAmitCurcyld
= { } Mame_hyperlink

O [E BudgetavailableDate
O [ & BudgetedFiag A item2

= :

a [ B3 ChampionFlag A Revenue -

O { } childrevenue
@ |:| A ClosePenoad item3
B O A comments A, SalesStage
® O A conflictid

A itemd
O A CreatedBy

Events (3

Types

Variables

c. Delete each field from the Item3 and Item4 slots, and then add the fields back but switch the order.
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(] E&'accc—ums-detail x %Op ortunities X
Rule Sets (12) Fields Templates (13) Actions Event Listeners Events (9)
47 p
¢ A Revenue l { } Name_hyperlink l
= O { } RevenuePartnerPrimary
O { } RevenueTerritory A item2
© [0 A RiskLevelCode [A Revenue » |
i O A salesAccountUniqueName
(A item3 N
® O A salesChannelCd
[0 A salesMethod | EffectiveDate \
B
O A salesMethodld
A\ itemd
% A salesStage
SalesStage x
00 A soesstagei \ /
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7. Click the Preview button to see your changes in your runtime test environment.

P ® Q

‘ Publish | =

Chapter 3
Additional Configuration Tasks

The preview link must include the application/container segments in the URL. If not, then change the preview

link using the following example URL:

https://<servername>/fscmUI/redwood/cx-sales/application/container/accounts/accounts-detail?

id=300000003513233&puid=7050&view=foldout

T My Teser's Accounis

Pinnacle Technologies <@
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v Highechnology  #

1903 Armbassadar Catfery Ploay LAFAYETTE. LA 70503 ittt wewen, Pirnache

Activities

Wi Durtails Drumins

Connect with this Account

s e et —

Contacts

Joshua Baker
VP, Global
Pro

Fosrest Gump
Chied Innovator

Opportunities

$3744140

une 2023 Opgortunity
$0

01 - Quafication

Q2 Ga3 Generstor Expansion

“\

0%

Pending $ 271,865
Recent Roger Glass 07 - .f i
Director, Purchasing
Mecount Updated = ﬁ b
By Gutpa Afanu o glans_sin-1estorachs Ddesel Engine Fall Opportunity
01 - Quakfication
Heuston Tesla plant
-~
0 0%
- Py alfir atinn j
sewd All Activities | 37) View All Congacts (3] Wiewr ANl Opportunaties [23)

Configure the Subview Layout

An object's detail page includes a region of panels with information. Each panel, however, can display only a few records
due to panel size. To see all records, users can navigate to a second page called a subview. This topic illustrates how to

modify those subview pages using Oracle Visual Builder Studio.

What's Inside the Subview?

A subview contains a list of all records that the panel, due to limited real estate, can't display.

For example, here's an example of an account detail page with 5 panels:
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Notice how each panel displays only a few records.

To see all records, users can click the View All link that displays at the bottom of the panel.

Here's an example of some View All links. Note that after the link itself, a number indicates the number of total records

listed on the subview.

Opportunities Leads
Patential Revenue
£ 3,744,140 Diesel Engine Lead

Forrest Gump
+1(713) 660-8512
June 2023 Opportunity

30 o 0% Grindelwald Opportunity

01 - Qualification Joshua Baker

7/18/23 +1(958) 555-1288
jbaker@pinnacle.com

Q2 Gas Generator Expansion

£ 271,865 Spartanburg New Site Lead
07 - Closed Forrest Gump

+1(713) 660-8512

£0 +1(650) 506-7000
01 > Qualification

&/25/2%

Diesel Engine Fall Opportunity Battery Backup
suh

Solar installation
Houston Tesla plant
$0
01 - Qualification e

| View All Opportunities (23) | View All Leads (8)

The subview displays all those records in a table.
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What Can You Change in a Subview Table?

In Visual Builder Studio, you can modify the information that displays in a subview table.

You can:

- Add and remove columns
- Change the display order of columns in the table

This topic illustrates how to change the display order of columns in a subview table. We'll look at the Opportunities
subview that's available from an account detail page.

Change the Display Order of Opportunity Subview Columns

Let's change the display order of columns in a subview table. In this example, we'll switch the order of the sales stage
and win probability columns on the Opportunities subview, accessed from the Opportunities panel on the Account
detail page.
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Pinnacle Technologies < : Opportunities
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1. In Visual Builder Studio, navigate to the Layouts tab and expand the CX Sales node > Opportunities.

The Opportunities node contains the rule sets for the Opportunities panel on the Account object.

3 Layouts -+
& l Q Filter
w (X Sales
&
b ‘%Accuunts
» 4 Activities
b 4 Assets

8
e
0 4 CampaignMembers
47 Campaigns

® 47 CatalogProductGrot
B 47 Competitors
S » 47 Contacts

47 ConversationMessa
» 4 Deals
» 47 HubOrganizations

» 47 Interactions

b 4 Leads

» 47 Opportunities

» 4 PartnerContacts
» 4 Partners

47 Products

47 ProgramEnrollment
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2. Onthe Opportunities tab > Rule Sets subtab, click the Sub View Layout.

Dashboard Layout | €x Sales

Table displaying opportunities in dashboard.

Picker Layout | €x Sales

Layout for Opportunity picker

Sub View Layout | Cxsales

Page region where users can view opportunities in sub view.

Events (%)

(| [&, accounts-detafl x 4&, Opportunities x
A Rule Sets (12) Fields Templates (13) Actions Event Listeners
€ | Q Filter
S .
~ Dynamic Form

© Page region where users can view opportunities in a panel.
© Panel Card Layout For Partner | Cxsales

Page region where users can view opportunities on summary panel for Partner
@ - ™

Single Field Update Layout | cx sales
B Single Field Update Layout
& Dynamic Table

[m] [a.-'fm-.l-\..arrd = t%:-.-.-u-..r.—. =
& Rk St 13 Fieki Teimplatis {1 Artions  Evint ILinsne Eveilti Tyt i ol JSOH  Sellieg:
& Rueen  SubMieslisn (G -
Sl o~ EEERR  oisplay Logic®
Lo - i

Fe pen Elrprrbere by
-] v aracle_cx_sabeilll From Dupractracien [orak ssby) {5
o L] HiBefated | O ke

um [ sefouse [+

© & reum

[y Stant by duplicsting the Bullt.in nake

3. Click the Duplicate Rule icon.

Display Logic @

:

From Dependencies (read-only) (3

Tell me more

[E Start by duplicating the built-in rule

N

isDefaultd | O Sales

default &

retunn

Both a default layout as well as a default rule are displayed for the Sub View Layout.

ORACLE

171



Oracle Fusion Cloud Sales Automation Chapter 3

How do | create an application extension for custom objects Additional Configuration Tasks
in Oracle Visual Builder Studio?

4. Inthe Duplicate Rule dialog, accept the default rule name or enter a new name. The name you enter here is
both the rule name and also the layout name, so enter a layout name that makes sense for you.

Also, make sure that the Also create a copy of the layout check box is selected.

Duplicate Rule X

Name ~

isDefaLl1t4_copy1

Also create a copy of the layout

‘ Cancel | Duplicate

5. Click Duplicate.

The new rule displays at the top of the list of existing rules, which means that this rule will be evaluated first at
runtime. If the rule's conditions are met, then the associated layout is displayed to the user.

In this example, we're not adding any conditions which means that the associated layout will always be
displayed.
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6. Modify the rule's copied layout.

a. Click the Open icon to edit the copied layout.

Display Logic @
>
isDefaultd_copy & B DED >~ -~ &
4 ———» Click to add candition
return [ isDefaulid_copy - @ »

From Dependencies (read-only) (3

isDefaultd | Cx Sales

A <\_ return [ defoult

b. Inthelist of fields in the layout, use the handle next to the win probability field to move it above the sales

stage field.
[a:ncrmlm-\.-ﬂm.m ® %Gln poriunities  x
s Rule Sets (12) Fielbds Templates (13 Acthons  Event Listeners Events (¥ Types  Variables LarvaScript JSOH Seftings
& ¢ PudeSets.  Sub View Layout | €X Sales Layout isDefaultd_copy =
B & [Qfm ® - Select fields to display
=

= Suggesied Fiekls w { ) Hame_hypedink @ Virrual field can be rencered only with a field template
o O # PredictedinFrobability_c

# windrob + A Reverue
-]

All Frelids.
[E) EffectiveDate
B O A AccountParyMumber
[ O A ActiorsMeny )
A SalesStage

O[] AictpectHnts

O[] Assessments 4 WinProb

O A Assetd

O A Assetmiusnber

O A assetProduct

Here's a screenshot of the final location of the win probability field.
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Select fields to display

{ } Name_hyperlink @ Virtual field can be rendered only with a field template

A Revenue

=] EffectiveDate

A SalesStage

7. Click the Preview button to see your changes in your runtime test environment.

> ©® Q ‘ Publish | =
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The preview link must include the application/container segments in the URL. If not, then change the preview
link using the following example URL:

https://<servername>/fscmUI/redwood/cx-sales/application/container/accounts/accounts-detail?

id=300000003513233&puid=7050&view=foldout

Pinnacle Technologies 2 : Opportunities
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Make Values of a DCL Field Dependent on the Values of
Another Field

You can create a field, such as a dynamic choice list field (DCL), that displays different values depending on the values

of a different field. In this example, we'll create a DCL field for the Create Contact page that shows addresses for the
account associated with the contact. Salespeople can use the field to select an address for the contact from the available
account addresses.

Create the Dynamic Choice List Field

1. Open Application Composer in a sandbox.
2. Inthe left panel, make sure that CRM Cloud is selected in the Application field.
3. Expand the Contact standard object.
4. C(lick Fields.
5. Inthe Fields page. click Actions > Create.
6. Select the Choice List (Dynamic) option.
7. Inthe Create Dynamic Choice List : Basic Information page, enter the following
8.
Field Sample Entry Explanation
Display Label Bill-To Address The label users see in the UL.
Display Width 40 Width of the box displaying the address
elements.
Name BillToAddress Unique internal name.

9. Leave the Constraints with the default selected values.
10. Click Next.
11.  On the List of Values page, make these entries:

Field Sample Entry Explanation
Related Object Address The source of the values.
List Selection Display Value Country You can select any of the values as these

aren't used for this use case.

12. You can leave the other sections blank.
13. Click Submit.

Specify the DCL Field Behavior and Add It to the Layout

1. Open Visual Builder Studio.
2. Click the Layouts tab.
3. Onthe Layouts tab, click CX Sales > Contacts.
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= ‘Workspace CX 3

& Your extension doesn't have any

g layouts yet.
. Tell me mare

| + Loyout
it4
-] From Dependencies
= X Sales

B

b 4 Accounts
% F & Activities
b4y Assets
4' Campaipniembers
4 Campaigns
& CatalogProductGroups
& ClassCeodes
& Competitors
= 4 Contacts
& Address
4 ContactFioing
4r ContactRollup
4 Mote

&r SalesTeamMember

4. C(lick Rule Sets > Create Layout (CX Sales).

Rule Sats | Ii_oids WVakidaticnes Templates (13 Action Chairs

O Fileer

~ Dynamic Form

Add Layout | O Sales
Page region whene users can bod & contsn

Conference Contact Picker | Cx Sakes
Contact Picker Layout used insice web conference fragment

Create Layouwt | Qtsales | @
Page region where users can create a contact

Dashboard Card Layout | 0 Sales
Page region displaying contact in deshboard.

B Geuntfibe.js 0 payment_c-list [ contmcts-list dr ContactPoint

Event Listeners

dr ContactRollup

Evenits

Types

45 Contacts

Variahbles (2

5. Duplicate the default rule with the Also create a copy of the layout option selected.

6. Add a rule condition to the new rule.

JavaSe
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7. Click Open on the new layout rule to open the layout copy.

Bulle Satu 15 - e ST et huakng F I — —
Covate Lyowt | oo tmien | =
i 1 e Display Loglc &
: S Dol copy
[ — [ e 1] B

Prom Deprademcie fread onky) (]

8. Find the PersonDEO_Bill_To_Address_id_c (Bill-to Address) field and add it to the layout (highlighted by
callout 1in the following screenshot)

9. Create a variable for the field template:

Still in the Contact layout tab, click Variables

Click Create Variables (callout 1in the following screenshot).
Enter a variable ID, such as billToAddresses.

For Type, select Any.

e ngoo
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10. Create a field template that you'll need for the layout:

a.

Click the Rule Sets tab.

b. Click Create for the Template field (callout 2) in the Field (right-hand) pane.

Select fields o display

A Sehutoryintroduction

,'.L.' Firitlarme

B Midcletlaens

B Lasthmme

A JobTide

A BzcoumPartyld  [Aecoum Piker Template)

[ 1 FormattedidoriPhoneMumber_pheone 6 Virtosl field con be ¢

{ 1 Formameclicdress_sddress  (Lhe Account Scdess Templabe)

[} Emsiliddeess_email W Cerual Beld can be rendered anly wrth s feld terg

enidened orlly v

[ 1 FormattecdMobilehumber_phone B Vierual Beld can b renckered anly wis

h s bl tereplat

th & Hesdl templat

Ay PersonDED Sil_To_Address_ld_c

3

¢ Form Field

Shaw Field
Abyvaryd

-

PersanDED_B0_Te_Address_ld ¢

Lashae] Hint
Ball_To_dickdress

Teenplute e Crate

Herw
) Resd Only

) Required

Codusmine Spaen
R
Max Rews

User Assistance Denssty

In the Create Template window, enter a name with no spaces, such as billToAddressTemplate and leave
the Enable Extension option selected.

Click Create.
Click the Code option

Here's sample code to enter:

<template id="billToAddress">

<oj-select-single label-hint="billToAddressID" data="[[$variables.billToAddresses]]"
value="{{$value}}"></oj-select-single>

</template>
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11. Create an action chain that does the following:

o Check if the updated field in the record is the account Party ID.
o If the account Party ID is updated, then store that Party ID in the constant accountPartyNumber
o Create a REST call that returns all of the addresses for that Party ID

o Store the returned addresses (FormattedAddresses) in an array.

Chapter 3

Additional Configuration Tasks

o Assign the values in the array to the variable billToAddresses which will be part of the Create Contact UL.

a. On the Contacts tab, click Action Chains.

[ paymens_c-list [ contacis-kst dr ContactPoim

& JevaSeript

& Con

Action Chalns Ewvent Listeners Events Types Varlables 2 Jarea Script

Create Action Chain

o -
[

Diesoripticn

You don't have an

Action chains define application laglc

Click Create Action Chain (+Action Chain).

c. Inthe Create Action Chain window, leave the Java Script option selected and enter any name as an ID, in

this example: GetAddresses.
d. Click Create.
e. Switch to the Code view and enter the code:
f. Here's a sample:

define ([
'vb/action/actionChain’,
'vb/action/actions’,
'vb/action/actionUtils’',
'ojs/ojarraydataprovider',
1, (

ActionChain,

Actions,

ActionUtils,
ArrayDataProvider
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) => {

'use strict';

class test extends ActionChain {

/**

* @param {Object} context

* @param {Object} params

* @param {{row:object,related:object|[],fieldsToShow:string[]}} params.previous
* @param
{{row:object,previousRow:object,modifiedField:string,pickedRowsData:object,parentRow:object,mode:string}}
params.event

* @return {{row:object,related:object[],fieldsToShow:string[]}}

*/

async run(context, { previous, event }) {

const { $layout, $extension, $responsive, $user } = context;

if (event.modifiedField === 'AccountPartyId') {

const accountPartyNumber = event.pickedRowsData ['accounts.AccountPartyId'];
const addressesResponse = await Actions.callRest(context, {

endpoint: 'oracle cx_salesUI:cx/getall accounts-Address',

uriParams: {

'accounts_Id': accountPartyNumber.PartyNumber,

}l

})

if (addressesResponse.ok) {

const billToAddresses = addressesResponse.body.items.map ((address)=> {return
{label:address.FormattedAddress,value:address.FormattedAddress}}) ;
$layout.variables.billToAddresses = new ArrayDataProvider (billToAddresses,
{keyattributes:"value"}) ;

}

}

if (event.modifiedField === 'PersonDEO BillToAddress_Id c'){

debugger;

}

return previous;

}

}

return test;

}) s

12. Create an event listener for the field template:

Click the Event Listeners tab.
Click the Create Listener button (+Event Listener).
In the Create Event Listener page, select ContactsOnFieldValueChangeEvent.
Click Next
Select the action chain you just created. In this example, GetAddresses.
f. Click Finish.
13. Test your field:

Pan o9

a. Click the Preview button to test your newly-created field.

b. On the Contacts list page, enter Create Contact in the Action Bar.
c. Select an account that includes a number of addresses.
d. Click in the Bill-To-Address field to select an address.
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Change Navigation to Pages in Your Sales Application

Using the Dispatcher feature in Application Composer, you can change which page opens when a salesperson clicks

on a record name link on pages in both standard and custom objects. You can redirect links on the list pages, detail
pages, and the edit/create pages. The redirected link can open standard or custom pages and subviews. You can specify
different destinations for different job roles.

Clicking the opportunity name link on the opportunity list page, for example, normally opens the opportunity detail
page, which provides an overview of key activities, contacts, products, and other information. Getting to what a
customer is interested in purchasing requires an extra click. If salespeople are more interested in what the customer
is buying than in a general overview, then you can open the subview that lists the opportunity products and revenue
directly, saving that extra click.

If you created a simple custom object, you can even skip the detail page altogether and open the edit page instead.

How Dispatcher Works

Using the Dispatcher, you can create a set of rules that can open different pages for different job roles. Each dispatcher
rule replaces the URLs pointing to the same location. Dispatcher doesn't identify individual links on the page. If a page
includes multiple links that go to the same destination, all are replaced. You can even redirect a URL in all the pages in

the application to a new destination with one rule.

Creating a rule involves 4 steps:

1. Rule Details, where you specify if the rule applies to everyone in the organization or to specific job roles.

2. Navigation Details, where you enter the scope of the redirection rule and both the old and the new destination.
3. Overlapping Rules, where you specify the order in which to process any overlapping rules.

4. Review and submit.

What you enter in the Navigation Details step is key, so here's an overview of the 5 sections in this step. You must scroll
down to see the last section. Detailed instructions for creating rules follow.

Section Description

Navigation Component (1) In this release, you can redirect only links from the object name link.

Location of the Navigation Component (2) = The scope of the links you want to redirect. You can redirect the links in all the pages of the Sales
application, in a specific object, or narrow the scope to a specific page.

Standard Destination of the Navigation The current destination for the link you're redirecting. You can redirect the links on the list page, the
Component (3) detail page, the edit page, and the create page.

I Note: Using Dispatcher, you can't redirect links in subviews.

New Destination of the Navigation The new destination page for the link. Subviews are part of the detail page.
Component (4) So, if you're redirecting the link to a subview, you select the detail page.
Query Parameter Mapping (5) If you're redirecting a link to a subview, then you identify the subview by adding a constant with a value

that you obtain from the subview URL.
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Section Description

If you're redirecting to an edit page, you add the constant: mode = edit.

The variables are standard for all standard objects and custom objects created by the CX Extension

Generator.

Dispatcher Rubes

Navigation details

Select the objects and pages that support this rule’s navigation, including the
navigation compeonent’s new destination.

Navigation component

Location of the navigation component

Apehere
Page
Agupibic s
O 5<.;Ies o opportunities - opportunities-list -

Standard destination of the navigation component

Page
Apphication = apportunities - opporiunities-deta =
CX Sales

.:_.-. [ cinpateher ey
New destination of the navigation component

Page
Bgplicaties .
CX Sales o e apporiunites s opportunites-deta =

Cancel Continue

Rule details

Navigation details

Overlapping rules

Review and submit
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Query parameter mapping
Parameter Type * Parameter Name * Parameter Value * Actions
Constant wiew ChildRevenue af ‘Iﬂl
Variable puid pict g m
Variable id id F
Cancel Continue

Example Entries for Redirecting Opportunity List Page Links to the Product
Revenue Page

Here's what to enter in the Navigation Details step sections to redirect the opportunity name links on the opportunity
list page to the Products subview.

- Location of Navigation Component

You're restricting the redirection to the links on the opportunity List page, so make these entries:

Field Entry
Application CX Sales

Page opportunities
2nd Page field opportunities-list

- Standard Destination of the Navigation Component

Normally, the application opens the detail page when users click the opportunity name on the List page.

Field Entry

Application CX Sales

Page opportunities

2nd Page field opportunities-detail
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- New Destination of the Navigation Component

You're redirecting the navigation to a subview of the detail page, so your entries are the same as for the
standard destination. Subviews are part of the detail page.

Field Entry

Application CX Sales

Page opportunities

2nd Page field opportunities-detail

- Query Parameter Mapping
To redirect to the Product subview, you add a constant with the value of ChildRevenue:

Field Entry
Parameter Type Constant
Parameter Name view
Parameter Value ChildRevenue

Steps to Create and Activate Dispatcher Rules

Open Application Composer outside a sandbox.
Click Dispatcher.
On the Dispatcher page, click Create.
In the Rule Details page, enter a name for the rule.
In the Rule Conditions section, specify the audience for the rule. You have two options:
o Make the rule apply to the all job roles in the organization by turning on Apply Rule Globally.

o Apply the rule to specific job roles you enter in the Role Filter field.

VEWNA

Click Continue to move to the Navigation Details step.
In the Location of the Navigation Component section, specify the scope of the rule:
o To have the link redirected on all pages, turn on Anywhere.

o Narrow the scope of the redirection to an object and page:
- Inthe Application field, select either CX Sales for standard pages, or CX Custom.
- Inthe Page fields, make these selections:
a. Inthe first Page field, select the object.
b. Inthe 2nd Page field, specify the page type:

N©o

Available Values Description

any Redirects links on all pages for the object.
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Available Values Description

list Redirects links on the list page.

edit Redirects links on the edit and create pages.
detail Redirects links on the detail page.

8. Inthe Standard Destination of the Navigation Component section, enter the current navigation destination.
Your entries identify the URL to be replaced.

a. Inthe first Page field, select the object.
b. Inthe 2nd Page field, select the page.

Available Values Description

detail The detail page (called the Overview page at runtime).
edit The edit/view page.

list The list page.

9. Inthe New Destination of the Navigation Component section, enter the new navigation destination.

a. Inthe first Page field, select the object.
b. Inthe 2nd Page field, select the page.

Available Values Description
detail Redirects to the detail page or subview.
edit Redirects to the edit or the create page.

If you're redirecting to the edit page, then you must also add the constant mode = edit in
the Query Parameter Mapping section.

If you don't add a constant, the user is redirected to the Create page.

list Select to redirect to the list page.
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10. If you're redirecting the link to a subview or to the edit page, then you must add a constant in the Query
Parameter Mapping section:

a. Click Add.
b. If you're redirecting to the edit page, then make the following entries:

Field Entry
Parameter Type Constant
Parameter Name mode
Parameter Value edit

c. If you're redirecting to a subview, then enter the following:

Field Entry

Parameter Type Constant

Parameter Name view

Parameter Value Enter the last part of the subview URL following view=.

Here's an example of a URL for the Products subview on an opportunity:

https://<domain>/fscmUI/redwood/cx-sales/application/container/opportunities/opportunities-detail?
id=300000009863286&puid=39003&view=ChildRevenue

Note: For standard subviews and subviews generated by the CX Extension Generator, the application
automatically adds 2 parameters: the variables puid and id. These parameters are required.

Here's a screenshot of the Query Parameter Mapping section

Callout Description
1 The Add button.
2 Constant entry.
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1"
12

13.
14.
15.

Callout Description

3 The 2 required variables are included automatically.

Quiery parameter mapping

Parameter Type * Parameter Mame * Parameter Value * Actions
efum'.dn‘. e ChildRevenue F W
Variabile E puid puid g W
ariable id il g !
Cancel Continue

Click Continue to move to the Overlapping Rules step.

Review the order of any rules with overlapping functionality and specify the order of priority by dragging them
into position using the handles on each row. The rule at the top gets executed first.

Click Continue to move to the Review and Submit step.
Click Submit.
On the Dispatcher list page, select Action > Mark Active.

Configure What Information Displays in the Product
Catalog

Here's how to configure what information displays in the product catalog in your Sales in the Redwood User Experience
application. You can configure both product groups and products and you can configure different layouts for different
roles in your organization.

Before you start, make sure that the product catalog includes products, product groups, and the attributes that you
want to expose. Attributes that are blank don't show up in the Ul.

You open Visual Builder Studio from the Product Catalog page and the page must show what you're configuring:
product groups and a product under the Recent heading.

Configure Product Groups

1.

Open an opportunity.
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2. Enter Catalog in the Action Bar and select Browse Catalog.

3.

4.

T My Open Opportunities

New PowerMax Center ©

O catalog

M| Browse Catalog

Filter catalog

RV Status Open Win Probability 20 Close Date 11/30/24  Owner Jane Solis

X
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In the Product Catalog page, click your profile and select Settings and Actions > Edit Page in Visual Builder

Studio to open Visual Builder Studio (VBS).

= / supremo

Settings and Sign Cut
Actions
New PowerMax Center: Product Catalog

Personalization
T

Set Preferences

= Filter by Territory 2 Enter a Praduct Administration

ei dit Page in Visual Builder Studio

Troubleshooting

Owverview

All Categories

Run hagnosiics Tests

Applications Help
Supremo Power )

Aboul This Application
Supremo Solar

Recent

—

Solar Panel - w/Next-Gen Graphene Cell (420 Wart)

Our Next-Gen Graphene PV solar panel provides and industry-leadin

$ using hig

[ L
gh efficiency solar cells made from our patented next-gen % 505 Each @

hene-based materials for high module conversion efficiency, long-term

g
oL stability and

t f ity. Virtwally maintenance free. High transmittance, low
iron tempered f_:?‘\.*-'\. for durabilit ¥ and ennanced iImpact res stance

In the central VBS panel, click one of the product groups in the page under the All Categories heading to

display a border for the Product Group Card Layout (callout 1in the following screenshot).
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5. Under the Rule Set heading in the right pane, click the Product Group Card Layout link (callout 2).

e [=} | Fitro Carrwaz = Buts X | mute W | Live [ Design
= ¥ supremo
undefined: Product Catalog Cancel
N T M PSS | 1]
= Filter by Terrftory X .\F!u
Crverview
all Categories
[ L s L T L m:d.-cl-un_q:-d Lyt
.'Suprfmupmm'r {:-EJ
Supremao Solar {-I:)
Recent

£

catalogProductGroups - Product Geoup Card
Lyt

Appha #tion {omp

T Guick Actions

Suppesied Actions

% Open Rubs S8t Editer

Layout

dr  catalogProduciCeoups

Dibsject

B petall_catalogProductGroups

FRule Set

% Product Group Card Layout o
Lot Preview

Resobyed by displey loghc -

6. Duplicate the default layout and open it by clicking the Open button highlighted in the following screenshot.

Bole Sota (15} Fiekdi  Valdetons  Templebes Mction, Chaires Evevt Lisbmars.  Evensts Fyoued

['2 )

= BOH  Semng
Fude Srts Covate Lingoust | O iabes |+
i Display Loglc @
B aouins com
Friwn el s Bl oopw B @ -]
- ke iu_tabeslll
0 Suier.arisMame ity eouati Wb

setwrn [ aDefeuhl opy - E £
Fresn Dupradarie {read only) I_?,.
albeipuie? | Cx Sakey

#—r mm E
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7. You can drag additional fields from the Fields tab. Or you can remove and reorder them.

Procduct Group Card Layouwt | CX Sakes

:f"{ Filae @ -

Feelds

O A allewDupcselartensFlag
[ A& alewSeectionFlag

[ A AsischmeniEntityMame
|:| { } Anschments

[ A pepsh

LJ A FilserByTM

[ A FirssProdGrpld

L] A intemmaltame

[ LastUpdateDate

|:| A Medeonbighnributes

O A ModetFamily

O A MedeiLine

0 A Medeitiaere

O A cverridedliowSelafliany™

O A earentPreduptreugld

reductGroupDencrmid
B ProduciGroupDescription
L] A ProductGroupld

f ProduciGroupMame

Layout sDefault_copy 2 ~

Set oracle £ _fI.IH et sLlex |Jr1.ll:ll.ll\'.|'i. ard paramelers

A badgaltem

A iteml
A ProductGrouphlsme
A item?

A ProduciGroupDescription

A item3

A

A itemd

A itemS

i itemld

A, style

8. Preview your configuration by clicking the Preview button.

P © Q

‘ Publish | =

9. Click Publish to make your configuration permanent.

Configure Products

The steps to configure products is very similar to configuring product groups. The main difference: To easily identify
the layout, you must display a product under the Recent heading of the product catalog. You can do this by adding a
product to the opportunity from the catalog and then adding another.

Here's a screenshot of the product catalog showing a product under the Recent heading.
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New PowerMax Center: Product Catalog Cancel  Save
e R P o S TN Bt L E el A A e

(=] Filter by Temitory X Enter a Product u B
L

Overview

All Categories

Supremo Power @}
Supremo Solar @
Recent

Solar Panel - w/Mext-Gen Graphene Cell (420 Watt)

Our Mext-Gen Graphene PV solar panel provides and industry-leading 420 Watts
output, using high efficiency solar cells made from our patented next-gen £ 505 Each @
graphene-based materials for high module conversion efficiency, long-term
output stability and reliakility. Virtually maintenance free. High transmittance, low E

iron tempered glass for durability and enhanced impact resistance

Here's a recap of the detailed steps:

Open an opportunity.

Enter Catalog in the Action Bar and select Browse Catalog.

Add a product to the opportunity from the catalog and save.

Add a second product. The first product should appear under the Recent heading.

From the Product Catalog page, click Settings and Actions > Edit Page in Visual Builder Studio to open
Visual Builder Studio.

Click the product in the page under the Recent heading to display a border for the Product Card Layout
(callout 1in the following screenshot).
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7. Under the Rule Set heading in the right pane, click the Product Card Layout link (callout 2).

10.
1"

=  supremo N 0 ; @ Quick Acmions

Sugpevied Actiona
undefined: Product Catalog Cancel o Copam B it et
L —e R B T T ot LTSSt~ T T Layina
& prosuct
O FilerbyTemoy X Ent ' ‘HB .

B getall_prodecin
CFvind

Frulle Srt
All Categories %, Broduct Cad e 9

Supdeen Powed @ Lyt Pravview
Sppaherd by detpley kagic
Supaeno Solar @
Recent

Solar Panel - wMeat I.'-¢|o¢|1-r Coll (220 Wast)

4505 Each (B

In the Display Logic pane, duplicate the default layout and open it.

Drag additional fields from the Fields tab. You can also remove and reorder fields.
Preview your configuration by clicking the Preview button.

Click Publish to make your configuration permanent.
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